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Introduction

Thank you for purchasing your MPC. At Akai Professional, we know how serious music is to you. That’s why we
design our equipment with only one thing in mind—to make your performance the best it can be.

This user guide explains how to create music using MPC X, MPC Live, MPC One and MPC Touch. There is similar
documentation available for MPC products that use an LCD and for the MPC software application. To view these user
guides, click the Help menu in the MPC software, select MPC Help, and select an option.

Welcome to the MPC family.

Akai Professional

System Requirements & Product Support

For the latest information about this product (system requirements, compatibility information, etc.) and product
registration, visit akaipro.com.

For additional support, visit akaipro.com/support.

About This User Guide

This manual should help you get familiar with using your MPC X, MPC Live, MPC One or MPC Touch. For
consistency, the terminology throughout is based on the MPC nomenclature. We also used specific formatting to
indicate particular topics of significance:

Important/Note/Tip: Important or helpful information on a given topic.

Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual.
Examples: Press the Play Start button.
Turn Q-Link Knob 4.
Tap the Mute button.
The Velocity ranges from 0 to 127.
Set the Sample Play selector to One Shot.

Tap BPM, and then use the numeric keypad to enter 120 as the tempo.

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters.
Click the text to skip immediately to that section.

Examples: Read the Important Notes section before proceeding.
For more information about installing the necessary drivers and software, see Setup > 2. Installation.

To learn more about using send effects, see General Features > Effects > Send/Return Effects.

~
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Important Notes

Read the included safety & warranty manual before using your MPC hardware.

Before getting started and connecting devices to your MPC hardware or turning the hardware on/off, make sure all
devices are switched off.

To use your MPC hardware in Controller Mode (to control the MPC software):

Before installing the MPC software, make sure your computer meets the system requirements described at
akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin in another digital
audio workstation (DAW).

Before connecting your MPC hardware to your computer, install the drivers and software. Visit akaipro.com to
download the latest versions. Refer to the 2. Installation section for more information.

1. Connection

Here is just an example of how to use MPC X in your setup. ltems not listed under Introduction > Box Contents of
your included quickstart guide are sold separately.

Headphones Footswitch
(to front-panel headphone output) (to front-panel FS1 input) Powered Monitors Computer

SD Card
(to front-panel SD card slot)

\KAI MPEX

PIfl FESSIONAL TUSCPRODUGTION GENTER

GATE

7 _6
N A A

(7N LANN (7Y

MIDI OUT

Microphone Turntable Power
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Remember to remove the protective film from your MPC hardware touchscreen!

To use your MPC hardware in Standalone Mode, just connect it to a power outlet using the included power
adapter, and power it on!

Note: We highly recommend checking akaipro.com for any available updates to the MPC software/firmware and/or
drivers.

To use your MPC hardware in Controller Mode, continue to Step 2. Installation.

2. Installation

To use your MPC hardware in Controller Mode (to control the MPC software), follow these steps to download
and install the required drivers & software:

w

P 0D~

Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, you will be
prompted to create one.

In your Akai Professional account, download the MPC software package.
Open the file and double-click the installer application.
Follow the on-screen instructions to complete the installation.

Note: By default, the MPC software will be installed in [your hard drive]\Program Files\Akai Pro\MPC (Windows")
or Applications (macOS"). You can also create a shortcut on your Desktop.

. Getting Started

Power on your MPC hardware.

On your computer, open the MPC software.

Follow the on-screen instructions to authorize your version of MPC.

You will need an iLok account to complete this. You can create an account at ilok.com.

Make a note of the PACE code in your account, and enter it when asked for it during the authorization/unlock
process.

On your MPC hardware, check the upper-right corner of the touchscreen:

e [f there is a monitor/cable icon, then your MPC hardware is already in Controller Mode.
Continue to Step 6.

e If there is a chip icon, then your MPC hardware is in Standalone Mode. Follow these steps:
i Press Menu to enter the Menu.

ii. Tap the MPC chip icon in the upper-right corner. IEI

iii. In the Enter Controller Mode window that appears, tap Controller Mode. Looking
for computer may appear briefly on the screen before your MPC hardware recognizes
the USB connection as a controller.

In the MPC software, click the Edit menu, and select Preferences. Click the Audio tab and select the sound
card you want to use. Click OK when you are done.

Important:

We highly recommend using your MPC hardware’s sound card (Akai Pro MPC X/Live/One/Touch ASIO). If you
need to use the internal sound card on a Windows computer, we recommend downloading the latest ASIO4ALL
driver at asio4all.com.

To view the MPC software user guide, click the Help menu in the MPC software, select MPC Help, and select
MPC User Manual.
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This chapter explains the features and functions of each MPC model with a touchscreen: MPC X, MPC Live, MPC

One and MPC Touch.

Touchscreens

Here is some general information about how to use the touchscreen on your MPC:

e wnser Toc N O
untitled B E 0 e
" scouenc
cquence
1 (unused) -] 2 e off ;

TRACK

LenGTH veLocTy  TRANSPOSE

1 (unused) -] { Seq 100% orf

al fr—

X, Program 001 -]

e cuck

Tap a button or option to select it. Use the data dial or
—/+ buttons to change its setting or value

7‘/

, 51200 , 64000 , 76800 , 115200 ‘128000

Spread two fingers to zoom in (into a section of a
waveform, for example). Pinch two fingers to zoom out.

,,,,,, wn e e
1 untities L o o
»

e =

1 (unused) 2 1 2 7
TRACK ﬂ N x al
-

o veloo  Taaspose
1 (unused) = = o Seq 100 oft ;

PROGRAM

X Program 001 g /

e cuck - TRACK + MUTE

Double-tap a button to access advanced editing options.
In some cases, this will show a numeric keypad that you
can use to enter a value (an alternative to the data dial
or —/+ buttons). Tap the upper-left part of the screen to
return to the previous view.

{} PROJECT BAR BEAT TICK IN
untitled oo 0 our
>
SEQUENCE Al
BPM [o»)
{} " 120.00 BARS - TRANSPOSE
2 FIRST/ LAST Off
1 (unused) -] 12 /
TRACK
a 5
-'/'«’ LENGTH VELOCITY TRANSPOSE
- o
1 (unused) g [ = m Seq 100% Off ,
""I PROGRAM al
X, Program 001 2 /
TC CLICK - TRACK + MUTE SoLo

The top of the screen shows the toolbar, which contains
information about the current view (often the name of
the current track, sequence, audio pointer position,
etc.). Tap an item to select it.

The bottom of the screen shows various buttons that
you can use in the current view. Tap a button to press it.

To return to a previous view, either tap outside of the
window currently on the screen or tap the left arrow (€)
in the upper-left part of the screen.
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Navigation & Data Entry Controls

1. Touchscreen: This full-color multi-touch display shows information relevant to MPC X’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

Tip: If you adjust the angle of the touchscreen, use the stand on its back panel to secure it in place.

2. Cursors: Press these buttons to navigate through the fields of menus and options shown on the screen. Press
and hold Shift and press these buttons to zoom in or out of the Grid View or Audio Edit Mode. Press and hold
Shift and press the up and down cursors simultaneously or the left and right cursors simultaneously to return
to the default zoom setting.

11



Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field on the screen.

—-/+: Press these buttons to increase or decrease the value of the selected field on the screen.

Numeric Keypad: If the selected field on the screen is a number, press these numbered buttons as you would
on a standard numeric keypad to enter a value. Press the keypad’s Enter to enter it. (A numeric keypad with
additional operations will appear on the screen, as well.)

Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by red writing).
Double-press this button to see which buttons have secondary functions —the buttons will flash for a few seconds.

F-Key: Press this button to activate or deactivate the F-Key feature. When active, the six buttons under the
touchscreen correspond to the options shown at the bottom edge of the screen. The F-Key button and those six
buttons will be lit red when active. When inactive, the six buttons under the touchscreen will access their normal
modes instead (Menu, Browser, Step Seq, Sampler, XYFX, and Looper).

Pad & Q-Link Controls

10.

11.

12.

13.

14.

15.

Q-Link Knobs: Turn these touch-sensitive knobs to adjust various parameters and settings. The display strip
above each knob indicates the parameter it is controlling. If the display strip shows a meter to indicate its value,
you can touch or turn its Q-Link knob to temporarily show its precise numerical value.

Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

Pad Bank: Press these buttons to access Pad Banks A-D.

Press and hold Shift while pressing these buttons to access Pad Banks E-H. Alternatively, double-press one of
these buttons.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be
temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See Operation > General Features >
16 Level to learn more.

Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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16.

17.

18.

19.

20.

Project: Press this button to use the Q-Link knobs to adjust parameters related to the current project. Press and
hold Shift and then press this button to enter the Project Q-Link Edit Mode directly. See Operation > Modes >
Q-Link Edit Mode > Project to learn about this.

Program: Press this button to use the Q-Link knobs to adjust parameters of the currently selected program or
audio track. Press and hold Shift and then press this button to enter the Program Q-Link Edit Mode directly. See
Operation > Modes > Q-Link Edit Mode > Program to learn about this.

Pad Scene: Press this button to use the Q-Link knobs to adjust parameters that you have assigned for the
currently selected pad. Press and hold Shift and then press this button to enter the Pad Scene Q-Link Edit Mode
directly. See Operation > Modes > Q-Link Edit Mode > Pad Scene to learn about this.

Pad Param: Press this button to use the Q-Link knobs to adjust one parameter across all 16 pads. Each Q-Link
knob corresponds to the pad with the same number and position in the 4-by-4 layout. Press and hold Shift and
then press this button to enter the Pad Param Q-Link Edit Mode directly. See Operation > Modes > Q-Link Edit
Mode > Pad Parameter to learn about this.

Screen Control/Edit: Press this button to use the Q-Link knobs to adjust parameters in the currently selected
mode as shown on the screen. See Operation > Modes > Q-Link Edit Mode > Screen to learn about this.

Press and hold Shift and then press this button to enter Q-Link Edit Mode where you can assign other parameters
to the Q-Link knobs.

Mode & View Controls

Note: See Operation > Modes to learn about the different modes you can access with these controls.

21.
22.

23.

24.

25.

26.

27.

28.
20.

30.

31.

Menu: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.
Main/Track: Press this button to enter Main Mode.
Press and hold Shift and then press this button to enter the Track View.

Browse/Save: Press this button to view the Browser. The Browser lets you navigate your computer’s internal
and external hard disks to load samples, sequences, songs, etc. Using filter buttons and user-definable folders,
you can easily adapt it to your workflow. You can also preview samples before loading them.

Press and hold Shift and press this button to save the current project (including its samples, programs, sequences,
and songs).

Step Seq/List Edit: Press this button to view the Step Sequencer where you can create or edit sequences by
using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

Press and hold Shift and press this button to view your sequences using the List Edit View instead of the Grid View.

Sampler/Looper: Press this button to view the Sampler where you can record audio samples to use in your
projects.

Press and hold Shift and press this button to view the Looper where you can record and overdub audio in real
time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop
as a sample to use in your project.

XYFX: Press this button to view XYFX Mode, which turns the touchscreen into an XY pad where each axis
represents the range of an effect parameter. As you move touch or move your finger on the screen, the current
position will determine the current value of the two parameters. You can use this mode to create interesting
effect automation on your tracks.

Pad Perform: Press this button to view Pad Perform Mode where you can assign musical scales/modes, chords,
or progressions to the pads for creative performance options.

Prog Edit: Press this button to view Program Edit Mode, which contains all parameters for editing your programs.

Sample Edit: Press this button to view Sample Edit Mode where you can edit your samples using various
functions and processes.

Pad Mixer: Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning,
routing, and effects.

Ch. Mixer: Press this button to view the Channel Mixer where you can set levels, stereo panning, and other
settings for your tracks, programs, returns, submixes and masters.
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32.

33.

Track Mute/Pad Mute: Press this button to view Track Mute Mode where you can easily mute tracks within a
sequence or set mute groups for each track.

Press and hold Shift and press this button to view Pad Mute Mode where you can easily mute pads within a
program or set mute groups for each pad within a program.

Next Seq/Song: Press this button to view Next Sequence Mode where you can trigger different sequences simply
by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold Shift and press this button to view Song Mode where you can arrange sequences in a specific
order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly
composing.

Transport & Recording Controls

34.
35.
36.

37.

38.

39.

40.

41.

42.

43.

Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

</> (Event |</>|): Use these buttons to move the audio pointer left or right, one step at a time.

Press and hold Locate and press one of these buttons to move the audio pointer to the previous/next event in
the sequence grid.

<</>> (Start/End): Use these buttons to move the audio pointer left or right, one bar at a time.

Press and hold Locate and press one of these buttons to move the audio pointer to the start or end of the
sequence grid.

Locate: Press and hold this button to activate the secondary functions of the </> and <</>> buttons (i.e., Event
|</>| and Start/End, respectively).

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).

14



I/0 & Level Controls

44,

45.

46.

47.

48.
49.

50.

51.

52.

53.

54.

55.

Gain 1/2: Use these knobs to adjust the gain of the incoming signal from Input 1/2 on the rear panel or Inst 1/2 on
the front panel. Use the Rear/Front switches below the knobs to determine the input. Use the level meter to
check the recording level. Be careful when setting this knob at higher levels, which can cause the signal to distort.

Rear/Front: Use each switch to set whether the Gain 1/2 knob above it will control the gain of the input signal on
the rear panel (Input 1/2) or on the front panel (Inst 1/2).

Phantom Power (+48V): This switch activates and deactivates phantom power for Input 1/2. When activated,
+48V of phantom power will be supplied to both inputs. Note that most dynamic microphones do not require
phantom power, while most condenser microphones do. Refer to your microphone’s documentation to check if it
needs phantom power.

3/4 Rec Gain: Use this knob to adjust the gain of the incoming signal from Input 3/4 on the rear panel. Use the
level meter to check the recording level. Be careful when setting this knob at higher levels, which can cause the
signal to distort.

Master: Turn this knob to adjust the volume level of the Main L/R outputs.
Direct/Main: Turn this knob to adjust the balance between the input and output signals in the headphones.

Direct corresponds to the input signal—all devices connected to the inputs on the front and rear panels.
While recording, you can turn this knob all the way to Direct for zero-latency direct monitoring.

Main corresponds to the output signal—the signal sent from the Main L/R outputs on the rear panel. When
you are not recording, we recommend turning this knob all the way to the Main position to hear the full-
volume playback signal.

Stereo/Mono: Use this switch to set whether the signal in the headphones is binaural (Stereo) or monaural
(Mono). When set to Stereo, the headphone signal will be split so that the input signal (Direct) is heard in the left
ear while the output signal (Main) is heard in the right ear. When set to Mono, the input and output signals are
blended into a single, summed mix, which is heard in both ears.

Rec Arm: Press this button to arm or disarm recording for the currently selected audio track, shown in the
display strip below the level meters (see Operation > General Features > Menu > Preferences to learn how to
set what is shown in the level meters).

Read/Write: Press this button to set the automation state for the program on the current track or for the current
audio track: Off, Read (green R), or Write (red W). The display strip below the level meters must show a program
or audio track (see Operation > General Features > Menu > Preferences to learn how to set what is shown in
the level meters).

Mute: Press this button to mute the program, audio track, or master output shown in the display strip below the
level meters (see Operation > General Features > Menu > Preferences to learn how to set what is shown in
the level meters).

Solo: Press this button to solo the currently selected program or audio track shown in the display strip below the
level meters (see Operation > General Features > Menu > Preferences to learn how to set what is shown in the
level meters).

Level Meters: These meters indicate the level of the audio signal shown in the display strip below them. See
Operation > General Features > Menu > Preferences to learn how to set what is shown in the level meters.
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1. SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using MPC X.

Footswitch Inputs (FS 1/2) (1/4” / 6.35 mm): Connect optional 1/4” (6.35 mm) TS footswitches to these inputs.

3. Instrument Inputs (Inst 1/2) (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TS cables to connect these inputs to
audio sources (guitars, bass, etc.). To use each of these inputs, set the corresponding Rear/Front switch (below
the Gain 1/2 knob on the top panel) to Front.

4. Mix Knob: Turn this knob to adjust the balance between the Main and 3/4 signals in your headphones. Main is
the signal sent from the Main L/R outputs. 3/4 is the signal sent from the Outputs 3/4.

5. Headphone Outputs (1/8” or 1/4” / 3.5 mm or 6.35 mm): Connect your headphones (not included) to either or
both of these standard stereo outputs. Use the Mix Knob to determine what signal is heard in the headphones.
Turn the Headphone Volume knob to set the volume level.

6. Headphone Volume: Turn this knob to adjust the volume of the headphone outputs.
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Rear Panel

10.

11

12.

13.

14.
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INPUT 1/2

Power Input: Use the included power adapter to connect MPC X to a power outlet. This must be connected to a
power outlet in order for MPC X to power on.

Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally unplugging.

Power Switch: Press this button to turn MPC X’s power on or off. While powered on, press and hold this button
for 5 seconds to force MPC X to power off (similar to a computer).

USB-B Port: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your
computer. This connection allows MPC X to send/receive MIDI and audio data to/from the MPC software on your
computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA port to
mount on your computer if MPC X is in Controller Mode (i.e., your computer can access these storage devices
that are connected to your MPC X).

USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC X. MPC X
supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability
for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by
both Windows and macOS.) These USB ports supply power to connected USB devices and can also be used to
receive MIDI messages from external USB MIDI devices.

Inputs 1/2 (XLR or 1/4” / 6.35 mm): Use standard XLR or 1/4” (6.35 mm) TRS cables to connect these inputs to
audio sources (microphone, mixer, synthesizer, etc.). To use each of these inputs, set the corresponding
Rear/Front switch (below the Gain 1/2 knob on the top panel) to Rear. Turn the Gain 1/2 knobs to set the input
level of each one.

Note: When using the XLR connection, the mic pre-amp is automatically engaged. When using a 1/4" (6.35 mm)
TRS cable, the mic pre-amp is bypassed.

Inputs 3/4 (1/4” / 6.35 mm or RCA): Use standard 1/4” (6.35 mm) TRS cables or stereo RCA cables to connect
these inputs to audio sources (mixer, turntable, synthesizer, etc.). To use the 1/4” (6.35 mm) inputs, set the
Phono/Line switch to Line. To use the RCA inputs, set the Phono/Line switch to Phono. Turn the 3/4 Rec Gain
knob to set their input levels.

Phono/Line Switch: Set this switch to the appropriate position, depending on which Input 3/4 connectors you
want to use. If you are using the 1/4” (6.35 mm) inputs, set this switch to Line. If you are using the RCA inputs,
set this switch to Phono to provide the additional amplification needed for phono-level signals.

Grounding Terminal: If you are sending a phono-level turntable signal to the Input 3/4 RCA connectors and are
hearing a low hum or buzz, it could mean that the turntable is not grounded. If the turntable has a grounding
wire, connect it to this terminal.

Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be
connected to the grounding terminal.

Main L/R Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your
speaker system. The signal sent out of these outputs is the master mix. Turn the Master knob to set their volume.
Tip: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is
set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

. Outputs 3/4, 5/6, 7/8 (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to an

external mixer. The signal sent from these outputs is full-volume (0 dB).

Tip: To route a program to these outputs, set its routing to Out 1,2, Out 5,6, or Out 7,8 (respectively) in the
Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn
more about this.

MIDI In: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI
devices.

MIDI Out: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI
devices.

CV/Gate Out: Use standard 1/8” (3.5 mm) TS cables to connect these outputs to optional external sequencers.
MPC X will send control voltage (CV) and/or Gate data over this connection.
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Live’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field on the screen. Pressing the dial also functions as an Enter button.

3. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control
one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-
Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

4. Q-Link Button: Press this button to change which parameter or group of parameters the Q-Link knobs currently
control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs.

Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the same
parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this).

5. Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

6. Pad Bank: Press any of these buttons to access Pad Banks A-D.

Press and hold Shift while pressing any of these buttons to access Pad Banks E-H. Alternatively, double-press
one of these buttons.

7. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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10.

11.

12.

13.

14.

15.

16.
17.
18.
19.

20.

21.

22.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be
temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See Operation > General Features >
16 Level to learn more.

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).
Double-press this button to see which buttons have secondary functions —the buttons will flash for a few seconds.
Menu/Browse: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and
select programs, samples, sequences, etc.

Main/Track: Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter the Track View.
Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

—/+: Press these buttons to increase or decrease the value of the selected field on the screen.
Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).
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1. Power Input: Use the included power adapter to connect MPC Live to a power outlet.

)

MIDI out

m\ -
@ 0
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Power Switch: Turns MPC Live’s power on/off.

Charging Indicator: This light (behind the vent) will turn on when MPC Live’s internal battery is charging (when
the power input is connected to a power outlet). When the battery is fully charged or when it is disconnected
from a power outlet, then this light will turn off.

4. USB-B Port: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your
computer. This connection allows MPC Live to send/receive MIDI and audio data to/from the MPC software on
your computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA
port to mount on your computer if MPC Live is in Controller Mode (i.e., your computer can access these storage
devices that are connected to your MPC Live).

5. USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using MPC Live. MPC
Live supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only
capability for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one
supported by both Windows and macQOS.) These USB ports supply power to connected USB devices and can
also be used to receive MIDI messages from external USB MIDI devices.

SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using MPC Live.

Rec Vol: Turn this knob to adjust the gain of the incoming signal from the 1/4” (6.35 mm) and RCA inputs. Be
careful when setting this knob at higher levels, which can cause the signal to distort.

Master Vol: Turn this knob to adjust the volume of Output 1/2 and the phones output.

9. Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources
(microphone, mixer, synthesizer, etc.). To use these inputs, set the Line/Phono switch to Line. Turn the Rec Vol
knob to set their input levels.

10. Inputs (RCA): Use a standard RCA stereo cable to connect these inputs to a phono-level audio source like a
turntable. To use these inputs, set the Line/Phono switch to Phono. Turn the Rec Vol knob to set their input levels.

11. Line/Phono Switch: Set this switch to the appropriate position, depending on which inputs you want to use. If
you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-
level signals. If you are using the 1/4” (6.35 mm) inputs, such as a keyboard or a sampler, set this switch to Line.

12. Grounding Terminal: If using phono-level turntables with a grounding wire, connect the grounding wire to these
terminals. If you experience a low “hum” or “buzz”, this could mean that your turntables are not grounded.
Note: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be
connected to the grounding terminal.

13. Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker
system, external mixer, etc. The signal sent out of the Master L/R outputs is the master mix. Turn the Master
Vol knob to set their volume. The signals sent from Outputs 3-6 are full-volume (0 dB).

Tip: To route a program to these outputs, set its routing to Out 1,2, Out 3,4, or Out 5,6 (respectively) in the
Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn
more about this.

14. Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the Master Vol
knob to set the volume level.

15. MIDI In: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI
devices.

16. MIDI Out: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI
devices.

17. Kensington® Lock Slot: You can use this slot to secure your MPC Live to a table or other surface.
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Navigation & Data Entry Controls

1. Display: This full-color multi-touch display shows information relevant to MPC One’s current operation. Touch
the display (and use the hardware controls) to control the MPC interface. See the previous Touchscreens

section to learn how to use some basic functions.

2. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the display. Pressing the dial also functions as an Enter button.

-/+: Press these buttons to increase or decrease the value of the selected field in the display.

4. Undo / Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

5. Shift: Press and hold this button to access some buttons’ secondary functions (indicated by red writing).
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Pad & Q-Link Controls

10.

11.

12.

13.

Pads: Use these pads to trigger drum hits or other samples. The pads are velocity-sensitive and pressure-
sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors,
depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You
can also customize their colors.

Pad Bank Buttons: Press any of these buttons to access Pad Banks A-D. Press and hold Shift while pressing
any of these buttons to access Pad Banks E-H. Alternatively, double-press one of these buttons.

Full Level / Half Level: Press this button to activate/deactivate Full Level. When activated, the pads will always
trigger their samples at the maximum velocity (127), regardless of the amount of force you use.

Press and hold Shift and then press this button to activate/deactivate Half Level. When activated, the pads will
always trigger their samples at half-velocity (64).

16 Level / Notes: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will
be temporarily copied to all 16 pads. The pads will play the same sample as the original pad, but a selectable
parameter will increase in value with each pad number, regardless of the amount of force you use.

Press and hold Shift and press this button to activate/deactivate Notes mode for the pads. When activated, you
can play musical scales/modes, chords or progressions using the pads while in any mode. Use Pad Perform
Mode to configure the settings for the pads.

Copy / Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the “destination”
pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap Do It to
continue or Cancel to return to the previous screen.

Press and hold Shift and press this button to delete.

Note Repeat / Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.

Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can
control one column of parameters at a time. The lights above the Q-Link Knobs indicate the currently selected
column. Press the Q-Link button to change which column of parameters they currently control.

Q-Link Button: Press this button to change which column of parameters the Q-Link Knobs currently control
(indicated by the lights above the Q-Link Knobs). Each press will select the next column.

Press and hold Shift and then press this button to select the previous column instead.

Mode & View Controls

14.

15.

16.

17.

Menu / Prefs: Press this button to open the Mode Menu. You can tap an option on the Menu screen to enter
that mode, view, etc.

Press and hold Shift and then press this button to open the Preferences page in the Menu.
Main / Grid: Press this button to enter Main Mode.
Press and hold Shift and then press this button to enter Grid View Mode.

Browse / Save: Press this button to view the Browser. You can use the Browser to locate and select programs,
samples, sequences, etc.

Press and hold Shift and then press this button to to save the current project (including its samples, programs,
sequences, and songs).

Track Mix / Pad Mix: Press this button to view the Track Mixer where you can set levels, stereo panning, and
other settings for your tracks, programs, returns, submixes, and masters.

Press and hold Shift and then press this button to view the Pad Mixer where you can set a program’s levels,
stereo panning, routing, and effects.
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18.

19.

20.

21.

22.

23.

24.

Track Mute / Pad Mute: Press this button to view Track Mute Mode where you can easily mute tracks within a
sequence or set mute groups for each track.

Press and hold Shift and press this button to view Pad Mute Mode where you can easily mute pads within a
program or set mute groups for each pad within a program.

Next Seq / XYFX: Press this button to view Next Sequence Mode where you can trigger different sequences
simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold Shift and press this button to view XYFX Mode, which turns the touchscreen into an XY pad
where each axis represents the range of an effect parameter. As you move touch or move your finger on the
touchscreen, the current position will determine the current value of the two parameters. You can use this mode
to create interesting effect automation on your tracks.

Step Seq / Automation: Press this button to view Step Sequencer Mode where you can create or edit
sequences by using the pads as "step buttons," simulating the experience of a traditional step-sequencer-style
drum machine.

Press and hold Shift and press this button to toggle Global Automation between Read and Write.

TC / On/Off: Press this button to open the Timing Correct window, which contains various settings to help
quantize the events in your sequence.

Press and hold Shift and press this button to turn Timing Correct on and off.

Sampler / Looper: Press this button to view the Sampler where you can record audio samples to use in your
projects.

Press and hold Shift and press this button to view the Looper where you can record and overdub audio in real
time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop
as a sample to use in your project.

Sample Edit / Q-Link Edit: Press this button to view Sample Edit Mode where you can edit your samples using
various functions and processes.

Press and hold Shift and press this button to view Q-Link Edit Mode where you can assign other parameters to
the Q-Link knobs.

Program Edit / MIDI Control: Press this button to view Program Edit Mode, which contains all parameters for
editing your programs.

Press and hold Shift and press this button to view MIDI Control Mode where you can customize what MIDI
messages are sent from certain controls on your hardware.

Transport & Recording Controls

25.

26.

27.

28.
29.
30.

31.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a Sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Press and hold Shift and press this button to return the playhead to 1:1:0.

Play: Press this button to play the sequence from the playhead’s current position.
Play Start: Press this button to play the sequence from its start point.
Tap Tempo / Master: Press this button in time with the desired tempo to enter a new tempo (in BPM).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit amber) or a master tempo (the button will be lit red).

Erase: As a Sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. When playback is stopped, press this button to open the Erase window where notes,
automation and other sequence data can be erased from the sequence.
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Front Panel
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SD Card Slot: Insert a standard SD, SDHC or SDXC card into this slot to access its files directly using MPC One.

2. Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output.
Rear Panel
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1. Power Input: Use the included power adapter to connect MPC One to a power outlet.

2. Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally
unplugging.

Power Switch: Turns MPC One’s power on/off.

4. Link: Connect a standard Ethernet cable to this port to use Ableton Link and other compatible devices with MPC
One.

5. USB-B Port: Use the included USB cable to connect this high-retention-MPC One USB port to an available USB
port on your computer. This connection allows MPC One to send/receive MIDI and audio data to/from the MPC
software on your computer.

6. USB-A Port: Connect a USB flash drive to this USB port to access files directly using MPC One. You can also
connect a standard MIDI controller to this port.

7. Rec Vol: Turn this knob to adjust the volume of the inputs.

8. Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to an audio source
(mixer, synthesizer, drum machine, etc.). In Sample Record Mode, you can select whether you want to record
either channel or both channels in stereo or in mono.

9. Master Vol: Turn this knob to adjust the volume of the outputs and phones output.

10. Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors,
mixer, etc.

11. MIDI In: Use a standard 5-pin MIDI cable to connect this input to the MIDI output of an external MIDI device
(synthesizer, drum machine, etc.).

12. MIDI Out: Use a standard 5-pin MIDI cable to connect this output to the MIDI input of an external MIDI device
(synthesizer, drum machine, etc.).

13. CV/Gate Outs: MPC One will send control voltage (CV) and/or Gate signals over these outputs to optional
external sequencers. Use standard 1/8” (3.5 mm) TS cables to send a single CV/Gate signal per output, or use a
stereo TRS-to-dual mono TSF breakout cable (such as a Hosa YMM-261) to send two CV/Gate signals per output.

14. Kensington® Lock Slot: You can use this slot to secure your MPC One to a table or other surface.
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MPC Touch

Top Panel
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1. Touchscreen: This full-color multi-touch display shows information relevant to MPC Touch’s current operation.
Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the previous
Touchscreens section to learn how to use some basic functions.

2. Display Brightness +/-: Use these buttons to increase/decrease the brightness of the touchscreen.

3. Data Dial: Use this dial to scroll through the available menu options or adjust the parameter values of the
selected field in the screen.

4. Q-Link Knobs: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control
one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-
Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

5. Q-Link Button: Press this button to change which parameter or group of parameters the Q-Link knobs currently
control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs.

Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

Press and hold this button to show the QLink window over the touchscreen’s current contents. These are the same
parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the
window to enter Q-Link Edit Mode immediately (see Operation > Modes > Q-Link Edit Mode to learn about this).

6. Pads: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive
and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different
colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest
velocity). You can also customize their colors.

7. Pad Bank: Press any of these buttons to access Pad Banks A-D.

Press and hold Shift while pressing any of these buttons to access Pad Banks E-H. Alternatively, double-press
one of these buttons.

8. Note Repeat/Latch: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly.
The rate is based on the current tempo and Time Correct settings.

Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not
have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
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10.

11.

12.

13.

14.

15.

16.

17.
18.
19.
20.

21.

22.

23.

Full Level/Half Level: Press this button to activate or deactivate the Full Level feature. When activated, the pads
will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated,
the pads will always trigger their samples at half-velocity (64).

16 Level: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be
temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a
selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum,
Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector
to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay. See Operation > General Features >
16 Level to learn more.

Erase: As a sequence is playing, press and hold this button and then press a pad to delete the note event for
that pad at the current playback position. This is a quick way to delete note events from your sequence without
having to stop playback. See Operation > General Features > Erase to learn more.

Shift: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).
Double-press this button to see which buttons have secondary functions —the buttons will flash for a few seconds.
Menu/Browse: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and
select programs, samples, sequences, etc.

Main/Track: Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter the Track View.
Undo/Redo: Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

Copy/Delete: Press this button to copy one pad to another. When the From Pad field is selected, press the
“source” pad (the pad you want to copy). When the To Pad graphic (of all pads) is selected, press the
“destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap
Do It to continue or Close to return to the previous screen.

Tip: To quickly copy a pad, press and hold Copy, press the source pad, press the destination pad, and then
release Copy.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the Delete Pad window
is shown, press any pad/pads whose sample assignments you want to clear. Tap Delete to continue or Cancel
to return to the previous screen.

—/+: Press these buttons to increase or decrease the value of the selected field in the screen.
Play: Press this button to play the sequence from the audio pointer’s current position.
Play Start: Press this button to play the sequence from its start point.

Stop: Press this button to stop playback. You can double-press this button to silence audio that is still sounding
once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all
voices and stop all audio processing.

Rec: Press this button to record-arm the sequence. Press Play or Play Start to start recording. Recording in this
way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through
once while recording, Overdub will be enabled.

Overdub: Press this button to enable Overdub. When enabled, you can record events in a sequence without
overwriting any previously recorded events. You can enable Overdub before or during recording.

Tap/Master: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how
many taps are required in the Preferences (see Operation > General Features > Menu > Preferences to learn
how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo
(the button will be lit red) or a master tempo (the button will be lit amber).
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Power Input: Use the included power adapter to connect MPC Touch to a power outlet. Alternatively, you can
power MPC Touch via the USB port only, but the touchscreen will be disabled.

S —]

Power Switch: Turns MPC Touch’s power on/off.

USB Port: Use the included USB cable to connect this high-retention-force USB port to an available USB port on
your computer. This connection allows MPC Touch to send/receive MIDI and audio data to/from the MPC software.

You can power MPC Touch via the USB port only, but the touchscreen will be disabled.

Rec Vol: Turn this knob to adjust the gain of the incoming signal from the inputs. Be careful when setting this
knob at higher levels, which can cause the signal to distort.

Master Vol: Turn this knob to adjust the volume of the outputs and phones output.

Inputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources
(microphone, mixer, synthesizer, etc.). Turn the Rec Vol knob to set their input levels.

Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker
system, external mixer, etc. The signal sent out of these outputs is the master mix. Turn the Master Vol knob to
set the volume level.

Tip: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is
set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

Phones (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the Master Vol
knob to set the volume level.

MIDI Out (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this
output to the MIDI input of an optional external MIDI device.

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI Out. Use the included
1/8”-to-5-pin adapters to connect MIDI devices only.

. MIDI In (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this input to

the MIDI output of an optional external MIDI device.

Important: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI In. Use the included
1/8”-to-5-pin adapters to connect MIDI devices only.

Kensington® Lock Slot: You can use this slot to secure your MPC Touch to a table or other surface.
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Basic Concepts

This chapter should help explain some fundamental aspects of the MPC universe.

The MPC workflow is quite different from traditional digital audio workstations (DAWSs). In most typical DAWSs, each track
uses an instance of each instrument, and all tracks are always playing even if they don’t contain any audio or MIDI
information. Furthermore, your entire project needs to be arranged just as the resulting song would be. This isn’t the case
with MPC, which offers much more flexibility within your project. It’s important to understand some basic terms, though:

A sequence is a “building block” of a song. It contains multiple tracks that play at the same time like a normal
DAW. In a project, you might create one sequence for your verse and another sequence for your chorus, alternating
and/or repeating each one in a specific order to create the song. (A project can contain 128 sequences.)

A track is a layer in a sequence. There are two types of tracks:

MIDI tracks consist of MIDI data only, no audio data. These tracks produce sound by using programs,
described below. Unlike a normal DAW, each MIDI track exists only in its sequence. The advantage of this is
not having to manage empty or unwanted tracks across all of your sequences—each sequence contains only
the tracks you want to use in it. If you want to use the same track across multiple sequences, you can copy
the track from one sequence into another. (A sequence can contain 128 MIDI tracks.)

Audio tracks consist of a recorded audio signal, like a traditional DAW. These tracks do not use programs
because the audio is already contained in the track. Also, unlike MIDI tracks, audio tracks are present in
every sequence in the project, even if the tracks themselves are empty. (A sequence on your MPC hardware
can contain 8 audio tracks. A sequence in the MPC software can contain 128 audio tracks.)

A program is a preset through which MIDI tracks are routed. Programs may contain audio samples that are
triggered when tracks play through them, producing the sound you want on that track. Programs are
independent of tracks and sequences, so you can set multiple tracks to use the same program (unlike normal
DAWSs where each track requires its own set of samples). Furthermore, you can use the same program/programs
across multiple sequences. (A project can contain 128 programs.)

Each program can be played using the 16 pads (across eight pad banks, which gives you access to 128 pads in
each program). Each pad plays a MIDI note when you press it, but that MIDI note will trigger something different
for each program. For instance, in drum programs, the pads are assigned to samples—one pad could trigger a
kick drum sound and another could trigger a snare drum sound—whereas in keygroup programs, each pad
triggers a MIDI note that plays the corresponding pitch of the sample assigned to its keygroup.

Here’s a diagram to illustrate an example of how these pieces could work together:

"= Sequence Bl B Drum Program
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“ Keygroup Program

== Track (MIDI: Bass) — (Bass)

\ ====
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—
_— “ Keygroup Program o |0 |0 [O
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Mixing

I|I|I Track (Audio: Vocals)

il Track (Audio: Guitar)

Please take a look at the following Tutorial chapter, as well. It will walk you through the creation of a short song to
show you some of your MPC hardware’s most important features.
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Tutorial

This chapter should familiarize you with some basic MPC features. We'll create a short song to illustrate some of the
most important features. To get the most out of this chapter, we recommend reproducing each of the described steps.

Starting Up

Make sure you have completed all of the steps described in Introduction > Setup. This includes:
¢ Installing the most current drivers and software.

e Connecting your MPC hardware to a power source using the included power adapter (if required) and
powering it on.

¢ Opening and authorizing your MPC software (if you are using your MPC hardware as a controller).

Creating a Drum Kit

Let’s start by making a simple drum Kkit.

[ | B3 [Internal\MPC Documents [Internal]\Expansions\The Vault 2

O, Search directory

O, Search directory

ymbal-Ac1 Crsh 1.wav

Wi Acoustic-Cymbal-Ac1 Crsh 2.wav

Exports
BB MPC Documents

Programs

Projects Acoustic-Cymbal-Ac1 Rd Bell.wav

Samples Acoustic-Cymbal-Ac1 Rd Bow.wav
Sequences Acoustic-Cymbal-Ac2 Crsl
Tracks Acoustic-Cymbal-Ac2 Crs
Acoustic-Cymbal-Ac2 Rd

Acoustic-Cymbal-Ac2 Rd Bow.wav

BROWSE SAMPLE ASSIGN =) AUDITION SAMPLE ASSIGN > <) AUDITION

Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Then, use
the touchscreen to navigate to where your drum sounds are located:

To browse your files by location, tap Places on the left side of the screen.
Internal is the internal drive of MPC X, MPC Live or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live or
MPC One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, MPC One, or your
computer (with MPC Touch), they will appear in this column, as well.

Important: MPC X, MPC Live and MPC One support read and write capability for exFAT, FAT32, NTFS, and
EXT4 file systems as well as read-only capability for HFS+ file systems. (We recommend using an exFAT file
system as it is the most robust one supported by both Windows and macOS.)

To browse your files by type, tap Content and then tap the type of file: Drums, Instruments, Clips, Samples,
Demos, or My Files.

To browse your MPC Expansions (MPC X, MPC Live or MPC One only), tap Expansions (see Addenda >
Updates for MPC 2.1 > New Features > Exporting Expansions to learn how to export MPC Expansions from
your computer to your MPC X, MPC Live or MPC One).

To move up one folder level, tap the folder/t icon in the upper-left corner.
To move through a list, swipe up or down, turn the data dial or use the -/+ buttons.
To select a file or folder, tap it once.

To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the data dial, or press
the center cursor or Enter (MPC X), to enter a selected folder.
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After loading samples for a drum kit into the sample pool,
use the Sample Assign tab to assign a kick drum sound to
a pad:

A
i 1980Kick1
i (ick2

1.

To load a selected file, double-tap it, tap Load, press the data dial, or press the center cursor or Enter (MPC
X). If the file is a sample, it will be loaded to the project’s sample pool. If the file is a project, it will be loaded in its
entirety (you will be asked if you want to close your current project).

To load all files in a folder, select the folder (so it is highlighted in the list), press and hold Shift, and then tap
Load All in the lower-right corner.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically
converted to full-quality uncompressed audio files, so they may use more storage space than they do on your
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.
To preview a selected sound, tap and hold Play () at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen.
In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set
the volume level. Tap Audition once more to hide the window.

To show the information for the current drive (MPC X, MPC Live, MPC One), press and hold Shift and then
tap Drive Info at the bottom of the screen. The drive’s information will appear in a new window. Tap OK to return
to the previous screen.

- Program 001

Tap Sample Assign at the bottom of the screen. This
lets you view the pads and project’s sample pool.

Press Pad 1 or tap Pad 1 on the screen to select it. The
pad will be lit green.

Swipe the Sample Pool list up or down or use the data
dial or —/+ buttons to move through it.

To load a sample to the selected pad (Pad 1, in this
case) tap it in the Sample Pool list, press the data dial, < auoron
or press the center cursor or Enter (MPC X). Now, you

can press Pad 1 to play the kick drum sample.

To create a simple drum Kkit, repeat the above steps for
other pads. We recommend loading a snare drum, a closed
hi-hat, and an open hi-hat.
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Creating a Drum Sequence

Now that your drum kit is set up, let’s record a drum sequence.
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1. Press Menu to enter the Menu, and then tap Grid View.

2. Press Tap repeatedly at the speed you want to record your sequence. Your MPC hardware will detect the rate
and adjust itself automatically.

Press the Rec button to record-arm the sequence.

Press the Play button to start the actual recording. You will hear the count-in for one measure before the
recording starts. We recommend recording only one sound (pad) at a time, especially if you’re not familiar with
playing drums on the pads.

5. Play a simple kick drum pattern. The note events you just recorded will automatically be placed in the grid (in this
case, on 16th notes). The initial measure length is two bars. After the two bars, the recording will automatically
activate Overdub; the sequence will play again from the beginning and keeps looping, allowing you to record
further notes. Don’t stop the recording!

6. Play the snare drum part, then a hi-hat part.

When you’re done recording, press the Stop button.

If you start recording again on this sequence, keep in mind that the pads you play in your new recording will replace
existing notes played with the same pads. To prevent this, press the Overdub button before recording instead of the
Rec button. Overdub lets you record additional note events over the existing sequence.

The Undo button functions differently while recording. Normally, pressing Undo will undo just the last event. When
there is an event to undo, the Undo button will be lit solid. While recording, the Undo button will flash. In this case,
pressing Undo will erase all events from that recording (i.e., since Play or Play Start was pressed).
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Saving & Renaming

We recommend doing some renaming of your programs and samples before going further.

The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged into a
program. When you load this program in the future, you will be able to use all of the samples that belong to it.

Let’s rename the existing program as we’ll want to create more programs later on.

€ Set program name

Program 001

To rename a program:
1. Press Main to enter Main Mode.
2. Inthe Program section in the lower part of the screen, tap the cursor icon on the right edge.

3. Use the virtual keyboard that appears to enter a new name (e.g., Drums), and then tap Do It.

To rename your samples:
1. Press Menu to enter the Menu, and then tap Sample Edit to enter Sample Edit Mode.

2. The Sample field at the top of the screen will show the name of a sample. Select a sample in one of the following
ways:

¢ When the Sample field is selected, use the data dial or —/+ buttons to change it.
¢ Double-tap the Sample field and tap one in the list that appears.
Tap the keyboard icon next to it to rename the current sample.

4. Use the virtual keyboard that appears to enter a new name (e.g., Kick, Snare, etc.), and then tap Do It.

Repeat Steps 2-4 to rename other samples.
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Now would be a good time to save your project.
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To save your project, press Menu to show the Menu, and tap the disk icon at the top of the screen to open the
Save window. Alternatively, press Shift+Browse/Save (MPC X, MPC One). In the Save window, do any of the
following:

To select the storage device you want to view, tap it in the Storage column on the left.
Internal is the internal drive of MPC X, MPC Live or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live or
MPC One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, MPC One or your
computer (with MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the =/+ buttons to move through the list,
and press the data dial, or the center cursor or Enter (MPC X), to enter a folder. You can also tap one of the
five folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see Operation >
Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap
Do It. You will immediately enter the new folder.

To move up one folder level, tap the folder/L icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.
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Editing Note Events

In the grid, you can see your recorded notes (or note events) as a sequence.

To enter the Grid View, press Menu, and then tap Grid View.

DON'T SNAP EDIT START EDITEND TRANSPOSE VELOCITY

In the Grid View, you can do any of the following:

To zoom in or out, tap the magnifying-glass icon in the upper-right corner. Then, in the grid, spread two
fingers apart or pinch two fingers together. You can do this for each axis, horizontal or vertical.

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in
the lower-left corner.

To undo your last action, press Undo.

To redo the last action you undid, press Shift+Undo/Redo.

To enter a note, tap the pencil icon in the upper-right corner. Then, in the grid, tap a square.

To delete a note, tap the eraser icon in the upper-right corner. Then, in the grid, tap a note.

To select a single note, tap the select box in the upper-right corner. Then, in the grid, tap the note.
To select all notes for a pad, press the desired pad.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or -/+ buttons
to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time
Correct value (learn about this feature in Operation > General Features > Timing Correct (TC)).

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold
Don’t Snap in the lower-left corner of the screen, and then use the data dial or —/+ buttons to shift the notes. In
this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start or
Edit End at the bottom of the screen, and then use the data dial or -/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the
data dial or —/+ buttons.

To switch to the previous or next track, tap the Track field in the upper-left corner, and then use the data dial
or —=/+ buttons.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the
screen.
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To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See
Operation > General Features > Timing Correct (TC) to learn about this.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data
dial or -=/+ buttons. The numeric value will appear on the screen.

To show or hide the velocity lane, tap the up arrow (A) button in the lower-right corner of the screen to show
the velocity lane below the grid. Each note’s velocity is represented by a vertical bar. The higher and more red
the bar is, the higher the velocity is.

Tap the up arrow (A) button once more to show a taller version of the velocity lane after which it will turn into a
down arrow (v) button, which you can then tap to hide the velocity lane.
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Making Basic Sound Edits

Let’s make sure the samples are properly tuned and have good levels.

Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X, MPC
One).
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Press a pad to show its parameters on the screen.

To adjust its volume, tap and drag the Volume knob up or down. Alternatively, use the data dial or —/+ buttons.

To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap anywhere else
to return to the previous screen.

To adjust its stereo panning, tap and drag the Pan knob up or down. Alternatively, use the data dial or —/+
buttons. To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap
anywhere else to return to the previous screen.

Adjust the level of each pad to suit your taste. We recommend spreading the panning of the bright sounds (e.g.,
cymbals, snare drum) a little. Additionally, you can tune the kick drum sound—tap the Samples tab so the first
square under it is lit, and then adjust the Semi and Fine knobs next to the sample name.
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The snare drum may need some reverb to give it a more spatial sound.

Tap Effects at bottom of the screen to view the Insert Effects tab. Press the pad with your snare drum sound to
select it.
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To add an effect:
1. Double-tap the desired slot. A list of effects will appear.
2. Swipe up or down to move through the list.

3. To load an effect, double-tap it. Alternatively, tap it once and then tap Select or push the data dial. Let’s try
Reverb Medium.

4. To close the list, tap Close.

To adjust the effect’s parameters, tap the pencil icon.
To empty the effect slot, tap the trash can icon. Switch the effect on or off by tapping the On/Off button for the slot.
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Creating a Bass Track

Let’s try recording a bass line. Unlike a drum kit, it’s important to be able to play and record a bass sound
chromatically, so this will be slightly different than setting up the drum kit.

Adding a bass line over the drum part means we need to work on a new track. A track is simply a layer of a sequence.
Each track uses a program within your project. You can work with multiple tracks in a single sequence (e.g., a drum
track, a bass track, a piano track, etc.). When you play the sequence, all of them will play simultaneously.

First, let’s make an empty track.

1T MPCProject 001

1 Sequence 01

2 (unused)

Program 001

@ AuDIO

To select a new track:
1. Press Main to go back to Main Mode.

2. Double-tap the Track field in the center-left part of the screen, and then tap Track 2 (unused) in the list of tracks
that appears.

Alternatively, tap the Track + button at the bottom of the screen until (unused) appears in the Track field.

Let’s create a new program for this track to use.

1 MPC Project 001

80.78

1 Sequence 01

v 2 Track 02

To create a new program:

1. In the Track section in the middle of the screen, tap the piano-keys icon. This icon indicates a keygroup
program, which is nhecessary to play the bass sound chromatically with the pads.

A name for the new keygroup program will appear in the Program field in the lower part of the screen.
2. Inthe Program section in the lower part of the screen, tap the cursor icon on the right edge.
3. Use the virtual keyboard that appears to enter a new name, and then tap Do It.
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To load and edit a bass sound:

1.

Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Then,
use the touchscreen to navigate to where your bass sounds are located, and load one to the project’s sample
pool. (You can look at this earlier section if you forgot how to do thisl!)

After loading a bass sample to the sample pool, don’t use the Sample Assign tab like you did when creating a
drum program; keygroup programs are different.

Instead, press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X,
MPC One).

In Program Edit Mode, tap the Samples tab at the bottom of the screen to show the four layers of samples in the
program.

Double-tap the first Layer field and then tap your bass sample in the list on the left. Because you’re working with
a keygroup program instead of a drum program, this sample is now playable across all pads.

Tip: On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You
should hear the bass sample played back with its original pitch. You can use the other pads to play your sample
chromatically.
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Let's add a second layer and set the layers’ velocity ranges so the bass will sound different when played at a higher
velocity (as a real bass would):

1.

3.
4.

Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser, select
a different bass sample that sounds similar but a little bit brighter, and load it to the project’s sample pool.

Return to Program Edit Mode, and in the Layer tab, double-tap the second Layer field, and select the new bass
sample. Press a pad to hear both samples will sound at once. Maybe this new sound is interesting as it is, but
let’s make some quick edits to get as close as we can to a real-life bass sound.

Tap the Pan Velocity tab to show its parameters.
Tap Layer 1's Vel End knob and turn the data dial to set it to 80. Do the same to set Layer 2’s Vel Start slider to 81.

Now when you press a pad, the lower velocities (0-80) will trigger the Layer 1 sample only, while higher velocities
(81-127) will trigger the Layer 2 sample only.
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Let’s record that bass line now. Prepare your recording as described earlier, and record some bass notes. You can
edit your recording just like we’ve done earlier.
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Once you've recorded it, let’s tweak the sound a bit in the Filter section:
1. In Program Edit Mode, tap the Filter/Env tab to show its parameters.
2. Double-tap the Type drop-down menu, and select a filter. Let’s try working with Lowpass 4 Pole.

3. Tap the Cutoff or Reso (resonance) knob, and turn the data dial to adjust their settings until your bass sample
sounds good to you.

4. In the Amp Envelope section, tap the Attack or Release knob, and turn the data dial to adjust their settings.
These control the overall level characteristics of the sound.

Do you want to add an effect? Do this in the Effects tab:

1. Tap the Effects tab to show the insert effects.

2. Double-tap one of the Inserts slots to show a list of available effects.

3. Double-tap the effect you want to add to your bass line, or click Close to cancel.

To adjust the settings of the effect, click the pencil icon next to its slot to open a window that shows its
parameters.

To activate or deactivate all insert effects for that program, click the All On/All Off button in the upper-right
corner.

So far, we’ve created a simple drum sequence and a bass line to go with it. Repeat this process to create a second
seqguence.
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Recording an Audio Track

We've already created some MIDI tracks, so let’s record some actual audio for our next track:

¥ MPC Praject 001
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1. Press Main to go back to Main Mode.
2. Tap the Audio tab at the bottom of the screen. Audio 001 will appear in the Track field.

If the channel strip is not already shown on the left side of the screen, tap Input Config (in the lower part of the
screen) or the small eye icon (in the upper-left part of the screen) to show it.

4. Connect a synthesizer or other line-level audio source to the 1/4” (6.35 mm) input/inputs on your MPC
hardware’s rear panel, and set the Line/Phono selector to Line (MPC X, MPC Live).

5. Double-tap the first field (Input __) and select Input 1 or Input 1,2 (depending on your audio source) as the input
source.

6. If the second field is not set to Out 1,2, double-tap it and select that option as the output.

Tap the Monitor button to cycle through its three states until it reads Auto (you will hear incoming audio while
the track is record-enabled only).

8. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC One, MPC Touch) knob to set the input level while
playing your audio source. You should now see the level in the meter. Make sure it does not exceed the
maximum level (the meter should not be “peaking” constantly).

9. If Solo and Mute are on, tap or press them so they are off. Also, tap the automation button so it is off/gray (not
green/Read [R] or red/Write [W]). Alternatively, press Read/Write (MPC X).

10. Tap the Record Arm button to record-enable the track. Alternatively, press Rec Arm (MPC X).
11. Press Rec to record-arm the sequence.

12. To start recording, press Play or Play Start—then play your audio source! You should hear your existing
sequence playing in the background.

To stop recording, press Stop.

Record another audio track for your other sequence: Select the other sequence in Main Mode, and create another
audio track (Audio 002) to go with that sequence.
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Creating a Song

This section explains how to make a song out of your sequences. Before starting, make sure that you have recorded
some sequences (which we described earlier).

To enter Song Mode, make sure playback is stopped, and then press Menu, and then tap Song to enter Song Mode.
Alternatively, press Song (MPC X).
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In Song Mode, each of the sequences you’ve created in this project assigned to a pad. The sequence playlist is to
the left of the pads, showing the song’s structure.

As a song plays, it moves through each step of the sequence playlist. Each step contains a sequence you assigned.
Each step can be repeated, determined by the value in the Repeat column (the repeat icon; a value of 1 means the
sequence will play through only once). The Bars column on the right indicates the length of that sequence.

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM column.

Important: Each sequence has its own tempo, while the project itself may use a different master tempo. The BPM value
for each sequence may be different from the master tempo. As long as playback is set to follow the master tempo, each
sequence’s individual tempo will be ignored. By default, each project is set to use the sequence tempo, which you set
back in the Creating a Drum Sequence chapter. We recommend tapping the Seq/Mst button at the top of the screen
(so the button displays Mst) and entering a master tempo to ensure all sequences use the same tempo.

To insert a step at the current position, tap Insert.
To delete the currently selected step, tap Delete.

To set which sequence plays for a step, tap the step’s Sequence field, and then turn the data dial to select a
sequence.

To set how many times a sequence repeats, tap the step’s Repeat field (next to the sequence name), and then
turn the data dial to select a number.
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Exporting the Song

Want to share your new song? Just export it first.

<& Audio Mixdown
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CANCEL EXPORT

To export a song:
1. While in Song Mode, tap Export at the bottom of the screen.
2. In the Audio Mixdown screen that appears, do the following:
e Make sure the Start field is set to 1, and set the End field to the last bar of your song.
o Tap the Audio Tail field and turn the data dial to set it to 2 seconds.
e Asyou’ll likely share the song online, tap the mp3 file format option in the lower-left corner.
3. Tap Export. Choose where you want to save the song.

To name the song, tap the File Name field, and use the virtual keyboard that appears to enter a new name, and
then tap Save to start exporting.
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Other Features Explained

This chapter describes various advanced features. For a fuller explanation of these features, please refer to their
corresponding sections in the Operation chapter.

Step Sequencer

You've already learned how to record note events on a track, but you can quickly enter note events in the Step
Sequencer by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum
machine.

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. Alternatively, in some modes, you can
tap the steps icon on the left edge of the screen. You can also press Step Seq (MPC X, MPC One).
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1. Let’s create a sequence on a new track. Tap the Track field in the upper-left corner, and then use the data dial or
—/+ buttons to select an (unused) track. Alternatively, double-tap the Track field, and then tap a track to select it.

2. Tap the Track Length field at the top of the screen to set a length for the track, and then use the data dial or the
—/+ buttons to select a length. If you select the minimum value, Sequence, the track will be however long your
sequence is.

Tip: This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence
repeatedly under a 4-bar bass line.

3. Tap the Bar -/+ buttons at the bottom of the screen to select the bar whose steps you want to create or edit.
The bar number will appear in the Bar field in the upper-left corner.

4. Tap the Pad -/+ buttons at the bottom of the screen to select the pad whose steps want to create or edit. The
pad number will appear in the Pad field in the upper-left corner.

Press Play to start your sequence.

6. Each pad represents a step in the bar. If the pad already has note events on the selected track, the corresponding
pads (steps) will be lit with colors corresponding to their velocities.

To enter a note at a step, press an unlit pad. The pad will light up with a color corresponding to its velocity.
To delete the note from a step, press a lit pad. The pad will become unlit.

To delete all notes from the entire bar, press and hold Shift, and then tap Clear Bar in the lower-right corner.

See Operation > Modes > Step Sequencer to learn more about this feature.
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Drum Loops & Chop Mode

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains
how to use Sample Edit Mode to work with drum loops.

Use the Browser to locate a drum loop, and then double-tap it to add it to the current program. The loop does not
have to match the tempo of anything in the project.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively,
press Sample Edit (MPC X, MPC One).
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1. Tap the Sample field at the top of the screen, and then use the data dial or —/+ buttons to select the loaded
drum loop. You can scroll through all loaded samples in the project. Alternatively, double-tap the Sample field,
and then tap a sample to select it.

2. Tap the Trim/Chop tab in the lower-left corner to switch between Trim Mode and Chop Mode. Select Chop
Mode, which will let us cut the drum loop into slices.

3. Tap Threshold, and then tap the Threshold field to the right of it. Use the data dial, —/+ buttons, or numeric
keypad (MPC X) to select a value. Alternatively, double-tap the Threshold field and use the numeric keypad on
the screen. The lower the threshold, the more slices will be created. Be sure to select a value so that every
transient peak of the drum loop has a corresponding a slice marker.

Tip: Each slice will be automatically assigned to a pad: Pad A01 plays Slice 1, Pad A02 plays Slice 2, etc. Press
each pad to play the slice with the same number.
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Let’s use this chopped sample to create a new program in which each of these slices is an individual sample. We
can also automatically create corresponding note events to play back these slices sequentially.

I e
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Press and hold Shift and then tap Convert at the bottom of the screen to enter the Convert or Assign Slices
window.

Tap the Convert To field, and then use the data dial or —/+ buttons to select New Program with New Samples.
Make sure Crop Samples is checked. If it is not, tap it.

Make sure Create New Program is checked. If it is not, tap it.

Make sure Create Events is checked. If it is not, tap it.

Tap the Bars field, and then use the data dial or —/+ buttons to select how many bars the entire sample should
use in your program.

Tap Do It to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note event in the
track. When you play that track, it will play each pad (each slice) in the original order. Press Menu and then tap
Grid View to see how the sample appears in your sequence.

Press Play and listen to how the drum loop matches your song tempo now.

You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with the note
events playing their corresponding slices has been automatically created. Tap the TC/clock icon at the top of the
screen to use the Timing Correct window to quantize the note events so they fall on exact, even time intervals.

You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each
slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the
frequency range of a selected slice. There are almost no limits to what you can do.

See Operation > Modes > Sample Edit Mode > Chop Mode to learn more about this feature.
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Pad Muting & Track Muting

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the sequence sounds
like without those samples or parts.

To enter Pad Mute Mode, press Menu, and then tap Pad Mute to enter Pad Mute Mode. Alternatively, press
Shift+Track Mute/Pad Mute (MPC X, MPC One).
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1. Press Play to play the sequence.

2. Tap the Program field at the top of the screen, and then use the data dial or =/+ buttons to select your drum
program. Alternatively, double-tap the Program field, and then tap a program to select it.

3. Mute a pad by pressing it once or tapping it on the screen. The muted pad will be lit red. You can mute multiple
pads at the same time.

See Operation > Modes > Pad Mute Mode to learn more about track mutes.
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You can also mute entire tracks by using the similar Track Mute function.

To enter Track Mute Mode, press Menu, and then tap Track Mute to enter Track Mute Mode. Alternatively, press
Track Mute (MPC X, MPC One).
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1. Press Play to play the sequence.

2. Tap the Sequence field at the top of the screen, and then use the data dial or —/+ buttons to select the desired
sequence. Alternatively, double-tap the Sequence field, and then tap a sequence to select it.

3. Each pad is assigned to a track. Mute a track by pressing the corresponding pad or tapping it on the screen. The
pad will be lit red. You can mute multiple tracks at the same time.

Tip: To mute a track only at precise note intervals (“quantizing” your mutes, essentially), tap Time Division to set
a musical timing value. Tap the desired musical value (e.g., 1 Bar). Alternatively, use the data dial or —/+ buttons. Tap
Close to close the page. Now, when you press a pad in Track Mute Mode, the mute will occur precisely at the
beginning of the following time division (in this example, one bar). This lets you test musical combinations of
patterns—the preliminary stage to building a song structure.

See Operation > Modes > Track Mute Mode to learn more about track mutes.
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Sampling (Recording)

This section describes recording new samples of your own, which you can use in your projects.

Important: To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s
audio interface.

To open the Sampler, press Menu, and then tap Sampler to enter Sampler Mode. Alternatively, press Sampler
(MPC X, MPC One).

00:05:22

SLICE +

1. Connect an audio source to the input/inputs of your MPC hardware.

2. The Input ___ menu in the upper-left corner should be set to Input 1,2 (the inputs of your MPC hardware). If it is
not, then select Input 1,2.

3. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC One, MPC Touch) knob to set the input level while
playing your audio source. You should now see the level in the meter. Make sure it does not exceed the
maximum level (the meter should not be “peaking” constantly).

4. Tap and drag threshold slider to set the threshold. Alternatively, use the data dial or —/+ buttons. Set it to a
fairly low level (e.g., -50 dB).

Tap Arm to record-arm the Sampler.

Play your audio source. The Sampler will start recording immediately when the input level reaches the threshold
value. Alternatively, tap the round Record button to manually start recording.

7. To stop recording, tap the round Stop button. The Keep or Discard Sample window will appear.
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In the Keep or Discard Sample window:
To name the new sample, tap the Edit Name field and use the virtual keyboard to enter a name.

To assign the new sample to a program, tap the Program field, and then use the data dial or —/+ buttons to
select the desired program. Alternatively, double-tap the Program field, and then tap a program to select it.

To assign the sample to a pad in the program, tap the Assign to Pad field, and then press the desired pad.
Alternatively, use the data dial or =/+ buttons to select the desired pad number, or double-tap the Pad field, and
then tap a pad number.

To set the Root Note for the sample, tap the Root Note field, and then then use the data dial or —/+ buttons to
select the desired note.

To save the sample, tap the Save button at the bottom of the screen.
To play the recording, tap the Play button at the bottom of the screen.

To discard the recording and return to the previous screen, tap the Discard button at the bottom of the
screen.

To confirm your selections, tap Keep at the bottom of the screen.

To edit the sample in Sample Edit Mode, tap the Edit button at the bottom of the screen.

See Operation > Modes > Sampler to learn more about this feature.
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Sample Editing

You may need to edit your newly recorded samples using Sample Edit Mode.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively,
press Sample Edit (MPC X, MPC One).

filn]

Synth01C3
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PROGRAM - ASSIGN PROCESS

In Sample Edit Mode:

To switch between Trim Mode and Chop Mode, tap the Trim/Chop tab at the bottom of the screen. In this
example, use Trim Mode.

To set the sample’s start point, use the first column of Q-Link knobs (when in the Screen Q-Link Edit Mode)
to adjust the start point with varying degrees of resolution. Alternatively, tap and drag the S marker in the
waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or
tap the Start field and use the numeric keypad).

To set the sample’s end point, use the second column of Q-Link knobs (when in the Screen Q-Link Edit
Mode) to adjust the end point with varying degrees of resolution. Alternatively, tap and drag the E marker in the
waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or
tap the Start field and use the numeric keypad).

To hear your edits, press Pad 10 to play the sample from the start point to the end point.
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Let’s apply some processing to the sample.

To open the Process Sample window, tap Process at the bottom of the screen.

Fil]  PROCESS SLICE

Pitch Shift

FUNCTION CANCEL

1. Use the data dial or —/+ buttons to select the desired process in the Function field. Alternatively, tap Function
or double-tap the Function field, and then tap the desired process. Let’s select Pitch Shift to change the overall
pitch of your sample. This will transpose the sample without affecting its length.

2. To set the pitch shift amount, tap and drag the knob in the center of the window up or down. Alternatively, use
the data dial or —/+ buttons.

To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap anywhere else
to return to the previous screen.

3. To confirm your selections, tap Do It.

To cancel the process, tap Cancel.

See Operation > Modes > Sample Edit Mode to learn more.
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Recording Automation with the XY Pad

Automating various parameters is a good way to add some motion and dynamism to your sequences.

10.
11.

X

Outputs 1/2

HPF Manual

Press Menu, and then tap XYFX to enter XYFX Mode. Alternatively, press XYFX (MPC X), or press Shift+Next
Seq/XYFX (MPC One).

Double-tap the XYFX Location field, and select Program.

When you first enter this mode in a project, you will be prompted to “load” XYFX to the program. Tap Insert
XYFX to do this.

Tap Setup to show the Setup panel, which controls how the XY pad behaves.

Double-tap the Preset field, and tap an effect to select it. (These are just the effects available in XYFX Mode, not
all MPC effects.) Swipe up or down to view the entire list.

Tap and drag any of the knobs (Attack, Release, or Wet/Dry) up or down to set their values as desired. Below
them, you can see what parameter the X axis and Y axis control.

Note: XYFX uses an envelope to control how quickly the effect crossfades between the dry signal and wet signal.
The Attack knob determines how long it takes the completely dry signal to reach the wet signal (determined by
the Wet/Dry knob) after you touch the XY pad. The Release knob determines how long it takes the wet signal
(determined by the Wet/Dry knob) to return to the completely dry signal after you touch the XY pad.

Tap the automation button or press Read/Write (MPC X) to cycle through the available automation modes.
Make sure the button is red (the Write (W) option).

Press Play Start to start recording.

As you record, move your finger over the XY pad on the screen. The changes in the sound are being recorded as
automation of both the X axis and Y axis parameters.

Tip: While touching the XY pad, tap Latch in the lower-left corner to keep the marker on the XY pad even after
you release it. The marker will remain there until you touch another part of the XY pad or until you tap Latch again.

When you are done recording, press Stop.

Tap the automation button or press Read/Write (MPC X) to select the green Read (R) option. This ensures
your track uses the automation you just recorded when you play it back.

See Operation > Modes > XYFX Mode to learn more about using this feature.
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Using MPC X, MPC Live or MPC One as a Controller

If you are using the MPC software on your computer, you can switch MPC X, MPC Live or MPC One into Controller
Mode, allowing you to use it to control the software. MPC Touch already operates as a controller only.

The MPC software offers the same features and functionality as the MPC hardware in Standalone Mode but with some
notable differences, which are discussed in Operation > General Features > Standalone vs. Controller Mode.
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This chapter explains the complete features and functions of your MPC hardware.

Important:

When accessing the secondary functions of buttons on your MPC hardware, you can do this one of
two ways: (1) pressing and holding Shift and then pressing the desired button or (2) double-pressing
the desired button. This manual describes these operations using only the first option, but both are
acceptable.

When the left-most button at the bottom of the screen shows an upward arrow (1), it means there are
additional buttons you can use when you press and hold Shift. Press and hold Shift to show the
secondary buttons, and any of them, if desired. Release Shift to return to the previous buttons.

Almost every mode shown on the screen has 1-6 buttons at the bottom. Each of these buttons select
a different tab in that mode or perform a specific function in that mode.

MPC X: You can press the F-Key button to activate or deactivate the F-Key feature. When active, the
six buttons under the touchscreen correspond to the options shown at its bottom edge. The F-Key
button and those six buttons will be lit red when active. When inactive, the six buttons under the
touchscreen will access their normal modes instead (Menu, Browser, Step Seq, Sampler, XYFX,
and Looper).

MPC X: As an alternative to tapping a control on the screen to select it, you can use the cursors to
navigate through the controls on the screen. The center cursor acts as an Enter key.

MPC Live, MPC One, MPC Touch: As an alternative to double-tapping an item on the screen to
“enter” it, you can press the data dial.

When a parameter is highlighted and has a red outline, this means that it is selected. You can then
change it by turning the hardware’s data dial or using the =/+ buttons. If the parameter is a number,
double-tap it to show a numeric keypad on the screen to enter a specific value, or use the numeric
keypad (MPC X).

MPC Live, MPC One, MPC Touch: When the touchscreen shows a parameter or group of
parameters with a gold outline (and sometimes a Q in the corner), this means that the current bank of
Q-Link knobs will control those parameters or settings. Turn a Q-Link knob to adjust its
corresponding parameter value or setting in that group. When the value has decimal places, you can
sometimes press and hold Shift and then turn the Q-Link knob to adjust the value by smaller
increments. You can also press the Q-Link button to select another group of four parameters.

Press and hold the any of the Q-Link buttons (Project, Program, Pad Scene, Pad Param, or Screen
Control/Edit: MPC X) or the Q-Link button (MPC Live, MPC One, MPC Touch) to see an overview of all
16 Q-Link knobs and their parameters in the QLinks window that appears. You can then tap a column
or row of knobs to select those four Q-Link knobs, and then release the Q-Link button. See Modes >
Q-Link Edit Mode to learn more about using the Q-Link knobs throughout your project.
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General Features

Control Types

The MPC touchscreen uses the following types of control elements:

Knobs
To set the value for a knob, do any of the following:
e Tap and drag the knob up or down.

e Tap the knob to select it, and then use the data dial or —/+
buttons to adjust the value.

e Double-tap the knob to show it in a larger screen. Alternatively,
press the data dial, or the center cursor or Enter (MPC X),
when the knob is selected.

Tap and drag the larger version that appears, or use the data dial
or —/+ buttons to adjust the value.

If the knob is bipolar (has positive and negative values with the
center as the default position), double-tap the larger version to
reset it to the center/0 position.

Tap anywhere else to return to the previous screen.

e Press and hold Shift while turning the data dial to adjust a value
by smaller increments.

Parameter Values

To set the value for a parameter, do either of the following:

FILTER
ENVELOPE

o Tap the field to select it, and then use the data dial or —/+ buttons
to adjust the value.

When the value has decimal places, you can sometimes press and e
hold Shift and then use the data dial or —/+ buttons to adjust the
value by smaller increments.

e Double-tap the field or hold your finger on it for a second. In the
screen that appears, use the numeric keypad, the data dial, or Z3EER
the —/+ buttons to adjust the value. Alternatively, tap and drag
the value up or down. ‘ 76.03

You can also tap /2 to halve the value or x2 to double it.
To confirm the value and remain on this screen, tap Apply.
To confirm the value and return to the previous screen, tap Do It.

To return to the previous screen without changing anything,
tap the gray area in the upper-left corner of the screen.
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Drop-Down Menus / Lists
To select an option for a drop-down menu, do any of the following:
e Tap the field to select it, and then use the data dial or —/+ buttons to select an option.

e Double-tap the field. In the list that appears (examples below), tap the desired option. Alternatively, use the
data dial or the -/+ buttons to select an option.

In some windows, tap the relevant button at the bottom of the screen to confirm your selection or to cancel
without changing anything.

INSERTS
1 Distortion Am

2  Compressor \ ge[2in2out]

3 | NOEFFECT

e

4 NOEFFECT

Major

Natural Minor
@& Drums PAD AO3

HP Filter Sync
Harmonic Minor Y

HP Filter

Pentatonic Major HP Shelving Filter

LP Filter Sweep
Pentatonic Minor
LP Filter Sync
Blues LP Filter

LP Shelving Filter
Flamenco

MPC60

DEN 2-Rand 2-Shelf

MANUFACTURER SELECT

Selectors

Selectors show all available options. One of them is always selected. The
selected option is highlighted while the others are dark.

To select an option, tap it.
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Buttons

Buttons usually have two states: selected and deselected (active or inactive, respectively).
Some may have more than two states.

PRESETS

To switch between or cycle through a button’s states, do either of the following:
o Tapit

e Ifitis outlined in red (and is not a mute button), use the data dial or —/+ buttons. M
VS
>«

AV

Checkboxes
Checkboxes have two states: checked and unchecked (enabled or disabled, respectively).

To check or uncheck a checkbox, tap it.

Tabs

Some modes have buttons at the bottom of the screen that let you cycle through several
similar tabs. For instance, you could view the send level that is routed to each of four
returns—each level is shown on a separate tab. With each tap, you will move to the next
tab, indicated by the squares below it. cHop

TRIM

To select a tab, tap it. Each time you tap it, it will select the next tab.

INSERT

Sliders

To adjust the position of a slider, do any of the following:
e Tap and drag the slider to the desired position.
e Tap the desired position (this works only on some sliders).

o Tap the slider to select it, and then use the data dial or —/+ buttons to adjust the position (this works only on
some sliders).

¢ Double-tap the slider, and then tap and drag the larger version that appears, or use the data dial or —/+ buttons
to adjust the value. If the slider controls a volume level, double-tap the larger version to reset it to 0 dB. Tap
anywhere else to return to the previous screen.

VELOCITY
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Envelopes
To set the stages of an envelope, do either of the following:

Tip: Tap the expand-rectangle icon above the envelope to show a close-up view.

e Tap and drag a “handle” of an envelope stage in the desired direction.

e Set the numeric value of an envelope stage by adjusting or entering it as a parameter value
(described earlier).

FILTER ENVELOPE ()

FILTER
Low 2 ~

MODULATION
SOURCES

AmpENVELOPE (3

FILTER
ENVELOPE DECAY FROM

W aros 21 [ eno |

AMP
ENVELOPE

om 37 125 127 34

MAS R SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION

The Filter/Envelope tab in Program Edit Mode.

& FILTER ENVELOPE & AMPENVELOPE

Close-up of an AD-type filter envelope. Close-up of an AHDS-type amp envelope.
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Grid View Tools

In the Grid View, these four icons enable you to use different functions in the grid.

Tap one to select its mode:

Pencil: Draw Mode:

To enter a note in an empty grid square, tap the grid square.
To select a note, tap it.
To move a note, tap and drag it to another grid square.

To erase a note, double-tap it.

Eraser: Erase Mode:

To erase a note, tap it.

Select Box: Select Mode:

Note: Notes will remain selected if you switch to another mode. The selection will change, however, if you
press a pad while Hitting Pad Selects All Events is set to On.

To select a note, tap it.

To select multiple notes, tap and drag across the grid to create a box around them.
To move a note, tap and drag it to another grid square.

To move multiple notes, select them as described above, and tap and drag them.

To erase multiple notes, select them as described above, and then select the eraser tool and tap any
of the selected notes.

@ Magnifying Glass: Navigation Mode:
~ To move to another part of the grid, tap and drag it.

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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Audio Edit Tools

In Audio Edit Mode, these six tool icons enable you to use different functions in the waveform.

Tap one to select its mode:

Marquee: Marquee Mode:
To select a track region, tap the upper third of it.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To split the track at two specific points (creating a track region on either side and between them), tap and
drag across the middle third of it to create a translucent white box, and then tap the upper third of that box.

To shorten or lengthen a track region (or multiple selected track regions), tap and drag the lower third
of it left or right.

Arrow: Selection Mode:

To select a track region, tap it.

E2

To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To shorten or lengthen a track region (or multiple selected track regions), tap its edge and drag it.

Eraser: Erase Mode:

To select multiple track regions, tap and drag across the grid to create a box that highlights them.

To erase a track region (or multiple selected track regions), tap it.

Scissors: Split Mode:

E

To split the track at a specific point (creating a track region on either side), tap that point in the track.
To select a track region, tap its left-most edge.

To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

Mute: Mute Mode:

To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

I3

To mute or unmute a track region (or multiple selected track regions), tap it.

Magnifying Glass: Navigation Mode:

To move to another part of the track, tap and drag it.

B

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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Programs

About Programs

Each track you create within a sequence is routed through a program. There are six
types of programs, each of which determines how the track sounds or what it is used
for. A single project can hold up to 128 programs.

This chapter covers how to create each program type.

To learn about editing your programs to your preference, see the Modes > Program
Edit Mode chapter.

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2)
the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum
programs are used mostly for creating drum parts and quickly and easily assigning samples to pads. See
Drum Programs for more information.

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and
(2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play
samples chromatically with a MIDI keyboard or the MPC pads. See Keygroup Programs for more
information.

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad,
which you can press to trigger the clip according to a quantization setting. This lets you create intriguing,
layered performances by launching different combinations of clips together. See Clip Programs for more
information.

A plugin program contains an instance of a plugin through which you can send your track’s MIDI data.
See Plugin Programs for more information.

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum
machine. See MIDI Programs for more information.

A CV program lets you send your track’s MIDI data to an external MIDI device that uses control voltage
(CV), like a synth. See CV Programs for more information.
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Drum Programs

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings
for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for
creating drum parts and quickly and easily assigning samples to pads.

To create a drum program:
1.
2.

Press Main to enter Main Mode. B

1 Drums

Next to the Track field, tap the four-squares icon, which indicates a drum
program.

If the project does not contain a drum program yet, a new drum program
(named Program, appended with a number) will be added automatically to
the project and appear in the Program field below.

If the project already contains a drum program, the first one will be selected
automatically and appear in the Program field below.

To create another drum program, tap the + icon above the Program field.
A new drum program will be created and appended with a number (e.g.,
Program 002).

To rename the program, tap the cursor icon on the right edge of the Program
section. Use the virtual keyboard that appears to enter a new name, and then
tap Do It to confirm or the gray bar at the top of the screen to cancel.

To load a sample into a drum program:

1.

Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Find
and select a sample, and then tap Load to load it to the program. Repeat this for any other samples you want to
load into the project. (See Modes > Browser to learn more about using the Browser specifically.)

Tap Sample Assign to view the pads and project’s sample pool.
Press or tap a pad to select it. The pad will be lit green.

In the Sample Pool list, tap a sample to assign it to the pad. Alternatively, use the data dial or —/+ buttons to
assign a sample and/or change the assigned sample.

To clear the assigned sample from a selected pad, tap Clear Pad.
To assign samples to additional pads, repeat Steps 3—4.

Tip: Remember that a drum program has 128 pads total—16 pads across eight banks.

] Program 001 ] [Internal]\Expansions\The Vault 2

SAMPLE POOL A% A ats s O,  Search directory

i 1980Kick1
e -
Wl Kick2

A A an 2

Acoustic-Cymbal-Ac1 Rd B

Acoustic-Cymbal-Ac2 Crsh
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Alternatively, assign samples in a drum program in Program Edit Mode in one of these two ways:
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Pad -3 0

- 100% 300.00

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

1. Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X,
MPC One).

2. Tap the Samples tab. This lets you view the samples assigned to all four layers of the current pad as well as
tuning and level parameters for each layer.

Tap a pad to select it (and play its assigned samples, if any). The pad will be lit green.

Tap one of the Layer fields under the sample waveform to select a layer. Tap the Sample field, and then use the
data dial or —/+ buttons to select a sample. Alternatively, double-tap the field for a layer, and then tap a sample

to select it.

198LKick

1980Kick1

None

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

1. Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X,
MPC One).

2. Tap the Pan Velocity tab. This lets you view the samples assigned to all four layers of the current pad as well as
panning and velocity ranges of each layer.

Tap a pad to select it (and play its assigned samples, if any). The pad will be lit green.

Tap one of the Layer fields to select a layer, and then use the data dial or —/+ buttons to select a sample.
Alternatively, double-tap the field for a layer, and then tap a sample to select it.
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Keygroup Programs

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the
settings for each sampile (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically
with a MIDI keyboard or the MPC pads.

To create a keygroup program:

1.
2.

Press Main to enter Main Mode.

Next to the Track field, tap the piano-keys icon, which indicates a keygroup
program.

If the project does not contain a keygroup program yet, a new keygroup program
(named Program, appended with a number) will be added automatically to the
project and appear in the Program field below.

If the project already contains a keygroup program, the first one will be selected
automatically and appear in the Program field below.

To create another keygroup program, tap the + icon above the Program
field. A new keygroup program will be created and appended with a number
(e.g., Program 002).

To rename the program, tap the cursor icon on the right edge of the Program
section. Use the virtual keyboard that appears to enter a new name, and then tap
Do It to confirm or the gray bar at the top of the screen to cancel.

To assign samples in a keygroup program:

1.

Press Menu, and then tap Program Edit to enter Program
Edit Mode. Alternatively, press Prog Edit (MPC X, MPC SIS
One).

Tap Samples. This lets you view the samples assigned EREGEEESEIS
to all four layers of the current keygroup as well as
tuning and level parameters for each layer.

Tap the Number of KG field, and then use the data dial
or =/+ buttons to set the number of keygroups in the
program (1-128). Alternatively, tap the Number of KG
field, and then use the numeric keypad to enter a value (or
double-tap the Number of KG field, and then use the

Synth 01 C2

5 Synth Pad

Synth 01

- JEED

numerlc keypad on the Screen), MA SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Tap the Keygroup field, and then use the data dial or —/+
buttons to select a keygroup. Alternatively, double-tap the
Keygroup field, and then tap a keygroup to select it.

Tap a pad to play the sample in the keygroup. The pad will be lit green.

Tip: On your MPC hardware, press the Pad Bank D button to and press Pad 13. You should hear the sample
played back with its original pitch. You can use the other pads to play your sample chromatically.

Tap the field for a layer, and then use the data dial or -/+ buttons to select a sample. Alternatively, double-tap

the field for a layer, and then tap a sample to select it.

To create complex keygroup programs, you can add more keygroups (up to 128). This is useful when working with
multi-samples (e.g., when programming a real piano).

Tip: Remember that a keygroup program offers up to 128 keygroups, and each keygroup can hold up to four
samples (Layers 1-4). This is a total of 512 samples.
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Clip Programs

A clip program uses several samples that can be looped
(clips). Each clip can be assigned to a pad, which you can
press to trigger the clip according to a quantization setting.
This lets you create intriguing, layered performances by
launching different combinations of clips together.

By default, the 16 pads are divided into four columns of four
pads. Each column represents a mute group; when a pad is
playing a clip, all other pads in that same mute group are
turned off. This enables you to launch a clip without having
to manually stop other clips that are similar. For instance,
pressing Pad 2 may launch a bass clip. You could then
press Pad 6, which launches another bass clip and stops
the clip on Pad 2. This way, you’ll never be playing two bass
clips simultaneously.

The four-columns pad configuration described above is just
a default to make things easy (e.g., you could use the first
column for drum clips, the second for bass clips, the third
for keyboard clips, and the fourth for vocal clips). You can
use Program Edit Mode to assign pads to any combination
of mute groups you want.

To create a clip program:
1. Press Main to enter Main Mode.
2. Next to the Track field, tap the play-button icon, which indicates a clip program.

3. If the project does not contain a clip program yet, a new clip program (named Clip, appended with a number) will
be added automatically to the project and appear in the Program field below.

If the project already contains a clip program, it will be selected automatically and appear in the Program field
below.

To create another clip program, tap the + icon above the Program field. A new clip program will be created
and appended with a number (e.g., Clip 002).

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that
appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.
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To load a clip into a clip program:

1.
2.
3.

Press Main to enter Main Mode.
Tap Edit Clips to view the pads and clip settings.

Press or tap a pad to select it (and play its assigned samples, if any). The pad on the screen will be lit red, and its
number will appear in the Pad field.

Tap the Sample field, and then use the data dial or —/+ buttons to select a clip. Alternatively, double-tap the
Sample field, and then tap a clip to select it.

To clear the assigned clip from a selected pad, repeat Step 4, but select None.

To assign clips to additional pads, repeat Steps 3-4.

Clip 001

SAMPLE POOL

e Elect13
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=" Loop Bass NuElec

=" Loop Bass Sq Ab

= Loop Bass Tech Ab
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BROWSE SAMPLE ASSIGN =) AUDITION CLEAR PAD

Alternatively, assign clips in a clip program this way:

1.

Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Find
and select a clip, and then tap Load to load it to the program. Repeat this for any other clips you want to load
into the project. (See Modes > Browser to learn more about using the Browser specifically.)

Tap Sample Assign to view the pads and project’s sample pool.

Tap Assign Mode so it is selected (tapping an item in the sample pool will now assign it automatically to the
current pad).

In the Sample Pool list, tap a clip to assign it to the pad. Alternatively, use the data dial or —/+ buttons to assign
a clip and/or change the assigned clip.

To clear the assigned clip from a selected pad, tap Clear Pad.

To assign clips to additional pads, repeat Steps 4-5.
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Plugin Programs

A plugin program contains an instance of a plugin through which
you can send your track’s MIDI data. This lets you use the same

instance of a plugin with multiple tracks (rather than load an EEETGIGLEEE

instance of a plugin on every track, which can be cumbersome and

CPU-intensive). : Hybrid 3

H\fb"‘d 3001 01 Trance-ition Pad

To create a plugin program:

1.
2.
3.

Press Main to enter Main Mode.
Next to the Track field, tap the plug icon, which indicates a plugin program.

If the project does not contain a plugin program yet, a new plugin program (named Plugin, appended with a
number) will be added automatically to the project and appear in the Program field below.

If the project already contains a plugin program, the first one will be selected automatically and appear in the
Program field below.

To create another plugin program, tap the + icon above the Program field. A new plugin program will be
created and appended with a number (e.g., Plugin 002).

Double-tap the Plugin field. In the list that appears, tap the desired plugin. Alternatively, use the data dial or the
—/+ buttons to select a plugin.

To sort your plugins by type or maker, tap Type or Manufacturer.
Tap Select to select the plugin, or tap Close to cancel.

Note: You have to specify the disk directory where your plugins are located. This can be done in the software’s
Preferences (in the Edit Menu). See the user guide in the MPC software to learn more: click the Help menu,
select MPC Help, and select MPC User Manual.

To select the MIDI channel the program will use, double-tap the MIDI Ch field. In the list that appears, tap the
desired channel. Alternatively, use the data dial or the —/+ buttons to select a channel. Use this setting when you
are working with a virtual instrument plugin that supports multi-mode.

To select a preset in your plugin (if any), double-tap the Preset field. In the list that appears, tap the desired
preset. Alternatively, use the data dial or the —/+ buttons to select a preset.

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that
appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To adjust the volume and panning of a track using the plugin program:

1.

Press Menu, and then tap Channel Mixer to enter the Channel Mixer. Alternatively, press Ch. Mixer (MPC X) or
Track Mix (MPC One).

2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks.
Tap the square that represents the track with the plugin program to select it.

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the
volume and panning of the plugin program normally.

Important:

If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to
a new sequence and put the same plugin program on a new track.

By default, some plugins do not support MIDI volume and pan. In this case, adjust volume levels and panning on the
plugin program.
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MIDI Programs

A MIDI program lets you send your track’s MIDI data to an
external MIDI device like a synth or drum machine.

8 Timbre Wolf

Midi 001

To create a MIDI program:
1. Press Main to enter Main Mode.
2. Next to the Track field, tap the MIDI-jack icon, which indicates a MIDI program.

3. If the project does not contain a MIDI program yet, a new MIDI program (named Midi, appended with a number)
will be added automatically to the project and appear in the Program field below.

If the project already contains a MIDI program, it will be selected automatically and appear in the Program field
below.

To create another MIDI program, tap the + icon above the Program field. A new MIDI program will be created
and appended with a number (e.g., Midi 002).

4. There are five additional settings to configure for a MIDI program: the MIDI Port, program change message
(Program Ch), MIDI channel (MIDI Ch), Most Significant Byte (Bank MSB), and Least Significant Byte (Bank
LSB). See this section to learn more.

To configure each setting, double-tap its field. In the list that appears, tap the desired option. Alternatively, use
the data dial or the —=/+ buttons to select an option.

Note: You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See the user
guide in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual.

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that
appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To adjust the volume and panning of a track using the MIDI program:

1. Press Menu, and then tap Channel Mixer to enter the Channel Mixer. Alternatively, press Ch. Mixer (MPC X) or
Track Mix (MPC One).

2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks.
Tap the square that represents the track with the MIDI program to select it.

4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the
volume and panning of the MIDI program normally.

Important: If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if
you move to a new sequence and put the same MIDI program on a new track.
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CV Programs

A CV program lets you send your control voltage (CV) signals
to an external MIDI device like a synth or drum machine that
uses CV.

To create a CV program:

1.
2.
3.

Press Main to enter Main Mode.
Next to the Track field, tap the CV icon, which indicates a CV program.

If the project does not contain a CV program yet, a new CV program (named CV, appended with a number) will
be added automatically to the project and appear in the Program field below.

If the project already contains a CV program, it will be selected automatically and appear in the Program field
below.

To create another CV program, tap the + icon above the Program field. A new CV program will be created and
appended with a number (e.g., CV 002).

There are five additional settings to configure for a CV program: the note tracking (Note), the CV Port, the Gate
Port, the modulation wheel (Mod Wheel), and Velocity Port.

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual
keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the
screen to cancel.
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Menu

The Menu lets you select any of the 21 modes or save your project. On MPC X, MPC Live or MPC One, you can also
use it to set your preferences, switch between Standalone Mode and Controller Mode, or view your system
resources.

To open the Menu, press Menu, or tap the icon in the upper-left corner of the screen while on the normal page of
your current mode.

When viewing the Menu, do any of the following:
To enter a mode, tap it.

Important: If a sequence is currently playing, you will not be able to enter Song Mode. Stop playback before
entering Song Mode.

To return to the previous mode, tap the gray area in the upper-left corner, or press Menu again.

You can also press and hold the Menu button and press a pad to select a menu mode. The pads follow the 4x4
layout of the Mode Menu.

A o Pl

SAMPLE EDIT PROGRAM EDIT LISTEDIT BROWSER

AUDIO EDIT O,J C“D il ak

SAMPLER LOOPER PAD MIXER CHANNEL MIXER

TRACK VIEW
>3
PAD MUTE TRACK MUTE NEXT SEQUENCE

STEP SEQUENCER

.
-
']
[]

Q-LINKEDIT PAD PERFORM MIDI CONTROL PAD COLOR

Note: The Menu above is available when the currently selected track is a MIDI track. When an
audio track is selected, it will show an icon for Audio Edit Mode instead of Grid View.

AUDIO EDIT

Click a part of the screen above to skip directly to that part of this user guide.
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Save

To save the project, tap the disk icon at the top of the screen. Alternatively, press Shift+Browse/Save (MPC X,
MPC One). If you have already saved the project, your changes will be saved. If you have not saved the project yet,
use the Save window to save the project:

€& Save B [Internal\MPC Documents\Projects (7

Project 01.xpj
L Internal Project 02.xpj
Project 03.xpj
Project 04 .xpj

Project 05.xpj

Project 06.xpj

B Project 07 .xpj

FILE NAME Project 08 ' ‘ SAVE AS TEMPLATE

NEW FOLDER CANCEL

To select the storage device you want to view, tap it in the Storage column on the left.
Internal is the internal drive of MPC X, MPC Live or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live or MPC
One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live or MPC One, or your
computer (with MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the —/+ buttons to move through the list, and
press the data dial, or the center cursor or Enter (MPC X), to enter a folder. You can also tap one of the five
folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see Modes > Browser to
learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It.
You will immediately enter the new folder.

To move up one folder level, tap the folder/L icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To save the file as a project template file, tap the Save as Template checkbox to check it before tapping Save.
(This file will be shown in the Template File field in the Preferences’ Project Load/Save tab.)

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.
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Preferences

To open the Preferences, tap the gear icon at
the top of the screen. Preferences

To return to the Menu, tap the € icon in the INFO
upper-left corner. Changes to the Preferences are

saved automatically except for Vintage Mode (in MPE

the General tab) and Start Time (in the Sync tab).

To restore your MPC hardware’s default
settings, tap Reset. In the screen that appears,
tap OK to continue or Cancel to return to the [ )
Preferences. In the next window, tap Save to save | (1111111111111
your current project before restoring the default [
settings; tap Cancel to return to the Preferences;
or tap Don’t Save to restore the default settings
without saving your current project.

Important: For MPC X, MPC Live and MPC Oneg,
the Preferences will appear differently in Controller
Mode than in Standalone Mode. Some of the
options described in this section may be available in
only one of these modes or in a different order.

Info

This screen shows current information about your MPC hardware: its current firmware version, which includes its
standalone operating system (MPC Firmware); its hardware Serial Number; and its current firmware for the Control
Surface.

To view legal information relevant to MPC, tap Legal Info. For complete legal information, visit
akaipro.com/product-legal.

To enter Update Mode, press and hold Shift and tap Update. In the screen that appears, tap Save to save your
current project before entering Update Mode; tap Cancel to return to the Preferences; or tap Don’t Save to enter
Update Mode without saving your current project.

Wi-Fi

The settings on this screen will determine how your MPC hardware's wireless connection works, so you can use
Ableton Link, a new technology that synchronizes beat, phase and tempo of Ableton Live and Ableton Link-enabled
applications over a wireless or wired network. These settings are available only for MPC X, MPC Live and MPC One
when used in Standalone Mode.

To activate or deactivate wireless connectivity on your MPC hardware, tap the On/Off selector. The
available wireless networks will appear in the panel below it.

To select a wireless network, tap it.

To connect to a selected wireless network, tap Connect. If the Wi-Fi network is password-protected, use the
virtual keyboard that appears to enter the correct password to connect to it.

To view the information of a selected wireless network, press and hold Shift and tap Info. The Network
Information window that appears will show the network name, IPv4/IPv6 address (including the subnet mask
and gateway), type of security, and signal strength (as a percentage).

To disconnect from a connected wireless network, tap Disconnect.

To clear the connection information (e.g., the password) from a selected wireless network, tap Forget.
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Ethernet

The settings on this screen will determine how your MPC hardware connects to a wired network using a USB-to-
Ethernet adapter. This allows you to maintain a tighter network connection when using Ableton Link or the Akai
Network Driver. These settings are available only for MPC X, MPC Live and MPC One when used in Standalone
Mode.

To activate or deactivate Ethernet connectivity on your MPC hardware, tap the Enabled box.

To determine how your MPC hardware connects to the network, use the Address Method dropdown. Select
Automatic to have your MPC hardware set the Ethernet connection, or Manual to set it yourself.

When setting the Ethernet connection manually, tap the IP Address, Subnet Mask, Gateway, and DNS fields to
input the values.

Bluetooth

The settings on this screen will determine how your MPC hardware’s Bluetooth connection works, so you can use
Bluetooth MIDI controllers (e.g., LPD8 Wireless or LPK25 Wireless) or a Bluetooth computer keyboard with it. These
settings are available only for MPC X, MPC Live and MPC One when used in Standalone Mode.

To activate or deactivate Bluetooth connectivity on your MPC hardware, tap the On/Off selector. The
available Bluetooth devices will appear in the panel below it under Available Devices. The Bluetooth devices
that have already paired to your MPC hardware will appear under Paired Devices.

To select a Bluetooth device, tap it.

To pair a selected Bluetooth device (in the Available Devices section), tap Pair.

To connect to a selected Bluetooth device (in the Paired Devices section), tap Connect.

To disconnect from a connected Bluetooth device (in the Paired Devices section), tap Disconnect.

To return an available Bluetooth device to its original state, tap Remove.

Sequencer
The settings on this screen determine how sequencing works in the Grid View and in the Step Sequencer.

Display Resolution: This is the display resolution (in PPQN—pulses per quarter note) of pulse values in certain
areas of the operating system. Please note that this setting affects the display resolution, not the timing.

Instant Track Mute: When disabled, if you mute a track, its Note On messages will be ignored, and samples and
notes that are playing will finish playing their entire length (this is how legacy MPCs’ track-muting worked). This is
useful if you are using loops and want a loop to play to the end of a bar but not play the next time the sequence
loops. When enabled, if you mute a track, the MIDI track volume (0) will be sent. The loop will continue to play
but at zero volume, allowing the loop to continue playing when the track is unmuted. This is useful when you
want to have the track muted immediately.

Play Track Mute and Solo Events: When enabled, track mute and solo events are played back when you are in
Track Mute Mode. When disabled, track mute and solo events will not be played back while in Track Mute Mode.

Record Track Mute and Solo Events: When enabled, track mute and solo events are recorded when you are in
Track Mute Mode (timing correct settings will affect the recorded position events). When disabled, track mute
and solo events will not be recorded while in Track Mute Mode. This feature is useful if you want to use Track
Mute Mode to record track mutes or solos into your sequences as opposed to using Track Mute Mode for
performance or listening purposes only.

Record Pad Aftertouch Events: When enabled, pad aftertouch data (from the MPC hardware’s pressure-
sensitive pads) will be recorded. When disabled, pad aftertouch data will be ignored.

Place Events Recorded During Count-In at Start Point: When enabled, pressing a pad during the recording’s
pre-count will record that note event at the start of the recording (this is how the MPC3000 worked). When
disabled, no notes will be recorded until the pre-count is finished and recording has begun.

Note: This setting is ignored when recording with the Arpeggiator active.
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Truncate Duration: This determines if/how events are cropped if they exceed the length of the current Sequence:

To Sequence Length: If the length of an event exceeds the length of the sequence, it will be truncated. This
ensures that the event will not overlap itself when the sequence loops.

To Sequence End: If an event exceeds the length of the sequence, it will be truncated to the end of the
current sequence. In other words, the event will stop playing when the sequence ends or loops.

As Played: Events will play back exactly as they were recorded, even if they overlap themselves when the
sequence loops. T N L

For example, if you record a note starting on the second bar of a 4-bar loop

and hold it for 5 bars, the note would end: at bar 7 (As Played), at bar 6 (To L s played

Sequence Length), or bar 4 (To Sequence End). See image for details. MMM To Sequence Length
I To Sequence End

Q-Link Swing Control Applies TC Settings on Release: When enabled, turning the Q-Link knob assigned to
Swing and then releasing it will immediately apply that Swing setting. When disabled, you must use the Timing
Correct window to apply the Swing setting.

Sync
The settings on this screen determine how your MPC hardware synchronizes with connected USB and MIDI devices.

Receive: This determines whether your MPC hardware receives MIDI Clock information (MIDI Clock), MIDI Time
Code information (MIDI Time Code (MTC)), communication from Ableton Link (Ableton Link), or none of these (Off).

Receive MMC: When enabled, your MPC hardware will be able to receive MIDI Machine Control (MMC)
information. When disabled, your MPC hardware will not receive this information. See Appendix > MIDI Machine
Control (MMC) to learn about this.

Send: This determines whether your MPC hardware sends MIDI Clock information (MIDI Clock), MIDI Time
Code information (MIDI Time Code (MTC)), or neither (Off).

Send MMC: When enabled, your MPC hardware will be able to send MIDI Machine Control (MMC) information.
When disabled, your MPC hardware will not send this information. See Appendix > MIDI Machine Control (MMC)
to learn about this.

MTC Frame Rate: This determines the frame rate used by MIDI Time Code (MTC), which is important for correct
timing, especially when working on film scoring projects. In most cases, you should select 25.

Start Time: This is the starting time that will be sent when Send MIDI is set to anything other than Off. The time
is formatted in hours:minutes:seconds:frames.

Send Port 1-4: These are the MIDI ports over which MIDI Clock or MTC information will be sent.

Hardware
The settings on this screen determine the behavior of your MPC hardware’s pads and touchscreen.
Pad Threshold: This determines how much force is required to strike the pads for them to trigger.

Pad Sensitivity: This determines how the pads respond to touch. At lower values, you need to use more force to
generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use
much force while pressing a pad.

Pad Curve: This determines how striking the pads translates into velocity values. The A | MIDI o
curve is essentially linear, while the B, C, and D curves are exponential (see graphic here). | Velocity
Velocity & Aftertouch: View these meters when striking and pressing the pads to help
gauge the force and pressure you are applying to them. These meters are useful when
adjusting the Pad Threshold and Pad Sensitivity parameters (above). A B Q 5]
Footswitch 1 & Footswitch 2: These determine how connected footswitches will work. d
These options are available for MPC X only, not for MPC Live, MPC One or MPC | ,--" .-" . Applied
Touch, which do not have footswitch inputs. Force

MIDI Control Mode Output: This determines which MIDI port the MPC hardware is
using to send MIDI messages to external MIDI devices.
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Screen Dimming: This determines how much time must pass before your MPC hardware automatically dims its
touchscreen (if it uses a battery, this can help preserve battery life).

Screen Brightness: This determines the brightness of the screen during normal operation: normal brightness
(Day) or dimmed (Night).

Power On Screen (MPC Live only): This determines if/when a special screen will appear when you power on
your MPC Live. On this screen, you must tap and hold a button for a moment to begin using MPC Live or it will
automatically power off. This feature prevents it from powering on accidentally and wasting battery life. You can
set it to the following options:

Never: The screen will never appear.
When On Battery: The screen will appear only if you power on MPC Live while using battery power.
Always: The screen will always appear.

VU Meter Source (MPC X only): This determines what audio signal level is shown in the level meters (on the right side
of the screen). When set to Master, the level meters show the audio signal sent out of Outputs 1/2 (the Main L/R
outputs on the rear panel). When set to Current Program, the level meters show the audio signal of the currently
selected program (i.e., the program used by the currently selected track and any other tracks that also use it).

Date (MPC X, MPC Live & MPC One only): This is the current date, formatted as Month / Day / Year. When
saving files on MPC X or MPC Live in Standalone Mode, the file will include the current date in its metadata. If
you use MPC X or MPC Live in Controller Mode, this setting will be overwritten with the current date of the host
computer.

Time (MPC X, MPC Live & MPC One only): This is the current time, formatted as Hour : Minute. When saving
files on MPC X or MPC Live in Standalone Mode, the file will include the current time in its metadata. If you use
MPC X or MPC Live in Controller Mode, this setting will be overwritten with the current time of the host
computer.

Time Zone (MPC X, MPC Live & MPC One only): This is the current time zone, formatted as Continent / City,
which you can change here.

Project Defaults
The settings on this screen determine various default values for any new project that you create.

New Project Dialog: This determines what options you see when you start a new project. When set to Off, a
new project will be empty with no preconfigured settings except for the project defaults shown here. When set to
Demo, you can choose to load a demo project (from several different genres) as a starting point or an empty
project. When set to Demo/Template/Recent, you can choose to load a demo project, a project template file, or
an empty project. You must have a project in the Template File field of the Project Load/Save tab to select a
template in this window.

Default Tempo: This is the default tempo in BPM.

Default Master Tempo: When enabled, the default tempo value will be used for the master tempo. When
disabled, the default tempo will be used for sequences.

Default Sequence Bars: This determines the default number of bars of a new sequence.

Default Time Signature Numerator: This determines the number of beats per bar of a new sequence (the top
number of a time signature).

Default Time Signature Denominator: This determines the value of each beat of a new sequence (the bottom
number of a time signature).

Default Pad Slice: This determines how new samples will play when you load them or record them into a
project. When set to Pad, the Slice menu in Program Edit Mode will be set to Pad, which lets you set the start
point, end point, etc. for the layer. When set to All, the Slice menu in Program Edit Mode will be set to All, in
which the entire sample plays.

Default Drum/Keygroup Filter: This determines the default type of filter that drum and keygroup programs will
use. See Appendix > Glossary > Filter to learn about this.

Default Plugin Synth: This determines the default instrument plugin that a new plugin program will use. Use the
window that appears to select it.
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Project Load/Save

The settings on this screen determine if (and how) projects are automatically saved. If you are using MPC hardware
as a controller, you can also define files to load automatically.

Auto Load File: Use this field to select a project (.xpj) or program (.xpm) to load automatically anytime you open
the MPC software. (For MPC X, MPC Live and MPC One, this option is available only when using your MPC
hardware in Controller Mode.)

Enabled: When enabled, your project will automatically save after each Timeout interval. When disabled, your
project will not be automatically saved; you may save only manually.

Timeout: Use this field to select how often your project will automatically save.

Template File: Use this field to select a project template that will load automatically when you select User
Template in the New Project Dialog window. (If you select the Save as Template box when saving a file, it will
be shown in this field.) In order for the User Template option to be available, New Project Dialog (in the Project
Defaults tab) must be set to Demo or Demo/Template/Recent.

Record/Export
The settings on this screen determine the settings for recording and exporting.
Recording Bit Depth: This determines the bit depth of recorded audio.

Include Program Volume/Pan Settings: When enabled, the exported audio or MIDI file will include its volume
and pan settings. When disabled, the volume and pan settings will be set to 0 dB and center (C), respectively.

Bypass Program Effects Plugins: When enabled, the exported audio or MIDI file will include any third-party
effect plugins that are used with it, but those effects will be bypassed (deactivated). When disabled, those effects
will be activated.

Audio Tail Length: This determines the length of an audio tail (silence) that will be applied to the exported audio
file. When set to 0, the audio file will not have any additional audio tail.

Audio Export: This determines what part of the sequence is exported when you click the Export Audio icon.
Track: When this is selected, Export Audio will export the currently shown track in the current sequence.

Program: When this is selected, Export Audio will export all tracks in that sequence that use the currently
shown program.

Master: When this is selected, Export Audio will export all tracks in that sequence that use programs routed
to master outputs.

MIDI Export: This determines what part of the sequence is exported when you click the Export MIDI icon.
Track: When this is selected, Export MIDI will export the currently shown track in the current sequence.
Sequence: When this is selected, Export MIDI will export all tracks in the current sequence.

Bounce Bit Depth: This determines bit depth of the audio file that is exported when you click the Export Audio
icon: 16-bit or 24-bit.

General
The settings on this screen determine how other features work in the hardware and operating system.

Tap Tempo: This determines how many times you have to press the Tap button before the new tempo is
recognized.

Flash Tap Tempo Light: When enabled, the Tap button’s light will flash in time with the tempo. When disabled,
the Tap button’s light will be off.

Filter ‘All Notes Off’ CC: When enabled, “All Notes Off” (“MIDI panic”) messages will be ignored. This is useful if
you are using an external MIDI device that can send these types of messages but you want to filter them out.
When disabled, “All Notes Off” messages will be received normally.

Program Change: This determines what an incoming MID | program change message will change: a Program,
Sequence, or Track.
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Vintage Mode: This determines the type of emulation applied to the audio output. You can apply the particular
sonic qualities of, for example, the MPC3000 or MPC60, or of course no emulation (None).

Audition Auto Play: This determines how long a sample will sound when auto-previewing it.

Audition Outputs: This determines which pair of outputs will play any auditioned sounds (Out 1,2-7,8 in
Standalone Mode, Out 1,2-31,32 in Controller Mode; MPC Live does not use Out 7,8 and MPC One does not use
Out 3,4-7,8 in Standalone Mode, but displays them to maintain compatibility with MPC X, which does use them).
These sounds include: samples, programs, and projects in the Browser; sample playback, Cue Preview, and Slice
Preview in Sample Edit Mode; and sample playback in the Keep or Discard Sample window in the Sampler.

Cue Preview: This determines if/how audio is played as you move the cue playhead. As you move the cue
playhead through a sample waveform, you can set it to play the small part of the sample before the cue playhead
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set
this in Sample Edit Mode (see Modes > Sample Edit Mode > Settings).

Slice Preview: This determines if/how audio is played as you move a slice marker. As you move the slice marker
through a sample waveform, you can set it to play the small part of the sample before the slice marker (Before),
play the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in
Sample Edit Mode (see Modes > Sample Edit Mode > Settings).

Threads: This determines how many cores of your computer’s processor will be used to render audio. The
available range depends on your processor. (For MPC X, MPC Live and MPC One, this option is available only
when using your MPC hardware in Controller Mode.)

Audio Warp Algorithm: This determines how a sample is “warped” when you adjust the length of a sample
without changing its pitch (e.g., the Warp function in Audio Edit Mode for audio tracks or in Program Edit Mode
for clip programs). (For MPC X, MPC Live and MPC One, this option is available only when using your MPC
hardware in Controller Mode.)

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required
by using a Warp algorithm other than Elastique Pro, which is very CPU-intensive.

Audio Track Auto Warp: This determines how recorded audio track regions are warped. When set to On, any
audio track region that you record will be warped automatically to match the current sequence tempo. You can
then adjust the sequence tempo while the audio track region remains in time.

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is
stored within the sample file when you save the project. When you warp an audio track region, the warping
algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.”

BPM Detection Range: This defines the range of detectable BPM values when you use any automatic BPM
detection function in the software or when you press the Tap button to enter a new tempo.

Bank Button Press: This determines how the Pad Bank buttons work.

Select A-D: Pressing a Pad Bank button once will select the corresponding bank from Pad Banks A-D.
Pressing and holding Shift while pressing a Pad Bank button will select the corresponding bank from Pad
Banks E-H.

Select/toggle bank: Pressing a Pad Bank button will alternate between the corresponding bank from Pad
Bank A-D and Pad Bank E-H. In other words, you do not need to hold Shift to select one of Pad Banks E-H.

Desktop Screensaver Disable: This determines if/when your computer’s screensaver is disabled while using
the MPC software (i.e., using your MPC hardware in Controller Mode):

Never: Your computer’s screensaver will function normally.

When hardware used: As long as your MPC hardware is connected to your computer and being used, your
computer’s screensaver will be disabled.

When hardware attached: As long as your MPC hardware is connected to your computer and powered on,
your computer’s screensaver will be disabled. It will function normally again if you power off or disconnect
your MPC hardware from your computer.

Always: Your computer’s screensaver will be disabled as long as the MPC software is open (whether or not
your MPC hardware is connected or powered on).

(For MPC X, MPC Live and MPC One, this option is available only when using your MPC hardware in Controller
Mode.)

Collect Usage Statistics: This determines whether or not your usage statistics will be sent occasionally to us,
enabling us to improve the MPC experience. (For MPC X, MPC Live and MPC One, this option is available only
when using your MPC hardware in Controller Mode.)
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Splice

The settings on this screen control integration with the Splice platform. See Addenda > Updates in MPC 2.5 for
more information.

Sync

Tap the Sync field (in the center of the top of the screen) and then turn the data dial or use the —/+ [l
buttons to set whether your MPC hardware receives MIDI Clock information (MIDI Clock), MIDI gl
Time Code information (MTC), communication from Ableton Link, or none of these (Off).
Alternatively, double-tap Sync and tap the desired option to select it.

SYNC

This is the same setting as the Receive menu in Sync tab of your Preferences. See Preferences [JYlBINEeeS
> Sync for more information.

Important: Your MPC hardware must be connected to a wireless network in order to receive these [
types of timing information. See Preferences > Wi-Fi to learn how to connect to a wireless network.

Note: Ableton Link is a new technology that synchronizes beat, phase and tempo of Ableton Live ¥l i
and Ableton Link-enabled applications over a wireless or wired network. Ableton Link

Mode

Tap this icon to switch MPC X, MPC Live or MPC One between Standalone Mode and
Controller Mode (MPC Touch already operates as a controller only). In the screen that
appears, select whether you want to save your current project before switching (Save),
switch without saving your project (Don’t Save), or stay in the current mode and project
(Cancel). You cannot freely switch between Standalone and Controller Modes without
also closing your current project.

See Standalone vs. Controller Mode to learn more.
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System Resources

Tap one of these icons to show the System Resources window for MPC X, MPC Live or MPC One.

&2 SYSTEM RESOURCES

iy PURGE

The indicators in this window show current usage statistics:

Battery: If you are using MPC Live powered by its internal battery, the first indicator shows the current battery
life as a percentage. (See Battery Usage to learn more about MPC Live’s internal battery.)

CPU: The CPU indicator shows the current CPU as a percentage.
RAM Usage: The Mem indicator shows your MPC hardware’s current RAM usage.

Important: If you encounter a warning that there is not enough memory to complete an action while using your
MPC hardware, do the following to make more memory available:

Make sure all audio tracks in your project are not record-armed.

Delete samples from your project’s sample pool that were there before the warning appeared.

If you are still seeing the warning, do the following:

1. Manually undo the last action you performed before seeing the warning (you may not be able to use the
Undo button for this due to how the undo history is stored in RAM).

2. Save your project.

3. Do one of the following, and then load your saved project again.
¢ [n Main Mode, tap the folder icon at the top of the screen, and then tap New at the bottom of the screen.
e Power your MPC hardware off and then on again.

* Press Menu and then tap the gear icon to open the Preferences. In the Preferences, tap Reset at the
bottom of the screen, tap OK, and then tap Restart to reset the Preferences.

¢ Enter Controller Mode and then reenter Standalone Mode.
Important: Although you can load multiple files at once, any samples you load into a project will be automatically

converted to full-quality uncompressed audio files, so they may use more storage space than they do on your
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

Drives: The Drives indicator shows the available storage space on any detected external storage devices or the
internal drive of MPC X, MPC Live or MPC One.

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.), tap
Purge. In the screen that appears, tap Unused Samples to delete all unused samples from the project, tap All
Samples to delete all samples from the project (from all programs, sequences, and audio or MIDI tracks), or tap
Cancel to return to the previous screen.

To close the System Resources window, tap OK, the X in the upper-right corner, or anywhere outside the window.
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Time Counter/Locate

In most of the available modes, there is a time counter at the top of the screen. This indicates
the current playhead position.

To adjust the position, tap it, and then use the use the data dial or the —/+ buttons.

To open the Locate screen and adjust its settings, double-tap the time counter.

To close the Locate screen, tap the X in the upper-right corner or anywhere outside the
window.

® LOCATE

AUTO RECORD

PUNCH IN PUNCH OUT

7

To move forward or backward a step, tap the Step < or Step > button, respectively.

To move forward or backward a bar, tap the Bar << or Bar >> button, respectively.

To configure your auto record settings, use the Auto Record selector and adjacent fields:
Auto Record selector: Tap the desired option to select it:
Off: Auto recording is disabled.

Punch In: You can auto record using punch-in and punch-out markers, enabling you to record over a
specified length of time in the track. While recording, the entire sequence will play, but you will record over
only the area between the Punch In and Punch Out markers. Any part of the sequence before the Punch In
marker or after the Punch Out marker will remain untouched, even if you perform over it during recording.

Record Start: After you record-arm the track and start playback, you will start recording once the sequence
loops back to its start. This is essentially a punch-in feature for the entire track, enabling you to start playing a
record-armed track while allowing more time than the usual count-in to prepare for the actual recording to start.

Punch In: Use these fields to set the location of the Punch In marker, which is where recording will start (when
the Auto Record selector is set to Punch In).

Punch Out: Use these fields to set the location of the Punch Out marker, which is where recording will stop
(when the Auto Record selector is set to Punch In).
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© LOCATE

AUTO RECORD

PUNCH IN PUNCH OUT

You can use this screen to set time markers, allowing you to jump automatically to precise locations in a sequence.
You can set up to six time markers.

To set a time marker, tap the time counter at the top of the screen, find the desired time, and then tap Set next to
the desired time marker. The time will appear next to that marker.

To jump to a time marker, tap the number next to it (1-6).
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Timing Correct (TC)

The Timing Correct window contains various settings to help quantize the events in your sequence. You can
quantize note events on MIDI tracks or track regions on audio tracks (though you cannot apply all types of
quantization to audio tracks).

To open the Timing Correct settings:
In Main Mode or List Edit Mode: Tap the TC/clock icon at the top of the screen.
In the Grid View: Press and hold Shift and tap TC at the bottom of the screen.
In the Track View or the Step Sequencer: Tap TC at the bottom of the screen.

Note: The TC button in Pad Mute Mode and Track Mute Mode contain Timing Correct settings, but they do
not open this window. See Modes > Pad Mute Mode and Track Mute Mode to learn about those settings.

Press the TC / On/Off button (MPC One only).
To apply the settings you selected to the current track, tap Do It.
To apply the settings you selected to all tracks, tap All Tracks.

To cancel and return to the previous screen, tap Close.

@ TIMING CORRECT @ TIMING CORRECT

TYPE TYPE

TIME DIVISION TIME DIVISION

0] 100 100 50 100

EVENTS EVENTS
ALL

ALLTRACKS ALL TRACKS

Use the Type selector to set how timing corrections are applied.

Start: The entire note event or audio track region will be nudged forward or backward so the start point aligns
with the closest time division marker in the grid. You can apply this to MIDI tracks or audio tracks.

End: The end points of note events will be extended or shortened to align with the closest time division marker in
the grid. The start points will remain untouched. You can apply this to MIDI tracks only.

Length: The end points of note events will be extended or shortened so that each event’s length is a multiple of
the time division, regardless of where it is in the grid. The start points will remain untouched. You can apply this
to MIDI tracks only.

Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from the
first note event’s start point to the last note event’s end point. Each note event will sustain until another note event
starts. If multiple note events start at the same time (and are not the last note events), their lengths will become
identical. Selecting Legato disables all other options in this window. You can apply this to MIDI tracks only.

Without legato applied. With legato applied.
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Use the Time Division selector to set the quantization value. Events will “snap” to these time divisions on the grid.

The T indicates a triplet-based value.

Alternatively, press and hold Note Repeat while in Main Mode, and then use the six buttons at the bottom of the screen.

Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle

to extreme.

Use the Shift Timing field to shift all events by clock ticks.

Use the Window field to set how many events around a quantize value will be quantized. Any events outside this

range will not be quantized; events inside will.

Use the Strength field to set how strictly events will be quantized (i.e., shifted toward the quantize value). Lower
values move events a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict

quantization (a higher value).

Use the Events selector to set the target range for the
time correction. You can apply the time correction to All
note events or to just the Selected ones.

To select note events to which to apply time correction,
either use the various tools in Grid View or press the
pad with the desired events (while Hitting Pad Selects
All Events is set to On). You must do this before
opening the Timing Correct window.

When Range is selected, you can define the locations
(From and To) as well as the pads or keys that will be
quantized.

© TIMING CORRECT

TYPE

START

TIME DIVISION

50

EVENTS

ALLTRACKS
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Metronome (Click/Metro)

The Click/Metro window contains all settings regarding the metronome (click track).

To open the metronome settings:
In Main Mode or List Edit Mode: Tap the Metro/metronome icon at the top of the screen.
In the Grid View: Press and hold Shift and tap Click at the bottom of the screen.
In the Track View: Tap Click at the bottom of the screen.

Tap the Metro/metronome icon at the top of the screen.

& cLCK/METRO

Record
Record

1/4

MPC Click

Use the Count-In field to set if/when the metronome counts before recording.
Off disables the metronome pre-count.
Record enables the pre-count during recording only.
Record + Play enables pre-count in both Record and Playback Modes.

Use the Enable field to set if/when the metronome is enabled.
Off disables the metronome.
Play enables the metronome sound during playback only.
Record enables the metronome sound during recording only.
Record + Play enables the metronome to happen in both Record and Playback Modes.

Use the Rate field to select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T.
T indicates a triplet-based time division.

Use the Sound field to select the sound that you want to hear for the metronome: Sidestick 1, Sidestick 2, Clap,
Metroclick, Shake, Tambourine, or MPC Click.

Use the Volume knob to set the volume of your metronome click.

Tap the On/Off button to enable or disable the metronome.

Use the Output field to set which pair of outputs will play the metronome click: Out 1,2-7,8 in Standalone Mode, Out
1,2-31,32 in Controller Mode (MPC Live does not use Out 7,8 and MPC One does not use Out 3,4-7,8 in Standalone
Mode, but displays them to maintain compatibility with MPC X, which does use them).
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Automation

You can set the automation for programs and audio tracks to be “written,
this globally or for individual programs and audio tracks.

read,” or disabled entirely. You can do

Global

In several modes, there is a button in the upper-right corner that controls the global automation. When you tap this
button to change its state, it will change the automation state for all programs in the project.

This is available in Main Mode, XYFX Mode, Pad Mute Mode, the Pad Mixer, the Channel Mixer, and Q-Link Edit Mode.

Tap the global automation button to cycle through its three states:

When off, automation data will be ignored. If you have already recorded or entered automation,
tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off
by pressing and holding Shift while tapping the button.

Important: If you have already recorded automation and turn it off, the track will still use the effect
and its parameter values at the point where you turned it off.

When set to Read (R), automation data will be read but not recorded. (Think of this as a protective
feature to prevent accidental changes to your automation while recording.)

When set to Write (W), automation can be recorded and will overwrite any existing automation. (Make
sure not to touch the XY pad accidentally while you are recording.)

Programs & Audio Tracks

You can also set the automation for each program or audio track by using the program automation button in the
channel strip on the left side of the screen in Main Mode and the Channel Mixer. Program automation is available for
all program types except MIDI programs.

Note: Remember that tapping the global automation button will change the automation state for all programs in the
project; if they were originally different, all of them will then match the global automation state.

In Main Mode, if the channel strip is not already shown, tap the small eye icon below the Project field to show it.

In the Channel Mixer, if you do not see a program automation button in the channel strip, make sure the Mixer field
is set to Audio Tracks or Programs.

Tap the program automation button or press Read/Write (MPC X) to cycle through its three states:

When off, the program will ignore automation data. If you have already recorded or entered _
automation, tapping this will switch between Read (R) and Write (W) only, but you can override
this and turn it off by pressing and holding Shift while pressing or tapping the button.

Important: If you have already recorded automation and turn it off, the track will still use the effect
and its parameter values at the point where you turned it off.

When set to Read (R), the program will read automation data but will not record any additional _
automation over it. (Think of this as a protective feature to prevent accidental changes to your
automation while recording.)

When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned _
to automatable parameters, make sure not to touch any accidentally while you are recording.)



16 Level

Press the 16 Level button on your MPC hardware to activate or deactivate 16 Level.

When first activated, the selected pad (Pad AO1 by default) will be temporarily copied to all 16 pads. The pads will now
output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the
pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them.

i3 16LevELS 58 16LevELS

€4 AL 19805nare ™ AOL 1980Snare

VELOCITY 3 LTEF L Ef ELS TUNE

In the 16 Levels screen that appears, use the Type selector to choose the parameter: Velocity, Tune, Filter, Layer,
Attack, or Decay.

To select a pad, do any of the following (while the 16 Levels window is open):
e Press and hold 16 Level, and then press the desired pad.

e Tap the 16 Levels checkbox to uncheck it (temporarily disabling the feature), press the desired pad, and
then tap the 16 Levels checkbox again to check it.

e Tap the Pad field, and use the data dial or =/+ buttons.
o Double-tap the Pad field, and tap the desired pad in the list that appears.

If Type is set to Tune, use the Original Pad field to select which you pad you want to use the original pitch of the
sample/samples. Alternatively, hold Shift and press the desired pad.

When Type is set to Layer, pads with multiple samples will play back each layer according to the Velocity Start and
Velocity End settings for each layer.
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Erase

The Erase function erases all or part of a track in a specific sequence.

To open the Erase window, press the Erase button. Alternatively, while in Main Mode, tap the pencil icon on the
right edge of the section, and then tap Erase in the screen that appears.

@\ ERASE @\ ERASE

1: Sequence 01 1: Sequence 01 1: Drums

CANCEL CANCEL

To select the sequence you want to erase, use the Sequence field.
To select the track you want to erase within the sequence, use the Track field.

To set the time range of the sequence you want to erase, use the Bar, Beat, and Tick fields. The left fields set
the start of the time range, and the right fields set the end of the time range.

To select what types of events you erase, select one of the Erase options:
All erases all pad events from the designated time range and reset all of its settings.

Automation erases only automation from the designated time range. Use the Parameter field to select what
type of automation is erased.

Note erases only specific pad events from the designated time range. In the diagram of the eight pad banks that
appears, press each pad in each bank to select or deselect its notes.

Except Note erases everything except pad events from the designated time range.

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel, or anywhere outside the window.
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Effects

You can apply various effects to the pads, keygroups, audio tracks, programs, submixes, and master outputs, using
insert and send/return effects. This chapter can help you get a good overall understanding of how the effects work.

See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their
editable parameters.

Overview

In a program, each pad or keygroup can have up to four insert effects applied to it. See Insert Effects > Pads or
Keygroups to learn more about this.

An entire program or audio track can also have up to four insert effects applied to it, as well. See Insert Effects >
Programs or Audio Tracks to learn more about this.

For even further flexibility, each submix can have up to four insert effects applied to it. You can route pads,
keygroups, audio tracks, or programs to a submix, which is then routed to a master output. See Insert Effects >
Submixes to learn more about this.

Additionally, each pad, keygroup, audio track, program, and submix can each be sent to (up to) four return
channels, each of which can have up to four insert effects of their own. Their audio will be routed through the insert
effects on those returns, and the processed audio will be sent to a master output. See Send/Return Effects to learn
more about this.

Finally, you can apply up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2,
Outputs 3/4, etc.). See Insert Effects > Masters to learn more about this.

When you create an audio mixdown of a sequence or song, you can choose whether or not master insert effects are
included or send/return effects are included, depending on what you are mixing down:

If you are creating an audio mixdown of a pair of master outputs, you can choose whether or not master insert
effects will be included in the mixdown.

If you are creating an audio mixdown of separate programs or exploded tracks, you can choose whether or
not send/return effects will be included in the mixdown.

See Audio Mixdown to learn about these options.

There are three other modes that handle effects differently:

e The Sampler can use up to four insert effects, which are applied to the audio as you record it. This means
that the effects cannot be “removed” from the sound later. Learn more about the Sampler in the Modes >
Sampler chapter.

e Similarly, the Looper can use up to four insert effects, which are applied to the audio as you record it. This
means that the effects cannot be “removed” from the sound later. Learn more about the Looper in the
Modes > Looper chapter.

e In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name of the
insert effect you have to load to the program before you can use this mode. Learn more about XYFX Mode in
the Modes > XYFX Mode chapter.
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To view, load, edit, or clear effects, tap the area under
the Inserts field. This usually appears in a channel strip
(next to a level slider and pan knob). Distortion Amp

LP Filter

When viewing loaded effects, you will see this window: < o
Drums

To select an effect, use the field for each insert slot. A
window (described below) will appear.

To edit the parameters of a loaded effect, tap the
pencil icon next to the insert slot.

To clear the insert slot, tap the trash can icon next to it.

To enable or disable an effect slot, tap the On/Off
button next to it.

To disable all four effect slots, tap the All On/All Off
button in the upper-right corner. Tap it again to
reactivate the previously active effects.

When selecting an effect, you will see this window: e

To move through the list, swipe up or down. Alternatively, s o WPE 2z

use the data dial or —/+ buttons. HP Filter MPC 2in20ut
To sort or unsort the effects by type or manufacturer, FP Shelving Fler MPE zinzan
tap Type or Manufacturer in the lower-left corner. LPHireesy MPC  2in20
To load an effect, double-tap it. Alternatively, tap eriersne Ve e
Select, press the data dial, or press the center cursor LP Filter MPC2in2lo
or Enter (M PC X) LP Shelving Filter MPC  2in2out

To cancel, tap Close or anywhere outside the list.

MPC60 MPC  2in2 oL

PFN 2-Rand 2-Shalf MPr

MANUFACTURER SELECT

When you edit an effect, you will see this window: Pa——— ) =

To adjust a parameter, tap and drag its slider.
Alternatively, use the data dial or —/+ buttons. To
make finer adjustments, double-tap the pad and
adjust the larger version of the slider that appears.

DRY / WET THRESHOLD

Tip: Turn the Q-Link knobs to quickly adjust the
corresponding four parameters.

To select an effect preset, use the dropdown menu at
the top of the screen.

To load a saved preset, tap the folder icon at the top
of the screen.

RELEASE ouTPUT

COMPRESSOR OPTO

To save a preset, tap the disk icon at the top of the
screen.

To select another page of parameters, tap the
Parameters —/+ buttons at the top of the screen.

To enable or disable the effect, tap the On/Off
button in the upper-right corner.

To edit parameters for another insert effect on the
same pad, program, etc., tap a different Insert tab at
the bottom of the screen to select it.

To close the window, tap Close or the upper part of
the screen.
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Insert Effects

Pads

You can load up to four insert effects to each pad. You can do this in Main Mode, the Pad Mixer, or Program Edit Mode.

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply
unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this
with a program insert effect (see Insert Effects > Programs).

MPC Project 001

80.78
1 Sequence 01

_ 1 Drums

) Program 001

@ AuDIO - TRACK

To load a pad insert effect in Main Mode:

1.

A R A

When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the
program with the desired pad —the program it uses will be selected automatically.

If the channel strip is not already shown, tap the small eye icon below the Project field to show it.
Tap the single-pad icon at the top of the channel strip. The channel strip will now show settings for the current pad.
Press the desired pad to select it. Alternatively, use the Pad field at the top of the channel strip.

Tap the area under Inserts, and then use the screen that appears to load or edit effects.
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Distortion Amp Distortion Amp

MUTE INSERT ROUTE

To load a pad insert effect in the Pad Mixer:

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at
the top of the screen to select the desired track—the program it uses will be selected automatically.

2. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the
Program field.

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or -/+ buttons to select an effect immediately.

INSERTS
91 Distortion Amp [2in 2 out]

2 | Compressor Vintage [2 in 2 out]

3 NOEFFECT

4  NOEFFECT

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To load a pad insert effect in Program Edit Mode:
1. While using the desired program, press the desired pad to select it.

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects.
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Keygroups

You can load up to four insert effects to each keygroup. You can do this in Main Mode, the Pad Mixer, or Program
Edit Mode.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

¥ MPC Praject 001

80.78
1 Sequence 01

= Synth 01

M@ Aubio - TRACK

To load a keygroup insert effect in Main Mode:

1. When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the
program with the desired pad —the program it uses will be selected automatically.

2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it.

Tap the single-pad icon at the top of the channel strip. The channel strip will now show settings for the current
keygroup.

4. Press a pad to select its corresponding keygroup, or tap it on the screen. Alternatively, use the Keygroup field at
the top of the channel strip.

Important: Remember that the effect will be applied to that keygroup only.

5. Tap the area under Inserts, and then use the screen that appears to load or edit effects.

93



KG 1 Synth Dis (S)M)| kG 2 Synth Dis. (5] (M)

B &R

Reverb Medium

MUTE

To load a keygroup insert effect in the Pad Mixer:

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at
the top of the screen to select the desired track—the program it uses will be selected automatically.

2. Press a pad to select its corresponding keygroup, or tap it on the screen. Alternatively, use the Keygroup field
below the Program field.

Important: Remember that the effect will be applied to that keygroup only.

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, double-tap
the desired pad on the screen. You could also select one of the four Insert tabs at the bottom of the screen, and
then use the data dial or —/+ buttons to select an effect immediately.

Synth 01

INSERTS
rb Medium [2 in 2 out]

2 | Distortion Custom [2 in 2 out]

3  NOEFFECT

4 NOEFFECT

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To load a keygroup insert effect in Program Edit Mode:

1. While using the desired program, press the desired pad to select its keygroup. Alternatively, use the Keygroup
field at the top of the screen.

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects.
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Audio Tracks

You can load up to four insert effects to each audio track. You can do this in Main Mode and the Channel Mixer.

1Y MPCProject 001

{}

Input 1,2 80.78
Out 1,2 2 Sequence 02 ~

- Audio 001

M@ AuDiO

To load an audio track insert effect in Main Mode:

1.
2.
3.

When the Audio tab is selected (in the lower-left corner), use the Track field to select the audio track.
If the channel strip is not already shown, tap the small eye icon below the Project field to show it.

Tap the waveform icon at the top of the channel strip. The channel strip will now show settings for the current
audio track.

Tap the area under Inserts, and then use the screen that appears to load or edit effects.

(i) )@ = @@ ci )

Distortion Amp Distortion Custom Chorus 4-voice  Distortion Over...

MUTE SEND INSERT ROUTE

To load an audio track insert effect in the Channel Mixer:

1.
2.
3.

Use the Mixer field in the upper-left corner to select Audio Tracks.
In the touchscreen, tap the pad that corresponds to the desired audio track.

Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or —/+ buttons to select an effect immediately.
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Programs

You can load up to four insert effects to each program. You can do this in Main Mode, XYFX Mode, and the Channel
Mixer.

Note: In XYFX Mode, the effects act like a single insert effect on that program. In fact, XYFX is the name of the insert
effect that is loaded when use this mode.

¥ MPC Praject 001

80.78
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~ Synth 01

M@ AuDiO

To load a program insert effect in Main Mode:

1. When the MIDI tab is selected (in the lower-left corner), use the Track field to select the track that uses the
program with the desired pad —the program it uses will be selected automatically.

2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it.

3. Tap the four-pads icon at the top of the channel strip. The channel strip will now show settings for the current
program.

4. Tap the area under Inserts, and then use the screen that appears to load or edit effects.
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X

Program

SETUP

To load XYFX for a program in XYFX Mode:
1. Select the desired program in another mode, and then enter XYFX Mode.

2. If you have not yet used XYFX Mode for this program, tap Insert XYFX on the screen to load it and show the XY
pad.

Note: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before
doing this.

If you have already used XYFX Mode for this program, the XY pad will appear.
Tap XYFX Location in the upper-left corner, and select Program.
If the Setup panel is not shown, tap Setup in the lower-right corner to show it.

Use the Preset field to load an effect. Use the controls below the Preset field to edit the effect.
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To load a program insert effect in the Channel Mixer:
1. Use the Mixer field in the upper-left corner to select Programs.

2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Program
field below the Mixer field and tap the desired program.

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or —/+ buttons to select an effect immediately.

97



Submixes
You can load up to four insert effects to each submix. You can do this in the Channel Mixer only.

+0.75dB

SEND

To load a submix insert effect:

1.
2.

Use the Mixer field in the upper-left corner to select Submixes.

In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Submix
field below the Mixer field and tap the desired program.

Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or -/+ buttons to select an effect immediately.
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Masters

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4,
etc.). You can do this in Main Mode or the Channel Mixer.

1 MPC Project 001

{}

Outputs 1/2
1 Sequence 01

1 Drums

Program 001

M@ AuDio - TRACK +

To load a master insert effect in Main Mode:

If the channel strip is not already shown, tap the small eye icon below the Project field to show it.

Tap the crown icon at the top of the channel strip. The channel strip will now show settings for the current
master output.

Use the Outputs field at the top of the channel strip to select the desired master output (Outputs 1/2, Outputs
3/4, etc.).

Tap the area under Inserts, and then use the screen that appears to load or edit effects.
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To load a master insert effect in the Channel Mixer:

1.
2.

Use the Mixer field in the upper-left corner to select Masters.

In the touchscreen, tap the pad that corresponds to the desired master output (Outputs 1/2, Outputs 3/4, etc.).
Alternatively, double-tap the Outputs field below the Mixer field.

Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or —/+ buttons to select an effect immediately.

99



Send/Return Effects

Send/return effects work in the following way:

1.

A pad, keygroup, audio track, program, or submix sends its audio to a return at a designated send level.

2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and

activated.

3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono).

You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this
section describes the different ways to set the desired send levels for pads, keygroups, programs, or submixes.

1 Return 1

[ ]

Reverb Small

MUTE INSERT

To load a send/return effect to a return:

1.
2.

3.

In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns.

In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field
below the Mixer field.

Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert
tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired
pad on the screen. You could also use the data dial or -/+ buttons to select an effect immediately.

0.00dB

INSERT

To set the return level:

1.
2.
3.

In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns.

Tap the Level tab in the lower-left corner.

In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field
below the Mixer field.

To adjust the level of the currently selected return, use the data dial or —/+ buttons. Alternatively, use the
level slider in the channel strip, or turn the corresponding Q-Link knob. To make finer adjustments, double-
tap the pad on the screen and adjust the larger version of the slider that appears.
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Pads

You can set the send levels for pads in Program Edit Mode or the Pad Mixer.
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To set the send levels for a pad in Program Edit Mode:

1.  While editing the desired program in Program Edit Mode, press the desired pad to select it.

2. Tap the Effects tab in the lower-right corner.

3. Use the Send knobs to set the send level for each return.

R E
Drums 14 4 a7 =
a13NoSample (SJ(M)  a14No Sample (SJ(M)  a15No Sample (S]] A16 No Sample (5] (M)

N
-INF dB -INF dB -INF dB

A10 s)(m)

7
-INF dB

A0s 1980HatC (5) (M)

|
-INF dB -INF dB

ao3snrsmilt (5] (m)

[ (N
-INF dB -4.99dB

INSERT ROUTE

To set the send levels for a pad in the Pad Mixer:

1.

Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at
the top of the screen to select the desired track—the program it uses will be selected automatically.

Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).

3. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the

Program field.

4. To set the send level, use the data dial or —/+ buttons. To make finer adjustments, double-tap the pad on the

screen and adjust the larger version of the slider that appears.

101



Keygroups

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer.
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To set the send levels for a keygroup in Program Edit Mode:

1. While using the desired program, press the desired pad to select its keygroup. Alternatively, use the Keygroup
field at the top of the screen.

2. Tap the Effects tab in the lower-right corner.

3. Use the Send knobs to set the send level for each return.
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To set the send levels for a keygroup in the Pad Mixer:

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at
the top of the screen to select the desired track—the program it uses will be selected automatically.

Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).

3. Press the desired pad to select its corresponding keygroup, or tap it on the screen. Alternatively, double-tap the
Keygroup field below the Program field.

4. To set the send level, use the data dial or =/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the slider that appears.
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Audio Tracks

You can set the send levels for audio tracks in the Channel Mixer only.
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To set the send levels for an audio track:

In the Channel Mixer, use the Mixer field in the upper-left corner to select Audio Tracks.

2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).

3. In the touchscreen, tap the pad that corresponds to the desired audio track. Alternatively, double-tap the Audio
Track field below the Mixer field.

4. To set the send level, use the data dial or =/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the slider that appears.

Programs

You can set the send levels for programs in the Channel Mixer only.
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To set the send levels for a program:

1.
2.
3.

In the Channel Mixer, use the Mixer field in the upper-left corner to select Programs.
Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).

In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Program
field below the Mixer field.

To set the send level, use the data dial or -/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the slider that appears.
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Submixes

You can set the send levels for submixes in the Channel Mixer only.

To set the send levels for a submix:
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Submixes.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).

3. In the touchscreen, tap the pad that corresponds to the desired submix. Alternatively, double-tap the Submix
field below the Mixer field.

4. To set the send level, use the data dial or —/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the slider that appears.
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Audio Mixdown

The Audio Mixdown screen lets you render and export either the current sequence or song as an audio file. In Song
Mode, this will export the entire song. In Main Mode, this will export the current sequence only.

To open the Audio Mixdown screen in Song Mode, tap Export at the bottom edge of the screen.

To open the Audio Mixdown screen in Main Mode, tap the Project field in the upper-left corner of the screen, and
then tap Export.

& Audio Mixdown
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Audio Length
Use the Start Bar and End Bar fields to define where the resulting audio file will start and end, respectively.

Use the Audio Tail field to add extra seconds to the end of the resulting audio file. This is useful if you are using
effects or samples whose sounds exceed the defined audio length (e.g., long reverb or delay, one-shot samples with
long decays, etc.). We recommend using an audio tail of at least a couple of seconds.

Render Source

Check Stereo Output and use the adjacent field to select a pair of outputs (Out 1,2-7,8 and Submix 1-8 in
Standalone Mode, or Out 1,2-31,32 in Controller Mode; MPC Live does not use Out 7,8 and MPC One does not use
Out 3,4-7,8 in Standalone Mode, but displays them to maintain compatibility with MPC X, which does use them). The
mixdown will be taken from these outputs.

Check Separate Programs to create a mixdown of each program used in the sequence or song.

Check Explode Tracks to create a mixdown of each track used in the sequence (you cannot use this option for an
entire song).

Important: Each pad or keygroup must have their output routed to Program to be included in the mixdown. This is
the typical (and default) setting. See Modes > Pad Mixer > Routing to learn about this.

Render Options
If your Render Source is set to Stereo Output, check Master Inserts to include master insert effects in the mixdown.

If your Render Source is set to Separate Programs or Explode Tracks, check Export Returns to export the return
channel signals as separate files.

If your Render Source is set to Stereo Output, tap Save as Project Preview to save the sequence or song as a
project preview file (which you can play for reference in the Browser). If you check this box, Stereo Output will
automatically be checked, as well.
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File Formats

Tap WAV, AIFF, MP3, FLAC or OGG to select the
file format of the mixdown.

For WAV and AIFF files, use the Bit Depth field to
select a bit depth of 8, 16, or 24 bits, or 32 bits, e
floating point (32 F). For FLAC files, you can select
a bit depth of 16 or 24 bits. For MP3 and OGG
files, you can select a Bitrate of 128, 160, 192, or
320 kbps.

Use the Sample Rate field to select a sample rate
of 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most
cases, we recommend selecting 44.1 kHz.

FILE FORMAT
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Tap Export to enter the Save screen where you can select a name and location to save your audio mixdown.

Tap Cancel or the € icon in the upper-left corner to return to the previous screen.

Battery Usage

Important: Only MPC Live may use battery power. MPC X, MPC One and MPC Touch must be connected to a

power outlet.

Although you can power MPC Live from a power outlet (using the included power adapter), you can use its
internal battery, which typically has four hours of life, depending on CPU and how you’re using MPC Live.

While powering MPC Live from its internal battery, the battery icon in upper-right corner of the touchscreen
will show its current battery life. (The icon below it indicates whether MPC Live is in Standalone Mode or

Controller Mode.)

To view MPC Live’s system resources (battery life, CPU,
and RAM usage), tap the battery icon in upper-right
corner of the touchscreen. The System Resources window
will appear, showing percentages to indicate the current
battery life, CPU, RAM usage (Mem), and storage device
space usage.

See System Resources to learn more about the information
shown in this window.

To charge MPC Live’s internal battery, connect its power
input to a power outlet using the included power adapter.
The charging indicator light (behind the vent on the rear
panel) will turn on while charging. When the battery is fully
charged or when it is disconnected from a power outlet,
then this light will turn off.

A SYSTEM RESOURCES

iy PURGE
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Standalone vs. Controller Mode

MPC X, MPC Live and MPC One can function in two ways: Standalone Mode and Controller Mode. (MPC Touch
already operates as a controller only.)

To enter Standalone Mode, do one of the following:

If MPC X, MPC Live or MPC One is not connected
to a computer, simply press the power switch to
power it on.

If MPC X, MPC Live or MPC One is connected to
your computer and you want to keep your MPC
software open, press Menu to enter the Menu, and
then tap the monitor/cable icon in the upper-right
corner. When the Switch to Standalone Mode
window appears, tap Standalone to continue. Your
project will remain open on your computer, and you
can continue to work on it independently from the
project shown on the screen. (If you tap Cancel,
you can continue using your MPC hardware in
Controller Mode.)

If MPC X, MPC Live or MPC One is connected to
your computer and you want to close the MPC
software, simply close the MPC software on your
computer. When Looking for computer appears
on your MPC hardware’s touchscreen, tap
Standalone. If the Restart as Standalone window
appears, tap Yes to continue. (If you tap Cancel,
you can reopen your MPC software and continue
using your MPC hardware in Controller Mode.)

In Standalone Mode:

An MPC chip icon will appear in the upper-right
corner.

The MPC hardware is not communicating with a
computer over a USB connection.

Any files (projects, samples, etc.) that you save or
load are in the internal hard drive on your MPC X,
MPC Live or MPC One or a connected USB drive or
SD card.

Plugin programs are disabled.

A SWITCH TO STANDALONE MODE

Please ensure you have safely ejected all storage devices from your MPC hardware before you
switch back to Standalone Mode

Switching your MPC to Standalone mode does not affect the MPC project on your computer.

STANDALONE CANCEL
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To enter Controller Mode:

1. Make sure the USB-B Port on your MPC X, MPC Live
or MPC One is connected to your computer.

2. On your computer, open the MPC software.

If MPC X, MPC Live or MPC One is powered off, press
the power switch to power it on.

4. If MPC X, MPC Live or MPC One is currently in
Standalone Mode, press Menu to enter the Menu, and
then tap the MPC chip icon in the upper-right corner.
When the Enter Controller Mode window appears, tap A ENTER CONTROLLER MODE
Controller Mode to continue. (If you tap Cancel, you
can continue using your MPC hardware in Standalone S O RO S
Mode.) Looking for computer may appear briefly on It will disable the standalone MPC functionaity.
the screen before the MPC hardware recognizes the
USB connection as a controller.

Are you sure you want to enter Controller mode?

CONTROLLER MODE CANCEL

In Controller Mode:

e A monitor/cable icon will appear in the upper-

right corner. E:I

e The MPC hardware is communicating with a
computer over a USB connection.

e You can save or load files (projects, samples, etc.)
to or from your computer as well as the internal
hard drive on your MPC X, MPC Live or MPC One
or a connected USB drive or SD card.

e Plugin programs are enabled. Remember to specify
the disk directory where your plugins are located.
This can be done in the software’s Preferences (in
the Edit Menu). See the user guide in the MPC
software to learn more: click the Help menu, select
MPC Help, and select MPC User Manual.

e The touchscreen on your MPC hardware reflects
what it is controlling in the software, but due to
space and character limitations, the layout on the
screen is different (e.g., parameter names may be
abbreviated, the layout may be different or spread
across multiple tabs, etc.).
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The MPC hardware has a Menu page that lets you select any one of several modes. This chapter describes the

various features and functions of each one.

Click a button below to skip directly to that chapter.

SAMPLE EDIT

AUDIO EDIT (.} J

SAMPLER

TRACK VIEW

PAD MUTE

STEP SEQUENCER

Q-LINK EDIT

AUDIO EDIT

N Bt

PROGRAM EDIT

¢

LOOPER

TRACK MUTE

PAD PERFORM

To enter Main Mode, tap the house icon.

MEM
| BATTERY
* 0% CPU 7%

LISTEDIT BROWSER

PAD MIXER CHANNEL MIXER

NEXT SEQUENCE

4.

MIDI CONTROL PAD COLOR

Note: The Menu above is available when the currently selected track is a MIDI track. When an
audio track is selected, it will show an icon for Audio Edit Mode instead of Grid View.

While in Main Mode, the Grid View, Audio Edit Mode, the Track View, the Step Sequencer,
or XYFX Mode, the left edge contains icons to quickly enter one of five modes. Using this strip
of icons, you can easily jump between them:

To enter the Grid View, tap the grid icon. The MIDI tab in the lower-left corner of the
screen in Main Mode must be selected for this icon to be shown.

To enter Audio Edit Mode, tap the waveform-and-box icon. This Audio tab in the
lower-left corner of the screen in Main Mode must be selected for this icon to be shown.

To enter the Track View, tap the bars-and-magnifying-glass icon.
To enter the Step Sequencer, tap the vertical-bars icon.
To enter XYFX Mode, tap the XY icon.
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Main Mode

Main Mode gives you an overview of the most-used functions.

MAIN

To enter Main Mode, do one of the following:
e Press Main.
e Press Menu, and then tap Main.

Y MPC Project 001

1 Sequence 01

)i Program 001

M@ AuDO

The top of the screen shows the project name and timing information.

i MPC Project 01

The Project field shows the name of the current project.

To view the Project window, tap the Project field. The Project window will appear, showing a list of available
programs, sequences, and samples in the project.

In the Project window, in additional to typical functions you can perform in lists, you can do any of the following:

To move through a list, swipe up or down.

To expand or collapse the list of programs or sequences, tap the arrow (v or >) to its left.

To select a program, sequence, or sample, tap it.

To immediately select a sample and enter Sample Edit Mode, double-tap it.

To save the project, tap Save.

To save the project with another name, tap Save As. Use the Save window that appears to save the project.
To return to the previous screen, tap the X in the upper-right corner or anywhere outside the window.

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.),
tap Purge. In the screen that appears, tap Unused Samples to delete all unused samples from the project, tap
All Samples to delete all samples from the project (from all programs, sequences, and audio or MIDI tracks), or
tap Cancel to return to the previous screen.

To export the current sequence, tap Export. Use the Audio Mixdown screen that appears to export a song
(see General Features > Audio Mixdown to learn about the settings in this window). To export the song
instead, see the Song Mode chapter.

To export the current sequence as an Ableton Live Set, tap ALS Export. See Addenda > Updates in 2.6 >
New Features > Ableton Live Set Export for more information.

110



1 MPC Project 01

The In and Out boxes indicate your MPC hardware is receiving or sending (respectively) MIDI messages from or to
your computer.

The time counter at the top of the screen the current playhead position. This is shown in most of the modes. See
General Features > Time Counter/Locate to learn about this.

The TC icon opens the Timing Correct window, which contains various settings to help quantize the note events in
your sequence. See General Features > Timing Correct (TC) to learn about this.

The Metro/metronome icon opens the Click/Metro menu, which contains all settings regarding the metronome
(click track). See General Features > Metronome (Click/Metro) to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.

In Main Mode, these are the buttons at the bottom of the screen:
MIDI: Tap this button to view only MIDI tracks in the Track section.
Audio: Tap this button to view only audio tracks in the Track section.
Track -/+: Tap one of these buttons to switch to the previous or next track, respectively.
Mute: Tap this button to mute the current track.

Solo: Tap this button to solo the current track.
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On the left edge of the screen, next to the five mode icons, there are two small icons
that control the channel strip.

To show or hide the channel strip, tap the eye icon.

The icon below the eye icon indicates the type of channel strip (see next description).

The channel strip contains some important settings for the current pad, program,
track, or master output, depending on the currently selected icon:

To view the pad channel strip, tap the single-pad icon.
To view the program channel strip, tap the four-squares icon.

To view the track channel strip, tap the bars icon (when the MIDI tab is
selected) or the waveform icon (when the Audio tab is selected).

To view the master channel strip, tap the crown icon.

When viewing the pad channel strip while using a drum program, keygroup program,
or clip program:

The first field shows the current pad number. Press a pad or tap the field to select
a different pad.

Tip: This is useful for mixing your pads without having to enter the Pad Mixer.

The second field shows where the pad is routed, which you can change: Program
(the usual setting); Out 1,2-7,8, Out 1-8 or Sub 1-8 in Standalone Mode; and Out
1,2-31,32 or Out 1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed post-
pan knob. If the pan knob is set to the center position, the left and right channels
will be summed and padded. If the pan knob is set to the maximum left or right
positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that pad. Tap the area
under Inserts to open a window where you can load, change, and enable or
disable the effects.

Tap Solo or Mute to solo or mute the pad (respectively).

Adjust the pan knob or level slider to change the panning or level of the pad. The
green level meter next to the slider shows the pad’s current volume level in dB.
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When viewing the program channel strip while using a drum program, keygroup
program, clip program, or plugin program:

The first field shows the current program number and name (which you can
change).

The second field shows where the program is routed, which you can change:
Out 1,2-7,8, Out 1-8 or Sub 1-8 in Standalone Mode; and Out 1,2-31,32 or
Out 1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed
post-pan knob. If the pan knob is set to the center position, the left and right
channels will be summed and padded. If the pan knob is set to the maximum
left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that program. Tap
the area under Inserts to open a window where you can load, change, and
enable or disable the effects.

Tap Solo or Mute to solo or mute the program (respectively). Alternatively,
press Solo or Mute under the LED meters (MPC X).

To change the program’s automation, tap the program automation button
or press Read/Write (MPC X) to cycle through its three states:

When off, the program will ignore automation data. If you have already
recorded or entered automation, tapping this will switch between Read (R)
and Write (W) only, but you can override this and turn it off by pressing and
holding Shift while tapping the button.

Important: If you have already recorded automation and turn it off, the
track will still use the effect and its parameter values at the point where you
turned it off.

When set to Read (R), the program will read automation data but will not _
record any additional automation over it. (Think of this as a protective
feature to prevent accidental changes to your automation while recording.)

When set to Write (W), the program can record automation. (If you have
any Q-Link knobs assigned to automatable parameters, make sure not to
touch any accidentally while you are recording.)

Tip: You can quickly set all programs and audio tracks to the same
automation by tapping the global automation button in the upper-right corner
of the screen. See General Features > Automation to learn about this.

Adjust the pan knob or level slider to change the panning or level of the
program. The green level meter next to the slider shows the program’s current
volume level in dB.

When viewing the track channel strip while using a MIDI track:
The first field shows the current track (which you can change) and its name.
The second field shows the name of the program the track is using.
Tap Solo or Mute to solo or mute the track (respectively).

Adjust the pan knob or level slider to change the panning or level of the track.
The blue level meter next to the slider shows the track’s current velocity level.

Note: If the track is using a plugin program, then the slider will send CC #7
(Volume) and the knob will send CC #10 (Pan) to your instrument plugin. The
plugin will then handle these messages as it normally would.
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When viewing the track channel strip while using an audio track:

The first field defines the input source of the external audio signal, which you can
set to a pair of inputs (Input 1,2-3,4 in Standalone Mode, Input 1,2-31,32 in Input 1,2
Controller Mode) or a single input (Input 1-4 in Standalone Mode, Input 1-32 in Out12

Controller Mode).

The second field shows where the track is routed, which you can change: Out
1,2-7,8, Out 1-8 or Sub 1-8 in Standalone Mode; and Out 1,2-31,32 or Out
1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed
post-pan knob. If the pan knob is set to the center position, the left and right
channels will be summed and padded. If the pan knob is set to the maximum
left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that track. Tap the
area under Inserts to open a window where you can load, change, and enable
or disable the effects.

Tap Solo or Mute to solo or mute the track (respectively). Alternatively, press
Solo or Mute under the LED meters (MPC X).

To change the audio track’s automation, tap the track automation button
or press Read/Write (MPC X) to cycle through its three states:

When off, the audio track will ignore automation data. If you have already _
recorded or entered automation, tapping this will switch between Read (R)

and Write (W) only, but you can override this and turn it off by pressing and

holding Shift while pressing or tapping the button.

Important: If you have already recorded automation and turn it off, the
track will still use the effect and its parameter values at the point where you
turned it off.

When set to Read (R), the audio track will read automation data but will not _
record any additional automation over it. (Think of this as a protective
feature to prevent accidental changes to your automation while recording.) _

When set to Write (W), the audio track can record automation. (If you have
any Q-Link knobs assigned to automatable parameters, make sure not to
touch any accidentally while you are recording.)

Tip: You can quickly set all programs and audio tracks to the same
automation by tapping the global automation button in the upper-right corner
of the screen. See General Features > Automation to learn about this.

Adjust the pan knob or level slider to change the panning or level of the track.
The green level meter next to the slider shows the track’s current volume level
in dB.

To record-enable the track, tap the Record Arm button or press Rec Arm
(MPC X). When you begin audio recording, the audio signal will be recorded to
this track.

Tip: You can select multiple tracks in the Track View by pressing and holding

Shift while tapping the Arm button to each track. 1 Outputs 1/2

When viewing the master channel strip:
The first field shows the current master output as a stereo pair (which you can
change).

The Inserts field shows any enabled or disabled effects for that pair of outputs.
Tap the area under Inserts to open a window where you can load, change, and
enable or disable the effects.

Tap Mute to mute the master output.

Adjust the pan knob or level slider to change the panning or level of the master
output. The green level meter next to the slider shows the outputs’ current
volume level in dB.
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Sequence Section

The Sequence section shows the current sequence and its information.

80.79

1 Sequence 01 ~

Use Sequence field to select a sequence.

To edit the name of the sequence, tap the cursor icon on the right edge of
the section, and use the virtual keyboard that appears.

Use the BPM field to adjust the tempo of the sequence.

To set whether the sequence follows its own tempo (Sequence) or a .
master tempo (Master), tap the Sequence/Master button under the BPM 80.79
field. Alternatively, press and hold Shift+Tap.

Use the Bars field to adjust the length of the sequence in bars.

The Loop button shows whether the sequence (or a part of it) will loop or not.
To enable or disable looping, tap the button.

To set the start point and end point of loop, tap the Start or End field
(respectively) and then use the data dial or the —/+ buttons, or double-tap the
field and use the numeric keyboard that appears.

Note: The Last Bar value of the Delete Bars and Copy Bars processes
depends on the total length of the sequence.

Use the Transpose field to set the transposition (in semitones) of the entire
sequence.
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To edit the sequence, tap the pencil icon on the right edge of the section. The Sequence Edit/Copy window will open.

< Sequence 01

=

TRANSPOSE BOUNCE TO SAMPLE

[ T [+2] 2]

DELETE BARS INSERT BARS HALF LENGTH DOUBLE LENGTH

57 copy

;
[ L
SEQUENCE EVENTS SAVE CURRENT SEQUENCE

CANCEL

You can use any of these functions as described below, though there are fewer options for audio tracks than for MIDI
tracks.

To return to Main Mode, tap Cancel or the left arrow (€) in the upper-left corner of the screen. Alternatively, press
Main.

To edit the name of the sequence, tap the top of the screen and use the virtual keyboard that appears.
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The Erase function erases all or part of a track in a specific
sequence. « erase

To select the sequence you want to erase, use the '
Sequence field. 1: Sequence 01

To select the track you want to erase within the
sequence, use the Track field.

To set the time range of the sequence you want to
erase, use the Bar, Beat, and Tick fields. The left
fields set the start of the time range, and the right
fields set the end of the time range.

To select what types of events you erase, select one
of the Erase options:

CANCEL

All erases all pad events from the designated time

range and reset all of its settings. M

Automation erases only automation from the

: . 1: Sequence 01 1: Drums
designated time range.

Note erases only specific pad events from the 1:
designated time range. In the diagram of the eight
pad banks that appears, press each pad in each
bank to select or deselect its notes. This option is
available only for MIDI tracks, not audio tracks.

Except Note erases everything except pad events
from the designated time range. This option is
available only for MIDI tracks, not audio tracks.

CANCEL

To confirm your choice, tap Do It.

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.

The Clear function erases all events from the sequence

and resets all of its settings.
To confirm your choice, tap Clear.

@ CLEARSEQUENCE

To return to the previous screen, tap Cancel.

Are you sure you want to clear this Sequence?

CANCEL
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The Transpose function transposes a range of events on a
track in a sequence. The events within that range will shift
accordingly in the Grid View. This option is available for
MIDI tracks only.

To select the sequence you want to transpose, use
the Sequence field.

To select the track you want to transpose within
the sequence, use the Track field.

To set the time range of the sequence you want to
transpose, use the two sets of Bar, Beat, and Tick
fields. The left fields set the start of the time range, and
the right fields set the end of the time range.

For drum programs, use the two Pad fields to select
the “source” pad (whose events you want to move) and
“destination” pad (where the events will be placed). Tap
each field and then press the desired pad.

For keygroup programs, plugin programs, and MIDI
programs, set the range and amount of transposition:

Range: Use the two Note fields to set the range of
notes of the events you want to transpose. Note
events within this range will be transposed, while
note events outside of this range will remain
unchanged.

Transpose: Use this field to set how many
semitones up or down you want to transpose the
note events.

To confirm your choice, tap Do It.

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.

The Bounce to Sample function immediately renders the
sequence (all of its tracks) as an audio sample and places it
in the project’s sample pool. By default, it will be named
Bounce - and appended with the sequence name.

If you have already used this function on this sequence,
then you will be asked if you want to overwrite the existing
sample with this new one or cancel.

To continue and save the sequence over the
existing one, tap Replace.

To cancel, tap Cancel.

D TRANSPOSE

CANCEL
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The Delete Bars function removes a range of bars from a
sequence.

To select the sequence whose bars you want to [x[] oELETE BARS
delete, use the Sequence field.

To set the range of bars you want to delete, use the
First Bar and Last Bar fields. The bar in each field and
all bars in between them will be deleted.

1: Sequence 01

To confirm your choice, tap Do It.

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel. canceL

The Insert Bars function adds empty bars to a sequence
at a specified point.

To select the desired sequence, use the Sequence AT INSERTBARS
field.

To set how many bars you will insert, use the # of
Bars field.

To set the time signature of the inserted bars, use
the two Time Sig fields.

1: Sequence 01

To set where you will insert the bars, use the Before
Bar field. The bars will be inserted before this one.

To confirm your choice, tap Do It. canceL

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.

The Half Length function will immediately halve the
length of the sequence (without deleting any note events).

The Double Length function will immediately double the
sequence and copy all events from the first half to the
second half.
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The Copy Sequence function copies the contents of one
sequence to another. ) G

To select the “source” sequence, use the Copy
Contents of Sequence field. This is the sequence
whose events you want to copy. 3: Sequence 03

To select the “destination” sequence, use the Over
Contents of Sequence field. This is the sequence
where the source sequence will be copied.

To confirm your choice, tap Do It.

To return to the previous screen, tap € Back or
anywhere outside the window.

4: (unused)

CANCEL

To cancel and return to Main Mode, tap Cancel.

The Copy Bars function copies a range of bars from a
sequence and adds them to another at a specified point. [ copvears

To select the “source” sequence, use the From
Sequence field. This is the sequence whose bars you

1: Sequence 01
want to copy.

To set the range of bars to copy in the source 1
sequence, use the First Bar and Last Bar fields.

To select the “destination” sequence, use the To 2: (unused)
Sequence field. This is the sequence where the source
sequence bars will be copied.

To set where you want to add the copied bars, use
the After Bar field. The copied bars will be inserted
after this one.

CANCEL REPLACE MERGE

To set how many instances of the copied bars you
want to add, use the Copies field.

To overwrite the destination sequence, tap Replace.

To add the events to the destination sequence
without erasing anything, tap Merge.

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.
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The Copy Events function copies a range of events or
selected audio track regions from a sequence and adds G2 CoPYEVENTS
them to another at a specified point.

To select the “source” sequence, use the From 1: Sequence 01
Sequence field. This is the sequence whose content

Copy All Events
To select the “source” track, use the From Track &

field. This is the track whose content you want to copy.

1: Sequence 01 1: Drums

To specify the pads or notes to copy events from,
use the Pads or Notes field. By default, this will be set O
to All to copy all events in the current track.

CANCEL REPLACE MERGE

To set the time range of the events or the audio
track you want to copy, use the Bar, Beat, and Tick
fields. The left fields set the start of the time range, and -
the right fields set the end of the time range.

To set what content is copied, use the field below 1. Sequence 01 8 1 Drums

the dotted arrow. Copy All Events will copy and paste

all events in the track. Copy Only Selected Events will Tt 10 0 =@ 30 1 0
copy and paste only the events that are currently Copy Only Selected Events
selected.

To select the “destination” sequence, use the To 1: Sequence 01 1: Drums

Sequence field. This is the sequence where the

content of the source sequence will be copied. &

To select the “destination” track, use the To Track canceL REpLACE MERGE
field. This is the track where the content of the source
track will be copied.

To set where you want to add the copied events or
audio track, use the Bar, Beat, and Tick fields. The
events or audio track will be added after this point.

To set how many instances of the copied events or
audio track you want to add, use the Copies field.

To set whether you want to copy the events in the
time range or the selected notes in the Grid View or
List Edit Mode, use the Selection field. Set this to All
events to copy the notes in the time range determined
by the Bar, Beat, and Tick fields above, or set this to
Selected events to copy only the events currently
selected in the Grid View or List Edit Mode. This field is
available for MIDI tracks only.

To overwrite the destination sequence, tap Replace.

To add the events to the destination sequence
without erasing anything, tap Merge.

To return to the previous screen, tap € Back or
anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.
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The Save Current Sequence function saves the current
sequence to an external storage device or the internal
drive of MPC X or MPC Live.

& Save B3 [Internal\MPC Documents\Sequences 0 &3 & @

Sequence 01.5xq

Sequence

To select the storage device you want to view, tap it gl Sequence 035

in the Storage column on the left. ecsence i
Internal is the internal drive of MPC X, MPC Live Sequence 05 sx
or MPC One. :

MPC Documents is a shortcut to the MPC
Documents folder on the internal drive of MPC X,
MPC Live or MPC One.

If you have storage devices connected to USB [imess —
ports or SD card slot of MPC X, MPC Live, MPC
One, or your computer (with MPC Touch), they will
appear in this column, as well.

Fenave - Sequence 09

To enter a folder, double-tap it. Alternatively, turn the
data dial or use the -/+ buttons to move through the
list, and press the data dial, or the center cursor or
Enter (MPC X), to enter a folder. You can also tap one
of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see
Browser to learn how to do this).

To create a new folder, tap New Folder, use the
virtual keyboard that appears to enter a name, and then
tap Do It. You will immediately enter the new folder.

To move up one folder level, tap the folder/t icon in
the upper-left corner.

To name the file, tap the File Name field at the bottom
of the screen, and use the virtual keyboard that appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel.
Alternatively, tap the € icon in the upper-left corner.
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Track Section

The Track section shows the current track, program type, and its information.

1 Drums

The Track section while using a MIDI track. The Track section while using an audio track.

The Track field shows the track number and its name.

To edit the name of the track, tap the cursor icon on the right edge of the section and use the virtual keyboard that
appears.

While using a MIDI track:

1 Drums

The program selector indicates the type of program through which the track is being routed. The specific
program name is displayed below in the Program section. You can use the program selector to change program
type (and then select a specific program of that type in the Program section below it).

To select a drum program, tap the four-squares icon.
To select a keygroup program, tap the piano-keys icon.
To select a clip program, tap the play-button icon.

To select a MIDI program, tap the bars icon.

To select a CV program, tap the CV icon.

To select a plugin program, tap the plug icon.

Use the Length field to set how long the track is in beats. If you select the minimum value, Seq or 0 (if you use
the numeric keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence
repeatedly under a 4-bar bass line.

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set to 50%,
the track will be played with half the velocity it was originally played. When set to 200%, the track will play twice
as loud. The maximum velocity level is still 127, though.

Use the Transpose field to set the transposition (in semitones) of the entire track.
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While using an audio track:

1 Audio 001

Tap the Record Arm button to record-enable the track. When you begin audio recording, the audio signal will be
recorded to this track.

Tip: You can select multiple tracks in the Track View by pressing and holding Shift while tapping the Arm button
to each track.

Use the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states:
When set to Auto, you will hear incoming audio while the track is record-enabled only.
When on, you will hear incoming audio whether or not the track is record-enabled.

When off, you will never hear any incoming audio.

To edit the track, tap the pencil icon on the right edge of the section. The Track Edit window will open.

5 El

EXPLODE DOUBLE-SPEED EVENTS HALF-SPEED EVENTS

A &

SPLIT EVENTS PITCH QUANTIZE HUMANIZE GENERATE RANDOM EVENTS

@ i il

COPY TRACK BOUNCE TO SAMPLE BOUNCE TO AUDIO TRACK

B SAvE

~
EXPORT AS PATTERN

CANCEL

While using MIDI tracks, you can use any of these functions as described below.

To return to Main Mode, tap Cancel or the left arrow (€) in the upper-left corner of the screen. Alternatively, press
Main.

To edit the name of the track, tap the top of the screen and use the virtual keyboard that appears.
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The Clear function erases all events from the track and
resets all of its settings.

To confirm your choice, tap Clear.

To return to the previous screen, tap Cancel.

The Explode function immediately splits the current track
into multiple tracks—one for each distinct pad or note
(pitch, not event). The current track also remains present
and intact, while each track created from it is labeled with
the track name and pad name or number.

The Double-Speed Events function immediately halves
the lengths of all note events on the track as well as the
distance between them. In other words, the track’s notes
are pressed closer together so the track sounds like it is
playing at twice the previous speed. This does not actually
affect the pitches of notes or the tempo.

The Half-Speed Events function immediately doubles the
lengths of all note events on the track as well as the
distance between them. In other words, the track’s notes
are spread further apart so the track sounds like it is
playing at half of the previous speed. This does not
actually affect the pitches of notes or the tempo.

The Copy Track function copies the contents of one track
to another.

To select the “source” track, tap the Copy Contents
of Track field. This is the track whose events you want
to copy.

To select the “destination” track, tap the Over
Contents of Track field. This is the track where the
source track will be copied.

To confirm your choice, tap Do It.

To cancel and return to Main Mode, tap Cancel.

The Split Events function divides note events to create
new rhythms and patterns.

To select the how many events to create, use the
Into slider. Select 2 to 32 events.

To apply the split to selected events, tap the Only
selected events field. Leave this unchecked to split all
note events in the track.

To confirm your choice, tap Do It.

To cancel and return to Main Mode, tap Cancel.

SPLIT EVENTS

Setup

[57) COPYTRACK

1: Drums

2: (unused)

CANCEL
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The Pitch Quantize function forces the pitches of note
events into a specific scale.

To select the desired root note of the scale, use the
Root Note field.

To select a type of scale, use the Scale field. Note Input Filter

To determine which note events will be quantized, 4
tap the Only apply to selected events checkbox.

When on, only the currently selected note events
will be quantized.

When off, all pitches in the current track will be
quantized.

To set lowest-possible and highest-possible pitches
where the quantized note events will be placed, use
the Start Note and End Note fields (respectively). If a
note event is originally outside of this range, it will be
forced to the nearest pitch (within the scale) inside the
range.

PITCH QUANTIZE

Output Note Range

Quantized notes will be moved up/down by an octave to fit into this note range.

To continue and quantize the note events, tap Do It.
To cancel, tap Close.

The Humanize function applies randomization to the
timing, length, and/or velocity of MIDI note events.

To select whether or not humanization will be applied Time
to the timing of MIDI events, tap the Humanize Time
checkbox. .

To select the maximum number of pulses by which
the timing of an event will be adjusted, use the
Amount (Pulses) slider.

To set how dramatically the humanization effect is
applied to the timing, use the Eagerness slider.
Negative values correspond to playing “ahead of the
beat” while positive values correspond to playing
“behind the beat.”

To set whether or not humanization will be applied
to the duration of MIDI note events, tap the
Humanize Note Length checkbox.

To set how dramatically the humanization effect is
applied to note lengths, use the Length (%) slider.
To set whether or not humanization will be applied
to the velocities of MIDI note events, tap the

Humanize Velocity checkbox.

To set how dramatically the humanization effect is
applied to note velocities, use the Strength (%) slider.

To determine which notes will use these
humanization values, tap the Only Apply to
Selected Events checkbox.

When on, just the currently selected notes will be
humanized.

When off, all notes in the track will be humanized.
To apply humanization and keep this window open,
tap Apply.
To apply humanization and close the window, tap
Do It.

To close the window without making any changes,
tap Close.

HUMANIZE

HUMANIZE

Length

Velocity

&4
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The Generate Random Events function creates random
melodic or drum patterns on the current MIDI track.

To select the type of events you want to create, use
the Event Type field to select Drum Events or
Melodic Events.

To select how the events will be created relative to
the existing events on the track, use the Replace
field:

Replace All Events: Select this option to replace all
events on the track with the randomly generated
ones.

Replace Events in Note Range: Select this option
to replace all events in the designated note range
on the track with the randomly generated ones.
Use the Bank or Start Pad and End Pad menus
to set the note range for drum events or the Start
Note and End Note menus to set the note range
for melodic events.

Add to Existing Events: Select this option to add
the randomly generated events to the track
without replacing or overwriting the existing ones.

To set how many bars the events will use, use the
Pattern Size (Bars) field. The highest possible value
is the number of bars in the current sequence.

To select the duration of the events, use the Note
Length field. (This feature is nonfunctional if Legato
is enabled while generating melodic events.)

To generate the events and keep this window open,
tap Apply.

To generate the events and close the window, tap
Do It.

To close the window without generating any events,
tap Close.

If Event Type is set to Drum Events:

To select the pad bank that will be used to
generate the events, use the Bank field or select
Range to use the Start Pad and End Pad menus
to define a specific pad range instead.

To define a specific pad range over which the
events will be generated, use the Start Pad or
End Pad fields. You can use these fields only if
the Bank menu is set to Range.

To set how closely together the events will be
placed in the track, use the Density (%) slider.

To set how widely or narrowly the rhythmic
patterns of the generated notes vary, use the
Rhythm Variation slider.

GENERATE RANDOM EVENTS

Generation

Drum

Replace all events

2

Drum event options

GENERATE RANDOM EVENTS

2

Drum event options
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If Event Type is set to Melodic Events:

To define a specific note range over which the CENERATE RANDOM EVENTS
events will be generated, use the Start Note or Eem
End Note fields.

To enable or disable legato, tap the Legato
checkbox.

Melodic events

When on, the generated notes will be
extended or shortened to create a long,
unbroken phrase from the first note event’s Melodic event options
start point to the last note event’s end point.
Each note event will sustain until another
note event starts. If multiple note events start
at the same time (and are not the last note
events), their lengths will become identical.

GENERATE RANDOM EVENTS

When off, the generated notes will use the
duration set by the Note Length menu. Melodicevenfoptions

To set the maximum number of note events that
can be sounding simultaneously in the track,
use the Polyphony field to select 1-8.

To determine whether or not the notes will use
a scale, tap the Constrain Notes to Scale
checkbox.

When on, the notes will be within the scale
determined by the Scale menu.

When off, the notes will be chromatic.

To set how closely together the events will be
placed in the track, use the Density (%) slider.

To set the root note of the scale that the notes
will use, use the Root Note field.

To select the scale or mode that the generated
notes will use, use the Scale field.

The Bounce to Sample function immediately renders the
track (for the current sequence only) as an audio sample
and places it in the project’s sample pool. By default, it will
be named Bounce - and appended with the track name.
This function does not work for tracks that use MIDI
programs or CV programs.

If you have already used this function on this track, then
you will be asked if you want to overwrite the existing
sample with this new one or cancel.

To continue and save the track over the existing
one, tap Replace.

To cancel, tap Cancel.
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The Bounce to Audio Track function immediately
renders the track (for the current sequence only) as an
audio track in the project. The Main Mode will
automatically switch to the Audio tab. By default, it will be
named Audio and appended with a number (e.g., Audio
002). This function does not work for tracks that use MIDI
programs or CV programs.

If you have already used this function on this track, then
you will be asked if you want to overwrite the existing
sample with this new one or cancel.

To continue and save the track over the existing
one, tap Replace.

To cancel, tap Cancel.

The Export as Pattern function saves the track (for the
current sequence only) as a pattern (.mpcpattern) to an
external storage device or the internal drive of MPC X or
MPC Live.
To select the storage device you want to view, tap it
in the Storage column on the left.
Internal is the internal drive of MPC X, MPC Live
or MPC One.
MPC Documents is a shortcut to the MPC
Documents folder on the internal drive of MPC X
or MPC Live.
If you have storage devices connected to USB
ports or SD card slot of MPC X, MPC Live, MPC
One, or your computer (with MPC Touch), they will
appear in this column, as well.
To enter a folder, double-tap it. Alternatively, turn the
data dial or use the —/+ buttons to move through the
list, and press the data dial, or the center cursor or
Enter (MPC X), to enter a folder. You can also tap one
of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see
Browser to learn how to do this).
To create a new folder, tap New Folder, use the
virtual keyboard that appears to enter a name, and then
tap Do It. You will immediately enter the new folder.
To move up one folder level, tap the folder/L icon in
the upper-left corner.
To name the file, tap the File Name field at the bottom
of the screen, and use the virtual keyboard that appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel.
Alternatively, tap the € icon in the upper-left corner.

& Save

L Internal

FILE NAME

B3 NEW FOLDER

[Internal\MPC Documents\Exports

Pattern 09

Pattern 01.mpcpattern

Pattern 02.mpcpattern

Pattern 03.mpcpattern

Pattern O4.mpcpattern

Pattern 05.mpcpattern

Pattern 06.mpcpattern

Pattern 07.mpcpattern

Pattern 08.mpcpattern

CANCEL
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& Audio 001

] X Ll

DELETE CLEAR REGIONS RESET CHANNEL STRIP COPY TRACK

H Save

1

SAVE CURRENT CHANNEL STRIP

CANCEL

While using audio tracks, you can use any of these functions as described below.

To return to Main Mode, tap Cancel or the left arrow (€) in the upper-left corner of the screen. Alternatively, press
Main.

To edit the name of the track, tap the top of the screen and use the virtual keyboard that appears.

The Delete function erases the entire audio track.
To confirm your choice, tap Clear.

To return to the previous screen, tap Cancel. @ DELETE LD TRAK

Are you sure you want to delete this Audio Track?

The Clear Regions function erases all regions from the
audio track without erasing the track itself.

CANCEL

The Reset Channel Strip function:
e clears all Insert effect slots;
e turns Mute, Solo, automation, and Monitor off;
e resets the pan knob to the center;
e resets the level slider to 0.00 dB; and
e turns the Record Arm button off.

It does not change the track’s inputs or outputs.
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The Copy Track function copies the contents of one track
to another. 3] COPY AUDIO TRACK

To select the “source” track, tap the Copy Contents
of Track field. This is the track whose events you want
to copy. 1: Audio 001

To select the “destination” track, tap the Over
Contents of Track field. This is the track where the
source track will be copied. 2: Audio 002

Vocals

To rename the "destination" track, use the Track
Name field.

To confirm your choice, tap Do It.

To cancel and return to Main Mode, tap Cancel or CANCED
anywhere outside the window.

The Save Current Channel Strip function saves the
current settings of the track channel strip (for the current
audio track) to an external storage device or the internal
drive of MPC X or MPC Live. O infemai ki

Audio 003.xpm

& Sae B [Internal\MPC Documents\Exports

Audio 001.xpm

To select the storage device you want to view, tap it
in the Storage column on the left.

Audio 004.xpm

Audio 005.xpm

Internal is the internal drive of MPC X, MPC Live Audio 006 xpm

or MPC One. Aucio 007

MPC Documents is a shortcut to the MPC
Documents folder on the internal drive of MPC X, |y -

MPC Live or MPC One.

B3 NEW FOLDER CANCEL

If you have storage devices connected to USB
ports or SD card slot of MPC X, MPC Live, MPC
One, or your computer (with MPC Touch), they will
appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the
data dial or use the —/+ buttons to move through the
list, and press the data dial, or the center cursor or
Enter (MPC X), to enter a folder. You can also tap one
of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see
Browser to learn how to do this).

To create a new folder, tap New Folder, use the
virtual keyboard that appears to enter a name, and
then tap Do It. You will immediately enter the new
folder.

To move up one folder level, tap the folder/t icon in
the upper-left corner.

To name the file, tap the File Name field at the
bottom of the screen, and use the virtual keyboard that
appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel.
Alternatively, tap the € icon in the upper-left corner.
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Program Section

The Program section shows the current program. This section will appear differently depending on the type of
program selected in the Track section above it.

For all program types while using MIDI tracks, you can do the following:

To edit the name of the program, tap the cursor icon on the right edge of the section. Use the virtual keyboard
that appears to enter a new name, and then tap Do It.

To create a new program of the currently selected type, tap the + icon. A new program of the same type will
be created and appended with a number (e.g., Program 002).

For all program types while using audio tracks, you can do the following:

To change the input source, tap Input Config. This will show or hide the track channel strip. If you are viewing the
audio track channel strip (not the master channel strip), the first field will be automatically selected.

To enter Audio Edit Mode, tap Edit Audio. This is the same as tapping the waveform-and-box icon on the left
edge of the screen.

While viewing drum programs, the Drum Program field shows the name of the program.

Tap Warp Samples to enter the first Sample tab in Program Edit Mode immediately (see Program Edit Mode >
Drum Programs to learn about this).

Tap Assign Samples to enter the Sample Assign tab in the Browser immediately (see Browser to learn about this).

Tap Edit Samples to enter Program Mode in Sample Edit Mode immediately (see Sample Edit Mode > Program
Mode to learn about this). The sample shown will be the one in the top layer of the last pad you pressed.

Clip 001

While viewing clip programs, the Clip Program field shows the name of the program.

Tap Edit Clips to enter Program Edit Mode, where you can assign samples (clips) to pads, edit each clip, and
configure how each clip plays when launched (see Program Edit Mode > Clip Programs to learn about this).
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Hybrid 3

. H\/bﬂd 3001 01 Trance-ition Pad

While viewing plugin programs, the Plugin Program field shows the name of the program.

Use the Plugin field to select the plugin the program is using. In the screen that appears, you can tap the Type or
Manufacturer button at the bottom of the screen to enable or disable sorting of your plugins by type or maker.

Note: You have to specify the disk directory where your plugins are located. This can be done in the software’s
Preferences. See user guide in the MPC software to learn how to do this: click the Help menu, select MPC
Help, and select MPC User Manual.

Use the MIDI Ch field to select the MIDI channel the program uses. Use this setting when you are working with a
virtual instrument plugin that supports multi-mode.

Use the Preset field to select a preset (if any) within the plugin the program is using.

IPC Live Port 1 ~ Off

Midi 001

While viewing MIDI programs, the MIDI Program field shows the name of the program.
Use the MIDI Port field to select the port over which the program sends its MIDI data.

Note: You also have to configure the MIDI ports in the Preferences. See the user guide in the MPC software to
learn how to do this: click the Help menu, select MPC Help, and select MPC User Manual.

Use the Program Ch field to select the program change message the program sends out.
Use the MIDI Ch field to select the MIDI channel over which the program sends its MIDI data.

Use the Bank MSB and Bank LSB fields to select the messages for Most Significant Byte and Least Significant
Byte (respectively) that the program sends out.

While viewing CV programs, the CV Program field shows the name of the program.
Use the Note field to select the note tracking—the program’s note track: Lowest, Highest, or Last.
Use the CV Port field to select the CV port the program is using.
Use the Gate Port field to select the Gate port the program is using.
Use the Mod Wheel field to select the CV port used by a modulation wheel on an external controller.

Use the Velocity Port field to select CV port the program will use to transmit velocity values.
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DELETE DUPLICATE DUPLICATE TO TRACK BOUNCE TO SAMPLE
i:»:ill
BOUNCE TO AUDIO TRACK
B SAVE

SAVE CURRENT PROGRAM SAVE CURRENT SAMPLE

CANCEL

To edit the program, tap the pencil icon on the right edge of the section. The Program Edit/Copy window will
open.

You can use any of these functions as described below.

To return to Main Mode, tap Cancel or the left arrow (€) in the upper-left corner of the screen. Alternatively,
press Main.

To edit the name of the program, tap the top of the screen and use the virtual keyboard that appears.

The Delete function erases all events from the track and
resets all of its settings.

To confirm your choice, tap Clear.

©  DELETE PROGRAM

To return to the previous screen, tap Cancel.

Are you sure you want to delete this Program?

The Duplicate function immediately creates an identical
program. The duplicate program will use the same name
but appended with a number (e.g., Program 002).

CANCEL DELETE
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The Duplicate to Track function immediately creates an identical program on a new track. The duplicate program
will use the same name but appended with a number (e.g., Program 002). The new track will be named Track and

appended with a number (e.g., Track 06).

The Bounce to Sample function immediately renders all tracks that use that program (for the current sequence only)
as an audio sample and places it in the project’s sample pool. By default, it will be named Bounce - and appended with
the program name. This function does not work for MIDI programs or CV programs.

If you have already used this function on this program, then you will be asked if you want to overwrite the

existing sample with this new one or cancel.

To continue and save the program over the existing one, tap Replace.

To cancel, tap Cancel.

The Bounce to Audio Track function immediately renders that program (for the current sequence only) as an audio
track in the project. The Main Mode will automatically switch to the Audio tab. By default, it will be named Audio and
appended with a number (e.g., Audio 002). This function does not work for MIDI programs or CV programs.

If you have already used this function on this track, then you will be asked if you want to overwrite the existing

sample with this new one or cancel.

To continue and save the track over the existing one, tap Replace.

To cancel, tap Cancel.

The Flatten Pad function renders all samples on a pad as
an audio sample and places it on the first layer of that pad.
The resulting sample is the audio signal produced by that
pad at full velocity (127) after the pad channel strip, which
means that it includes any assigned pad insert effects and
the results of warping the sample. This function is useful if
you need to reduce how CPU-intensive a pad or program is
by essentially “embedding” the warping and effects in the
sample itself. By default, it will use the name of the first
sample. This function works for drum programs only. (This is
the same as the Flatten Pad button shown at the top of the
screen in Program Edit Mode.)

To select the pad, press it or use the Pad menu.

To set the length of the audio tail, use the Audio Tail
field. This will add extra seconds to the end of the
resulting audio file. This is useful if you are using
effects or samples whose sounds exceed the defined
audio length (e.g., long reverb or delay, one-shot
samples with long decays, etc.). We recommend using
an audio tail of at least a couple of seconds.

To name the new sample, tap the Edit Name field,
and use the virtual keyboard that appears.

To confirm your choice, tap Do It.

To cancel, tap Cancel.

[®] FLATTEN PAD

Sample_01
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The Save Current Program or Save Current Sample
function saves the current program or sample (the top
layer of the last pad you pressed) (respectively) to an
external storage device or the internal drive of MPC X, Program 002>pm

Internal

MPC Live or MPC One. 7 Program 003.xpm

& Save B3 [Internal\MPC Documents\Programs 0O &=

Program 001.xpm

Program 004.xpm

To select the storage device you want to view, tap it
in the Storage column on the left.

Program 005.xpm

Program 006.xpm

Internal is the internal drive of MPC X, MPC Live orogram 0075

or MPG One.
MPC Documents is a shortcut to the MPC

Documents folder on the internal drive of MPC X,
MPC lee or MPC One NEW FOLDER CANCEL

If you have storage devices connected to USB
ports or SD card slot of MPC X, MPC Live, MPC
One, or your computer (with MPC Touch), they will
appear in this column, as well.

FILE NAME Program 009 (]

To enter a folder, double-tap it. Alternatively, turn the
data dial or use the -/+ buttons to move through the
list, and press the data dial, or the center cursor or
Enter (MPC X), to enter a folder. You can also tap one
of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see
Browser to learn how to do this).

To create a new folder, tap New Folder, use the
virtual keyboard that appears to enter a name, and
then tap Do It. You will immediately enter the new
folder.

To move up one folder level, tap the folder/t icon in
the upper-left corner.

To name the file, tap the File Name field at the
bottom of the screen, and use the virtual keyboard that
appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel.
Alternatively, tap the € icon in the upper-left corner.
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Grid View

The Grid View lets you view and edit the note events of each track of a sequence in a project
and their velocities. This mode has two different appearances: one for drum programs and one
GRID VIEW for keygroup programs, MIDI programs, and plugin programs.
For drum programs, the left column shows you all available pads in a vertical view with their corresponding data.

For keygroup programs, plugin programs, and MIDI programs, the left column shows a vertical “piano roll” keyboard.
To enter the Grid View, do either of the following:

e Press Menu, and then tap Grid View.

e Press Shift+Main/Grid (MPC One)

Note: The Grid View option is available when the currently selected track is a MIDI track. When an audio track is
selected, it will show an icon for Audio Edit Mode instead of Grid View. To select a MIDI track (and enable Grid View),
press Main to enter Main Mode, and then tap MIDI in the lower-left corner.

DON'T SNAP EDIT START EDITEND TRANSPOSE VELOCITY DON'T SNAP EDIT START EDITEND TRANSPOSE VELOCITY
Grid View of a drum program. Grid View of a keygroup program or MIDI program.

The top of the screen shows the track name, sequence and timing information, and editing tools.

Use the Track field to select which track of the current sequence you want to show in the grid.

Use the Bars field to set the length of the sequence.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the
modes. See General Features > Time Counter/Locate to learn about this.
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In the Grid View, these four tool icons enable you to use different functions in the grid.

Tap one to select its mode:

Pencil: Draw Mode:

To enter a note in an empty grid square, tap the grid square.

To select a note, tap it.
To move a note, tap and drag it to another grid square.

To erase a note, double-tap it.

Eraser: Erase Mode:

To erase a note, tap it.

Select Box: Select Mode:

Note: Notes will remain selected if you switch to another mode. The selection will change, however, if you
press a pad while Hitting Pad Selects All Events is set to On.

To select a note, tap it.

To select multiple notes, tap and drag across the grid to create a box around them.
To move a note, tap and drag it to another grid square.

To move multiple notes, select them as described above, and tap and drag them.

To erase multiple notes, select them as described above, and then select the eraser tool and tap any
of the selected notes.

Magnifying Glass: Navigation Mode:
®\ To move to another part of the grid, tap and drag it.

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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The Settings window lets you configure certain Grid View settings.

To view the Settings, tap the gear icon.

X SETTINGS

ABSOLUTE

1/16 NOTE

Use the Snap Mode selector to set how events “snap” to the grid.

Absolute: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time
Correct window). This is the typical and traditional method of using the snap/quantization feature.

Relative: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time
Correct window) plus the original time position of the event (e.g., an event that is originally three ticks past a
time division on the grid will snap only to positions that are three ticks past every time division).

Use the Hitting Pad Selects All Events selector to turn the feature on or off. When on, pressing a pad will
automatically select all note events for that pad in the sequence on that track. When off, pressing a pad will simply
play its sound without selecting any note events.

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.

Follow: Depending on the zoom setting, the grid will scroll along in the background while keeping the audio
playhead centered.

Page: The grid will move to the “next page” to follow the audio playhead.
Off: The grid will not move at all.
These functions also apply to Audio Edit Mode, List Edit Mode, and Sample Edit Mode.

Use the Link Zoom and Scroll selector to turn the feature on or off. When on, the zoom and scroll levels in the MPC
software and your MPC hardware will always be the same. When off, the grid views can be adjusted separately using
the MPC software and your MPC hardware.

Note: This setting is only available when connected to MPC software in controller mode.

Use the Q-Link Playhead Increment selector to set the how turning Q-Link Knob 2 (Playhead) in Q-Link Screen
Mode moves the playhead. Select 1/16th-note increments (1/16 Note) or according to the time division (TC
Division).
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DON'T SNAP EDIT START EDITEND TRANSPOSE VELOCITY

Regardless of which tool is selected, you can do any of the following to move, lengthen, shorten, or transpose any
selected note/notes.

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in
the lower-left corner.

To undo your last action, press Undo.
To redo the last action you undid, press Shift+Undo/Redo.
To select all notes for a pad, press the desired pad.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or —/+ buttons
to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time
Correct value (see General Features > Timing Correct (TC) to learn about this).

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold
Don’t Snap in the lower-left corner of the screen, and then use the data dial or —/+ buttons to shift the notes. In
this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start at
the bottom of the screen, and then use the data dial or =/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the
data dial or —/+ buttons.

To copy the selected notes instantly, press Copy. The selected notes will be duplicated and start immediately
after the end of the last selected note. Nudge will be automatically selected so you can immediately use the data
dial to move the copied notes,

To switch to the previous or next track, press and hold Shift, and then tap Track - or Track + (respectively) at
the bottom of the screen.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the
screen.
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To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See
General Features > Timing Correct (TC) to learn about this.

To select a time division directly, double-tap the down arrow (V) in the upper-left corner of the grid and select a
time division.

To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the screen. See
General Features > Metronome (Click/Metro) to learn about this.

The Grid View also contains a velocity/automation lane where you can easily adjust note velocities and automation
parameters.

Velocity

DON'T SNAP NUDGE EDIT START EDITEND TRANSPOSE VELOCITY

The velocity lane in the Grid View.

To show or hide the velocity/automation lane:
1. Tap the up arrow (A) button in the lower-right corner to show the velocity/automation lane.

2. Tap the down arrow (v) to hide the velocity/automation lane.

When viewing velocity in the lane, a vertical bar represents each note’s velocity. The higher and more red the bar is,
the higher the velocity is. Yellow bars indicate a lower velocity. Bars with a gray line at the top indicate a currently
selected note.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data dial
or —/+ buttons. The numeric value will appear on the screen.

See Addenda > Updates in 2.6 > New Features > Grid Automation Lanes for more information on editing
automation parameters.
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Audio Edit Mode

Audio Edit Mode lets you view and edit the audio tracks of a sequence in a project.

AUDIO EDIT

To enter Audio Edit Mode, press Menu, and then tap Audio Edit Mode.

Note: The Audio Edit option is available when the currently selected track is an audio track. When a MIDI track is
selected, it will show an icon for Grid View instead of Audio Edit Mode. To select an audio track (and enable Audio
Edit Mode), press Main to enter Main Mode, and then tap Audio in the lower-left corner.
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Audio Edit Mode with channel strip hidden.
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Audio Edit Mode with channel strip shown.
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Below is a brief step-by-step process so you can get started recording audio tracks quickly. Continue reading the
rest of this chapter to learn how to use Audio Edit Mode in different cases.

Audio 001 ([ XN SR O On
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Input 1,2
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PRG: Volume

Audio 001 R | i 3008

« w 0 116,00

DON'T SNAP EDIT START EDITEND SPLIT DUPLICATE

To record in Audio Edit Mode (or Main Mode):

1.
2.

11.

If the channel strip is not already shown on the left side of the screen, tap the small eye icon to show it.

Connect a synthesizer or other line-level audio source to the appropriate input/inputs of your MPC hardware. Set
the Line/Phono selector appropriately, too.

Double-tap the first field to select the input source of the external audio signal, which you can set to a pair of
inputs (Input 1,2-3,4 in Standalone Mode, Input 1,2-31,32 in Controller Mode) or a single input (Input 14 in
Standalone Mode, Input 1-32 in Controller Mode) (MPC One does not use Inputs 3,4 but displays them to
maintain compatibility with MPC X, MPC Live and MPC Touch, which do use them).

Double-tap the second field to select where the track is routed (Out 1,2-7,8 and Submix 1-8 in Standalone
Mode, or Out 1,2-31,32 in Controller Mode; MPC Live does not use Out 7,8 and MPC One does not use Out
3,4-7,8 in Standalone Mode, but displays them to maintain compatibility with MPC X, which does use them).

Tap the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states:
When set to Auto, you will hear incoming audio while the track is record-enabled only.
When on, you will hear incoming audio whether or not the track is record-enabled.
When off, you will never hear any incoming audio.

Turn the 3/4 Rec Gain knob (MPC X) or Rec Vol knob (MPC Live, MPC One, MPC Touch) to set the input level
while sending an audio signal into your MPC hardware. You should now see the level in the meter. Make sure it
does not exceed the maximum level (the meter should not be “peaking” constantly).

If Mute and Solo are on, tap or press them so they are off. We also recommend tapping the automation button
so it is off/gray (not green/Read [R] or red/Write [W]). Alternatively, press Read/Write so it is off (MPC X).

Tap the Rec Arm button next to the pan knob or press Rec Arm (MPC X) to record-enable the track.

Press Rec to record-arm the sequence.

. To start recording, press Play or Play Start—then play your audio source. You should hear your existing

sequence playing in the background. You’ll see the waveform appear as a single “track region” as you record.

To stop recording, press Stop.
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The top of the screen shows the track name, sequence and timing information, and editing tools.

\Vocals 1

Use the Track field to select which track of the current sequence you want to show in the grid.

Use the Bars field to set the length of the sequence.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the
modes. See General Features > Time Counter/Locate to learn about this.

In Audio Edit Mode, these seven tool icons enable you to use different functions in the track.

Tap one to select its mode:

Marquee: Marquee Mode:
To select a track region, tap the upper third of it.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To split the track at two specific points (creating a track region on either side and between them), tap and
drag across the middle third of it to create a translucent white box, and then tap the upper third of that box.

To shorten or lengthen a track region (or multiple selected track regions), tap and drag the lower third
of it left or right.

Arrow: Selection Mode:
k To select a track region, tap it.
To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To shorten or lengthen a track region (or multiple selected track regions), tap its edge and drag it.
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Pencil: Draw Mode:

To enter a note in an empty grid square, tap the grid square.

To select a note, tap it.
To move a note, tap and drag it to another grid square.

To erase a note, double-tap it.

Eraser: Erase Mode:
To select multiple track regions, tap and drag across the grid to create a box that highlights them.

To erase a track region (or multiple selected track regions), tap it.

Scissors: Split Mode:

To split the track at a specific point (creating a track region on either side), tap that point in the track.

kS

To select a track region, tap its left-most edge.

To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

Mute: Mute Mode:

3

To select multiple track regions, tap and drag across the grid to create a box that highlights them.
Double-tap the selected track regions to deselect them.

To mute or unmute a track region (or multiple selected track regions), tap it.

Magnifying Glass: Navigation Mode:

To move to another part of the track, tap and drag it.

B

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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The Settings window lets you configure certain Audio Edit Mode settings.

To view the Settings, tap the gear icon.

{3 SETTINGS

ABSOLUTE

1/16 NOTE

Use the Snap Mode selector to set how events “snap” to the grid.

Absolute: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time
Correct window). This is the typical and traditional method of using the snap/quantization feature.

Relative: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time
Correct window) plus the original time position of the event (e.g., an event that is originally three ticks past a
time division on the grid will snap only to positions that are three ticks past every time division).

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.

Follow: Depending on the zoom setting, the waveform display will scroll along in the background while keeping
the audio playhead centered.

Page: The waveform display will move to the “next page” to follow the audio playhead.

Off: The waveform display will not move at all.

These functions also apply to the sample waveform in Sample Edit Mode.

Use the Link Zoom and Scroll selector to turn the feature on or off. When on, the zoom and scroll levels in the MPC
software and your MPC hardware will always be the same. When off, the grid views can be adjusted separately using
the MPC software and your MPC hardware.

Note: This setting is only available when connected to MPC software in controller mode.

Use the Q-Link Playhead Increment selector to set the how turning Q-Link Knob 2 (Playhead) in Q-Link Screen
Mode moves the playhead. Select 1/16th-note increments (1/16 Note) or according to the time division (TC
Division).
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On the left edge of the screen, next to the five mode icons, there are two small
icons that control the channel strip.

To show or hide the channel strip, tap the eye icon.

The channel strip contains some important settings for the audio track or master
output, depending on the currently selected icon:

To view the track channel strip, tap the waveform icon.

To view the master channel strip, tap the crown icon.

When viewing the track channel strip while using an audio track:

The first field defines the input source of the external audio signal, which you
can set to a pair of inputs (Input 1,2-3,4 in Standalone Mode, Input 1,2-31,32
in Controller Mode) or a single input (Input 1-4 in Standalone Mode, Input 1-
32 in Controller Mode).

The second field shows where the track is routed, which you can change: Out
1,2-7,8, Out 1-8 or Sub 1-8 in Standalone Mode; and Out 1,2-31,32 or Out
1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed
post-pan knob. If the pan knob is set to the center position, the left and right
channels will be summed and padded. If the pan knob is set to the maximum
left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that track. Tap the
area under Inserts to open a window where you can load, change, and enable
or disable the effects.

Tap Solo or Mute to solo or mute the track (respectively).

Tap the Monitor button to set how your audio track will be monitored. Tapping
it will cycle through its three states:

When set to Auto, you will hear incoming audio while the track is record-
enabled only.

When on, you will hear incoming audio whether or not the track is record-
enabled.

When off, you will never hear any incoming audio.
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Tap the track automation button or press Read/Write (MPC X) to cycle
through its three states:

When off, the audio track will ignore automation data. If you have already
recorded or entered automation, tapping this will switch between Read (R)
and Write (W) only, but you can override this and turn it off by pressing and
holding Shift while pressing or tapping the button.

Important: If you have already recorded automation and turn it off, the
track will still use the effect and its parameter values at the point where you
turned it off.

When set to Read (R), the audio track will read automation data but will not _
record any additional automation over it. (Think of this as a protective
feature to prevent accidental changes to your automation while recording.)

When set to Write (W), the audio track can record automation. (If you have _

any Q-Link knobs assigned to automatable parameters, make sure not to
touch any accidentally while you are recording.)

Tip: You can quickly set all programs and audio tracks to the same
automation by tapping the global automation button in the upper-right corner
of the screen. See General Features > Automation to learn about this.

To change the panning or level of the track, adjust the pan knob or level
slider.

To record-enable the track, tap the Record Arm button or press Rec Arm
(on MPC X when the track name is shown in the display strip below the level
meters). When you begin audio recording, the audio signal will be recorded to
this track.

Tip: You can select multiple tracks in the Track View by pressing and holding
Shift while tapping the Arm button to each track.

When viewing the master channel strip:

The first field shows the current master output as a stereo pair (which you can - .
change). 1 Outputs 1/2

The Inserts field shows any enabled or disabled effects for that pair of outputs.
Tap the area under Inserts to open a window where you can load, change, and
enable or disable the effects.

Tap Mute to mute the master output.

Adjust the pan knob or level slider to change the panning or level of the
master output.
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Regardless of which tool is selected, you can do any of the following to edit the selected audio track regions.
Tip: If you want to hear only the audio track while editing, use the Solo button in the track channel strip to solo it.

To select a track region, tap the arrow icon to enter Selection Mode and tap a track region. When a track
region is selected, all region parameters will be available to edit.

To undo your last action, press Undo.
To redo the last action you undid, press Shift+Undo/Redo.

To move the selected track region, tap Nudge at the bottom of the screen, and then use the data dial or —/+
buttons to shift the track region left or right. Alternatively, if the arrow tool or marquee tool are selected, tap
and drag the upper third of the selected track region left or right. By default, you can move a track region only by
quantization values defined by the Time Correct value (see General Features > Timing Correct (TC) to learn
about this).

To move the selected track region without restricting (“snapping”) it to the quantization grid, tap and hold
Don’t Snap in the lower-left corner of the screen, and then use the data dial or —/+ buttons to shift the track
region. In this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected track region (without changing its position), tap Edit
Start at the bottom of the screen, and then use the data dial or —/+ buttons.

To split the track at the current playhead position (creating a track region on either side), tap Split at the
bottom of the screen.

14 2

To copy, cut, or paste the selected track region, Frr==== — — A A P,
press Copy or press and hold Shift, and then tap :
Copy or Cut. Turn the data dial to move the ) * * *
highlighted track region, and then press the data ‘ ‘ | !

dial, or the center cursor or Enter (MPC X), to paste

it at its current location. Alternatively, press and hold
Shift, and then tap Paste (respectively).

M%W o

To cut, copy, or paste the selected track region,
press and hold Shift, and then tap Cut, Copy, or
Paste (respectively) at the bottom of the screen.

To duplicate the selected track region, tap Duplicate at the bottom of the screen. The duplicate track region
will appear immediately after the original one.

To create a fade-in or fade out for the selected track region, use the Fade In or Fade Out fields, respectively.
The fades will be shown as a sloped line at the start or end of the track region.

To set the level of the selected track region, use the Level field. The waveform amplitude will change accordingly.
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To reverse the selected track region, tap Reverse.

To mute the selected track region, tap Mute. ‘

mellowbopEbPP1
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To lengthen or shorten the selected track region without changing its pitch, tap Warp, which will enable the
Semi, Fine, and BPM fields next to it. Use the BPM field to change the tempo, which will change the length of
the track region accordingly. Use the Semi and Fine fields if you want to change the pitch (this is useful for
matching the durations of two samples with different pitches).

Tip: You can configure audio track recording to ensure the resulting track region is warped automatically. You can
then adjust the sequence tempo while track region remains in time. See Menu > Preferences > General to learn
about this.

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is
stored within the sample file when you save the project. When you warp an audio track region, the warping
algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.”

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required
by doing any/all of the following:

Minimize the amount of pitch adjustment (e.g., the Semi and Fine fields).
Avoid warping very small track regions.

Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices [of the
polyphonic limit] that use the warp algorithm at a given time), especially instances where the warped regions
start at the same time.

If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate
the affected pad’s layers into one audio sample (see here to learn about this). After you flatten the pad, its
sample/samples no longer need to be warped.

To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See
General Features > Timing Correct (TC) to learn about this.

To switch to the previous or next track, press and hold Shift, and then tap Track - or Track + (respectively) at
the bottom of the screen.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the
screen.

To edit automation for the track, open the automation lane. See Addenda > Updates in 2.6 > New Features >
Grid Automation Lanes for more information.
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Track View

Track View gives you an overview of the tracks of each sequence. Use this mode to edit tracks
and sequences simultaneously.
TRACK VIEW
To enter the Track View, do either of the following:
e Press Menu, and then tap Track View.

e Press Shift+Main/Track (MPC X, MPC Live, MPC Touch).

Sequence 01

Drums

Program 001

Bass

Synth 01

Synth Pad
Midi 001

Each horizontal strip represents a track in the current sequence. MIDI tracks and audio tracks are grouped together.
MIDI tracks are listed first, audio tracks are listed second.

To move through the list of tracks, swipe up or down.

To collapse or expand each group of tracks, tap the up arrow (A) or down arrow (V) icon above the first
track’s Mute button.

The top of the screen shows the sequence name and timing information.

Sequence 01

Use the Sequence field to select which sequence contains the tracks you want to show below.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the
modes. See General Features > Time Counter/Locate to learn about this.
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The Settings window lets you configure certain Track View settings.

To view the Settings, tap the gear icon.

X seTTINGS

Use the Show Unused Tracks selector to turn this feature on or off. When on, tracks with a sequence, program, etc.
will still appear in the Track View. When off, only tracks with a sequence, program, etc. will appear.

To open the Timing Correct settings, tap TC at the bottom of the screen. See General Features > Timing Correct
(TC) to learn about this.

To open the metronome settings, tap Click at the bottom of the screen. See General Features > Metronome
(Click/Metro) to learn about this.

To select the previous or next track of the same type (MIDI or audio), tap Track - or Track + (respectively) at the
bottom of the screen. Alternatively, tap the track in the main part of the screen.

152



MIDI Tracks

All MIDI tracks in the project are grouped together in the upper half of the Track View.

To show or hide them, tap the A or ¥ arrow icon.

Use the Program field to select the program that the track will use.

Use the Length field to set how long the track is. If you select the minimum value, Seq or 0 (if you use the numeric
keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence
repeatedly under a 4-bar bass line.

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the
track will be played with half the velocity it was originally played. When set to 200%, the track will play twice as loud.
The maximum velocity level is still 127, though.

Use the Transpose field to set the transposition (in semitones) of the entire track.

Use the level slider to change the level of the track. The level meter above the slider shows the track’s current level.

Use the pan knob to change the panning of the track.

Use the Solo and Mute buttons to solo or mute the track (respectively).

Alternatively, tap Mute or Solo (respectively) at the bottom of the screen to mute the currently selected track.
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Audio Tracks

All audio tracks in the project are grouped together in the lower half of the Track View.

To show or hide them, tap the A or ¥ arrow icon.

Audio 001

Input 1,2

Use the Input field to set the track’s input/inputs.

Use the Arm button to record-enable the track. When you begin audio recording, the audio signal will be recorded to
this track. You can select multiple tracks by pressing and holding Shift while tapping the Arm button to each track.

Use the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states:
When set to Auto, you will hear incoming audio while the track is record-enabled only.
When on, you will hear incoming audio whether or not the track is record-enabled.

When off, you will never hear any incoming audio.

Use the level slider to change the level of the track. The level meter above the slider shows the track’s current level.

Use the pan knob to change the panning of the track.

Use the Solo and Mute buttons to solo or mute the track (respectively).

Alternatively, tap Mute or Solo (respectively) at the bottom of the screen to mute the currently selected track.

Use the Add new audio track button to create a new audio track.
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Step Sequencer

The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,”
simulating the experience of a traditional step-sequencer-style drum machine. This is

available for MIDI tracks only, not audio tracks.
STEP SEQUENCER

You can also create and edit automation using the Step Sequencer. See Addenda >
Updates in 2.6 > New Features > Step Automation for more information.

To enter the Step Sequencer, do either of the following:
e Press Menu, and then tap Step Sequencer.
e Press Step Seq (MPC X, MPC One).

il Drums Sequence 77.60 (=)

A01

2 Velocity 32

PAD SEL

The top of the screen shows the track name and information as well as sequence and timing information.

Sequence

The Track field shows the name of the current track.

Use the Track Length field to set how long the track is. If you select the minimum value, Sequence or 0 (if you use
the numeric keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence
repeatedly under a 4-bar bass line.

Use the Bars field to adjust the length of the sequence in bars.
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Use the BPM field to adjust the tempo of the sequence.

To set whether the sequence follows its own tempo (Seq) or a master tempo (Mst), tap the

Seq/Mst button next to the BPM field. Alternatively, press Shift+Tap/Master. 126.02 (a)

80.79

The time counter at the top of the screen indicates the current playhead position. This is shown in
most of the modes. See General Features > Time Counter/Locate to learn about this.

Use the Time Division selector to set the value that determines how many steps each bar of the sequence will have.
The T indicates a triplet-based value.

Alternatively, tap TC at the bottom of the screen to open the Timing Correct window. See General Features >
Timing Correct (TC) to learn about this.

ol Drums Sequence 7760 &=

AD1

2 Velocity 52

PAD SEL

To enter or delete steps in a sequence:

1.

Use the Pad -/+ buttons at the bottom of the screen to select the pad whose steps you want to enter or delete.
The current pad number is shown in the upper-left corner.

Alternatively, use the Pad Select feature: Tap and hold Pad Sel, press the desired pad, and then release Pad
Sel. You can also use Pad Select as a “latching” feature: tap Pad Sel so it is activated, press the desired pad,
and then tap Pad Sel once more so it is deactivated.

Use the Bar —/+ buttons at the bottom of the screen to select the bar of the sequence whose steps you want to
enter or delete. The current bar number is shown in the upper-left corner.

Press the pads of your MPC hardware, or tap a button at the bottom of the sequencer. Each pad corresponds to
a step in the bar and will light with a color corresponding to its velocity.

Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In
this case, use Pad Bank Buttons A and B to view all the steps within a bar.

For time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In
this case, use the left and right arrows (< and >) by the step numbers (1-16, 17-32, etc.) to 1-16
change which steps are shown in the sequencer.

Alternatively, use Pad Bank Buttons A and B.
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To adjust the velocities of the steps, do any of the following:

Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point.

Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.

Turn the Q-Link knob that corresponds to that step (the Q-Link knobs must be in the Screen edit mode).

Setting a value of 0 (Off) will delete the step.

Use the Nudge < and Nudge > arrows to shift each step left or right (respectively) one step. This is useful for
experimenting with different rhythmic permutations.

Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.

Use the Flip Steps button to switch which steps have notes entered and which do not have notes.
Steps that previously had no notes will now have notes at full velocity (127). Steps that previously had
notes will now be empty.

Tap Presets to show or hide the preset sequence controls. These controls let you manipulate and
transform the velocities of the current bar in the sequence.

The first button will apply ascending or descending velocities to the steps. Each time you tap it, it will
cycle through these options:

The velocities will ascend to a single peak at the end of the bar.

The velocities will ascend to two peaks—one after each half of the bar.
The velocities will ascend to four peaks—one after each quarter of the bar.
The velocities will descend from a single peak at the start of the bar.

The velocities will descend from two peaks—one after each half of the bar.

The velocities will descend from four peaks —one at the start each quarter of the bar.

The second button will set the velocities of the steps to be at the maximum value (127) or minimum
values (1), depending on their position in the bar. Each time you tap it, it will cycle through these options:

The velocities of the first half of the bar will be set to 1. The velocities of the second half will be
set to 127.

The velocities of the first and third quarters of the bar will be set to 1. The velocities of the
second and fourth quarters will be set to 127.

The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The
velocities of the second, fourth, sixth, and eighth eighths will be set to 127.

The velocities of the first half of the bar will be set to 127. The velocities of the second half will
be set to 1.

The velocities of the first and third quarters of the bar will be set to 127. The velocities of the
second and fourth quarters will be set to 1.

The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The
velocities of the second, fourth, sixth, and eighth eighths will be set to 1.
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The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will
cycle through these options:

Across the entire bar, the velocities will ascend to a peak and then descend from it.
In each half of the bar, the velocities will ascend to a peak and then descend from it.
In each quarter of the bar, the velocities will ascend to a peak and then descend from it.

Across the entire bar, the velocities will descend from a peak into a valley and then ascend back
up to the peak.

In each half of the bar, the velocities will descend from a peak into a valley and then ascend back
up to the peak.

In each quarter of the bar, the velocities will descend from a peak into a valley and then
ascend back up to the peak.

The fourth button will swap the first half and second half of the bar. In other words, the first half of the
bar will become a mirrored image of the second half, and vice versa.

The fifth button will invert the velocities of all steps with entered notes. The sum of the old and new
velocities will equal 127. The exception is a velocity of 127 or 1 as a step with a note cannot have a
velocity of 0.

Examples:

Steps with velocities of 40 will now have velocities of 87, and vice versa.

Steps with velocities of 75 will now have velocities of 52, and vice versa.

Steps with velocities of 127 will now have velocities of 1, and vice versa.
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XYFX Mode

XYFX Mode turns the touchscreen into an XY pad where each axis represents the range of an effect
parameter. As you move your finger on the XY pad, the current position will determine the current value
of the two parameters. You can use this mode to create interesting effect automation on your tracks.

The effect you control in XYFX Mode acts like an insert effect on that program. In fact, XYFX is the
name of the insert effect you have to load to the program before you can use this mode. Learn more
about this in General Features > Effects.

To enter XYFX Mode, do any of the following:
e Press Menu, and then tap XYFX.
e Press XYFX (MPC X) or Shift+Next Seq/XYFX (MPC One)

X

Outputs 1/2

HPF Manual

When you first enter this mode in a project, you may be prompted to load XYFX to the program. Tap Insert XYFX to
do this.

Note: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing this.

Use the XYFX Location field to select the signal to which the effects will be applied: the current program (Program)
or a master output (a stereo pair of channels: Output 1/2, Output 3/4, etc.).

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See
General Features > Time Counter/Locate to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.
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Touch or move your finger on the gridded part of the screen. A marker will follow your finger to indicate the current
position. The X axis is the horizontal axis, increasing in value as you move right. The Y axis is the vertical axis,
increasing in value as you move up. Each axis is labeled with its assigned parameter.

When an effect has a beat division parameter, the current division will be highlighted as an entire column.

Effects are differently colored for easy visual distinction: beat-synchronized effects are blue, while manually
controlled effects are green.

X

Outputs 1/2

. Beat Repeat LPF

XY Mode with a beat-synchronized effect.

While touching the XY pad, tap Latch in the lower-left corner to keep the marker on the XY pad even after you
release it. The marker will remain there until you touch another part of the XY pad or until you tap Latch again.

Use the Setup button to show or hide the Setup panel, which controls how the XY pad behaves.

Use the Preset field to select the effect you want to use in XYFX Mode.
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X

Outputs 1/2

HPF Manual

XY Mode with a manually controlled effect.

Use the Attack knob to set the length of the attack phase of the envelope, which is triggered when you touch the XY
pad. In other words, this determines how long it takes the effect to fully respond to your touch.

Use the Release knob to set the length of the release phase of the envelope, which is triggered when you release the
XY pad. In other words, this determines how long it takes the effect to fully deactivate after you stopping touching
the XY pad.

Use the Wet/Dry knob to set the blend the original signal (dry) and the effect signal (wet).

The X Axis and Y Axis fields show which parameters are controlled by each axis. This varies depending on the effect
you are using.
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Sample Edit Mode

Sample Edit Mode lets you edit samples using various functions.

SAMPLE EDIT

To enter Sample Edit Mode, do any of the following:
¢ Press Menu, and then tap Sample Edit.
¢ Press Sample Edit (MPC X, MPC One).

1980HatOp

35385

109,89

PROGRAM = ASSIGN PROCESS

To select a sample to edit, do any of the following:
e Use the Sample field at the top of the screen.

¢ In Main Mode, tap the Project field at the top of the screen, and then double-tap a sample in the list on the
right side.

¢ In the Browser, tap the Project button with the P/page icon at the bottom of the screen, and then double-
tap a sample in the list on the right side.

To edit the name of the sample, tap the keyboard icon next to the name at the top of the screen, and use the
virtual keyboard that appears.

To delete the sample, tap the trash-can icon next to the name at the top of the screen. In the screen that appears,
you will see the programs that use this sample within your project. Tap Delete Sample to continue, or tap Cancel to
return to the previous screen.

162



The upper half of the screen shows the waveform. The lower half shows the editing controls.

1980HatOp

35385

PROGRAM = ASSIGN PROCESS

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to
move through it.

Above the waveform is the timeline, shown in Samples, Time (in seconds and milliseconds), or Beats. You can
select the measurement units you want to show in the Settings.

To zoom in or out, do any of the following:

e When the magnifying-glass icon (in the upper-right corner) is selected, spread or pinch your fingers
(respectively) on the waveform.

e Tap the Zoom + or Zoom - buttons (respectively) at the bottom of the screen.

e Turn Q-Link Knob 4 (Zoom on MPC X) or the fourth Q-Link knob in the fourth column (MPC Live, MPC One,
MPC Touch).

To scroll through the waveform, do either of the following:
o When the magnifying-glass icon (in the upper-right corner) is selected, swipe the waveform left or right.

e Turn Q-Link Knob 8 (Scroll on MPC X) or the third Q-Link knob in the fourth column (MPC Live, MPC One,
MPC Touch).

The green marker and red marker are the start point and end point (respectively). These two points define the region
of the sample that will be played.

To move the start point or end point of the selected region, do any of the following:
e Tap and drag its marker left or right.
e Use the Start or End fields shown below the waveform.

e Use the first column of Q-Link knobs (Start X1__) to adjust the start point or the second column of Q-Link
knobs (End X1_) to adjust the end point. The top-most Q-Link knobs (13 and 14) provide coarse
adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in
a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or
unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can
enhance your production or performance.

You can use Sample Edit Mode in three different ways: Trim Mode, Chop Mode, or Program Mode. The options for
each mode are slightly different. Please refer to the following Trim Mode, Chop Mode, and Program Mode parts of
this chapter to learn how each works. Before using these modes, though, you may want to configure your settings—
see the following Settings chapter to do this.
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Settings

The Settings window lets you configure certain Sample Edit Mode settings.

To view the Settings, tap the gear icon.

{3 setTinGs

TOGGLE

il SAMPLES

Use the Cue Play Mode selector to set how the cue playhead will play audio.
One Shot: Tapping Play Cue will play the entire sample from the cue playhead.
Toggle: Tapping Play Cue once will start playback from cue playhead. Tapping it once more will stop playback.

Use the Cue Preview selector to set if any audio plays as you move the cue playhead. As you move the cue
playhead through the sample waveform, you can set it to play the small part of the sample before the cue playhead
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set this
in your overall Preferences (see General Features > Menu > Preferences > General).

Use the Slice Preview selector to set if any audio plays as you move a slice marker. As you move the slice marker
through the sample waveform, you can set it to play the small part of the sample before the slice marker (Before),
play the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in your
overall Preferences (see General Features > Menu > Preferences > General).

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.

Follow: Depending on the zoom setting, the waveform will scroll along in the background, keeping the audio
playhead centered.

Page: The waveform display will move to the “next page” to follow the audio playhead.
Off: The waveform display will not move at all.

These functions also apply to the sample waveform in the Grid View.

Use the Timeline Units selector to set the measurement units shown above the sample waveform. You can select
one of the following options:

Time: hours:minutes:seconds:frames
Samples: number of samples

Beats: bars:beats:ticks
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Trim Mode

We recommend using Trim Mode to crop the start and/or ends from a sample.

To enter Trim Mode, tap the Trim/Chop button in the lower-left corner so it says Trim.

12070 40367

0.00 105.49

TRIM PROGRAM - ASSIGN PROCESS

Use the Start and End fields to set the position of the start point and end point of the sample (respectively).
Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs (Start
X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point.

Trim Mode includes a loop function. When on, the region of the sample between the loop point and end point will repeat.
This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:
e Use the Loop field.
e Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off).

e Use the first column of Q-Link knobs (Start X1__; if Loop Lock is on) or the third column of Q-Link knobs
(Loop X1__; if Loop Lock is off). The top-most Q-Link knobs (13 and 15) provide coarse adjustment. The
bottom-most Q-Link knobs (1 and 3) provide fine adjustment.

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point.
When off, the loop point is independent from the start point and indicated by a separate loop marker.

To turn the loop function on or off, tap the Loop button to cycle between the four modes:
Off: The sample will not loop.
Forward: When the loop reaches its end point, it will start playing again from the loop point.

Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will
return to the end point and continue playing in reverse.

Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it
will start playing forward again from the loop point.

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the screen.

Use the X-Fade button to apply a crossfade to a looping sample. See Addenda > Updates in MPC 2.3 > New
Features > Crossfade Looping for more information about this.
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Use your MPC hardware pads to play certain parts of the selected sample:

Play to Loop Play from Play Loop
Play Loop Start Loop Start Continuous
13 14 15 16
Play Sample Play Sample
Play All No function
(One Shot) (Note On)
09 10 11 12
Play from Play to Play to Play from
Start Start End End
(Note On) (Note On) (Note On) (Note On)
05 06 07 08
Play from Play to Play to Play from
Start Start End End
(One Shot) (One Shot) (One Shot) (One Shot)
01 02 03 04

Play Sample (One Shot) (Pad 10) plays the sample once from the start point to the end point. Press the pad
once to play it.

Play Sample (Note On) (Pad 11) plays the sample once from the start point to the end point. Press and hold the
pad to play it, and release the pad to stop playing it. Alternatively, select the headphones icon in the upper-right
corner, and then tap and hold your finger on the waveform.

Play Loop Continuous (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward,
Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly).

Play Loop (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or
Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it,
and release the pad to stop playing it.

Play to Loop Start (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to
play it, and release the pad to stop playing it.

Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample regardless of the
end point. Press and hold the pad to play it, and release the pad to stop playing it.

Play All (Pad 9) plays the entire sample.

Pads 1-4 have the same respective functions as Pads 5-8, but Pads 14 play the sample part as “One Shots”
(pressing the pad once will play the entire part) while Pads 5-8 play the sample part as “Note Ons” (pressing the pad
and holding it will play the part; releasing it will stop playback):

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point.

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point.
Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point.

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample.
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Use the Tune field to transpose the sample up or down from its original pitch.

B EDITTUNING

Audio 002 Rec1
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TO SEQUENCE

Tap From BPM to open the Edit Tuning window, which lets you tune a sample to the current sequence.
Use the Beats field to match the number of beats in the sequence.

To tune the sample to the sequence, tap Match. The Tune field will adjust automatically and close the
window. The sample is now tuned to the sequence.

To tune the sample to the sequence and adjust the sequence tempo, tap To Sequence. This is the same as
tapping Match but it also changes the sequence’s tempo to the BPM shown in the Tempo field on the right.

To close the window, tap Close.

B epmsem

DETECT TAP TEMPO

To enter a tempo manually, use the BPM field.

To detect the tempo automatically, tap Detect. In the Edit BPM window that appears, you can do any of the following:
e Use the BPM field to enter a tempo manually.
e Tap Detect to detect the tempo automatically.

e Tap Tap Tempo at the bottom of the screen at the desired rate to use it as the tempo. You can play a
sequence in the background to help with your timing.

o Tap Close, the X, or anywhere outside the window to close it.
Note: Before detecting tempo, it is recommended that you Normalize samples for best results.
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Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original
pitch when in a keygroup program.

To select a slice to edit, do either of the following (after you have created slices in Chop Mode):
e Use the Slice field.

e Turn Q-Link Knob 16 (Select Slice on MPC X) or the fourth Q-Link knob in the fourth column (MPC Live,
MPC One, MPC Touch).

When Link Slices is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also
change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point
of the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample.

To enable or disable this feature, tap the Link Slices button.
Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can
help to avoid clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the screen. This
switches the loop function between Forward and off. The loop function is described earlier.

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This
allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the
slice. You can easily switch between Trim Mode and Chop Mode while doing this.

To use both Trim Mode and Chop Mode to edit a sample slice:
1. Tap Trim/Chop at the bottom of the screen so it says Chop.
2. Set all fields as desired to create your sample slices.

3. Select the desired slice.
4

Tap Trim/Chop at the bottom of the screen so it says Trim. The region you are now editing is indicated by the
normal start point and end point markers rather than slice markers.

5. Tap Trim/Chop at any time to return to Chop Mode.
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Assigning Samples

You can assign your new sample directly to a pad from Trim Mode.
To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the
pad will simply refer to the slice in this sample instead of #i ASSIGN SAMPLE
creating a new sample. This is useful for reducing clutter in
your project.

Assign slice to pad

AO1
Use the Pad field to select the desired pad. Alternatively,
press the desired pad- Non-destructive slice

Drums
Use the Slice Type field to select how the pad’s layer
settings will be set when the slice is assigned to it (see
Program Edit Mode to learn more about the
parameters mentioned below):

Non-Destructive Slice: The pad’s Slice setting
will be set to the slice number.

Pad Parameters: The pad’s Slice setting will be
set to Pad. The Pad Start and Pad End will be set
to the slice’s start point and end point values, and
the Loop Position will be set to the slice’s start
point but with Pad Loop deactivated.

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.

To cancel the operation, tap Close, the X, or anywhere
outside the window.
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If you set the Assign To field to Make new sample, this
will create a new sample in your project. (The original
sample will remain as it is.)

:"::!Il ASSIGN SAMPLE

Make new sample

Use the Pad field to select the desired pad. Alternatively,
press the desired pad.

Check the Crop Sample box to delete the unused
parts from the sample when it’s created and assigned.
This feature is destructive, though the project will still
contain your original sample.

Leave this box unchecked to keep the unused parts of
the sample when it is created and assigned. This way,
you will still be able to edit the entire sample further
even though you are using only part of it at the moment.

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.

To cancel the operation, tap Close, the X, or anywhere
outside the window.
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Processing Slices & Samples

Tap the Process button to open the Process window, where you can select an editing option for the sample.

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to
open the Function window, which displays an overview of all available editing processes.

& SELECT FUNCTION

Fimy]  SLICE

.| . o x
DISCARD DELETE SILENCE EXTRACT

it &2 | ([
NORMALIZE REVERSE FADE IN FADE OUT

LN <& > L D)

PITCH SHIFT TIME STRETCH GAIN CHANGE
e SAMPLE

[ a»

BIT REDUCE STEREO -> MONO

CANCEL

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All Slice processes will affect only the part of the sample between the start point and the end point. The Sample
processes (Bit Reduce and Stereo -> Mono) will affect the entire sample regardless of its start point or end point.

The Discard process deletes the regions before the start
point and after the end point. fin] PROCESS SLice

Discard

Pressing 'Do It' will discard the data
beyond the START and END points

FUNCTION CANCEL
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The Delete process deletes the region between the start
point and end point and closes the gap between them.

The Silence process replaces the region between the start
point and end point with silence.

The Extract process deletes the regions before the start
point and after the end point and saves it as a new sample
in your current project.

Use the Edit Name field (and the virtual keyboard that
appears) to name the new sample.

Tip: This is useful if you recorded a drum loop and wanted
to remove just a snare drum hit, a kick drum hit, etc. to use
separately in the project.

The Normalize process increases a sample’s level to the
highest level possible without distortion. This is essentially
a kind of digital gain optimization, so you do not have to
worry about excessive level settings when working with
samples with a wide range of amplitudes.

fily] - PROCESS SLICE

Delete

Pressing 'Do It' will delete the section
between the START/END points.

FUNCTION CANCEL

Filn] PROCESS SLICE

Silence

Pressing 'Do It' will silence the section
between the START/END points.

FUNCTION CANCEL

fily) - PROCESS SLICE

Extract

NEW SAMPLE

Audio 002 Rec2

FUNCTION CANCEL

Filn] - PROCESS SLICE

Normalize

FUNCTION CANCEL
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The Reverse process reverses the region between the
start point and end point. finj - PROCESSsLICE

Reverse

[T

FUNCTION CANCEL

The Fade In process sets a fade-in between the start point
and end point. The following types are available: i PROcESSSLICE

Linear fades the audio in with a linear curve—a
straight line between the start and end. Fade In

Log fades the audio in with a logarithmic curve —quickly N\,\NWUWW
rising at the start and flattening out towards the end.

Exp fades the audio in with an exponential curve—
slowly rising in the beginning and growing steeper

Pressing 'Do It' will put a fade in
tOWardS the end' between the START/END points.

FUNCTION CANCEL

The Fade Out process sets a fade-out between the start

point and end point. The following types are available: ] PROCESS Stice
Linear fades the audio out with a linear curve—a
straight line between the start and end. et AT
Log fades the audio out with a logarithmic curve— UWW\N\;\/\M;
quickly rising at the start and flattening out towards the
end.
Exp fades the audio out with an exponential curve— T )
slowly rising in the beginning and growing steeper b e

towards the end.

FUNCTION CANCEL

The Pitch Shift process changes the pitch of the sample
without changing its length. This lets you set the sample’s fin] - PROCESS SLICE
pitch to your sequence without affecting the sample’s
tempo or duration. You can adjust it up to 12 semitones, Pitch Shift
up or down. Keep in mind that the audio quality may
decrease at more extreme settings.

FUNCTION CANCEL
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The Time Stretch process lengthens or shortens the
sample without changing its pitch. This is useful for
matching the durations of two samples with different
pitches. You can enter the original tempo of the sample
and the desired tempo after processing.

Use the Beat field to set the desired value number of
beats.

Use the New Tempo field to set the new tempo. The
Ratio field will then automatically show the time
stretch factor.

Alternatively, to adjust the ratio instead, use the Ratio
field to set the desired ratio. The New Tempo field will
then change automatically based on the new time
stretch factor.

The Gain Change process raises or lowers the volume of
the sample. You can adjust it up to 18 dB, higher or lower.
This function is different than Normalize because it will
allow volumes beyond clipping level. This may be a
desired effect, but remember to watch your output level!

The Copy process saves a copy of the sample.

Use the Edit Name field (and the virtual keyboard that
appears) to name the new sample. Otherwise, the
process will add a consecutive number after the sample
name.

[illy] - PROCESS SLICE

Time Stretch

Pressing 'Do It' will change the length of the sample

FUNCTION CANCEL

Filn] - PROCESS SLICE

Gain Change

FUNCTION CANCEL

fily) - PROCESS SLICE

Copy

Ly |

NEW SAMPLE

Audio 002 Rec2

FUNCTION CANCEL
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The Bit Reduce process lowers the bit resolution of a
sample, effectively reducing its degree of faithful
reproduction. You can reduce it down to 1 bit. (The sound
is similar to the Resampler effect, but Bit Reduce will
permanently alter the sample.)

Tip: Use this on drum loops to get a dirty, “old-school”
sizzle but with a digital “edge.”

Note: This process affects the entire sample regardless of
its start point or end point.

The Stereo -> Mono process converts a stereo sample to a
new mono sample and saves it as a new sample.

Use the Edit Name field (and the virtual keyboard that
appears) to name the new sample. Otherwise, the
process will add a consecutive number after the sample
name.

The following options are available:
o Left will convert the left channel only.
¢ Right will convert the right channel only.

e Sum will combine the left and right audio channels
to a single mono channel.

Note: This process affects the entire sample regardless of
its start point or end point.

Al PROCESS SAMPLE

Bit Reduce

FUNCTION CANCEL

Al PROCESS SAMPLE

Stereo > Mono

LEFT

Audio 002 Rec2

FUNCTION CANCEL
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Chop Mode

Whereas Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple
regions called slices. We recommend using Chop Mode when working with a long sample with different sounds
throughout (e.g., a drum loop or a long melodic or harmonic passage).

To enter Chop Mode, tap the Trim/Chop button in the lower-left corner so it says Chop.

Loop Drum Minimal
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Use the Start and End fields to set the position of the start point and end point (respectively) of the currently selected
slice. Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs
(Start X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point.

Use the selector in the lower-left corner of the screen to choose how you want to use Chop Mode:

Manual
This method lets you insert slices at locations you select.

Threshold

This method uses an adjustable detection algorithm that derives the number of slices created from the
volume levels present in the sample.

Use the Threshold field to set the threshold level. Alternatively, turn Q-Link Knob 11 (Threshold on MPC X)
or the second Q-Link knob in the third column (MPC Live, MPC One, MPC Touch). The higher the selected
value, the more slices will be created.

Use the Min Time field to set the minimum length of a slice in milliseconds.

Regions
This method divides a sample into several slices of equal length.

Use the Regions field to set how many regions the sample will be divided into. Alternatively, turn Q-Link
Knob 11 (Num Regions on MPC X) or the second Q-Link knob in the third column (MPC Live, MPC One,
MPC Touch). The higher the selected value, the more slices will be created.

BPM
This method divides a sample into several slices based on the tempo (beats per minute).

Use the Bars field to set how many bars are in the sample. Alternatively, turn Q-Link Knob 11 (Bars on MPC
X) or the second Q-Link knob in the third column (MPC Live, MPC One, MPC Touch).

Use the Beats field to set how many beats are in each bar. Alternatively, turn Q-Link Knob 7 (Beats on MPC
X) or the third Q-Link knob in the third column (MPC Live, MPC One, MPC Touch).

Use the Time Div field to set a note division. Alternatively, turn Q-Link Knob 3 (Time Div on MPC X) or the
fourth Q-Link knob in the third column (MPC Live, MPC One, MPC Touch). The slice markers will be placed
according to this setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this
parameter to 1/16.)
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To play a slice, do either of the following:
e Press the pad that corresponds to the slice. If your sample has more than 16 slices, use the additional pad banks.

¢ When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

When the One Shot feature is enabled, you can press a pad once to play the entire slice. When this is disabled,
pressing the pad and holding it will play the slice; releasing it will stop playback.

To enable or disable One Shot, press and hold Shift, and then tap One Shot.

To select a slice to edit, do any of the following:
e Use the Slice field.

e Turn Q-Link Knob 16 (Select Slice on MPC X) or the first Q-Link knob in the fourth column (MPC Live,
MPC One, MPC Touch).

e When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

To add a slice at the current playhead position, tap Slice+ at the bottom of the screen. You can do this at any
point during sample playback.

To insert a slice marker during sample playback, press an unlit pad (usually Pad 1) to start playback of the
sample, and then press an unlit pad during playback to place a slice marker at each location of the playhead. (If you
press a lit pad, playback will restart from that pad’s corresponding slice marker.) The number of the pad that is lit
green is the number of the most-recently inserted slice marker. The numbers of the pads that are lit yellow are the
numbers of the slice markers that are already inserted.

tX  SPLIT/COMBINE REGION

Do you want to

SPLIT THE REGION COMBINE WITH PREVIOUS

r

J

COMBINE

To split or combine slices, tap the glue-and-scissors icon. In the Split/Combine Region screen that appears, tap
one of the following buttons:

Split: This splits the currently selected region into two equal slices.
Combine: This combines the currently selected region with the one before it.

Back: This closes the window.
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When Link Slices is enabled, changing the start point of a slice will also change the end point of the previous slice.
Similarly, changing the end point of a slice will also change the start point of the next slice. Disable Link Slices if you
are trying to create slices that use non-contiguous parts of the sample.

To enable or disable this feature, tap the Link Slices button.

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping.

To remove all slices from a sample, press and hold Shift and tap Clear All.

The cue playhead is useful when manually inserting slice markers. You can set its position and behavior to suit your
workflow.

Use the Cue field to adjust the position of the cue playhead. Alternatively, tap and drag the translucent marker with
the triangle ().

To play the sample from the cue playhead, tap Play Cue at the bottom of the screen.
To create a slice marker at the cue playhead position, tap Slice+ at the bottom of the screen.

To set how the cue playhead behaves, use the Settings window (described earlier).

0 Snap forces start points and end points to occur only at the waveform’s “zero-crossings.” This can help to avoid
clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.
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Converting or Assigning Slices

You can assign your new sample directly to a pad from Chop Mode. You can also convert it into a new program or
patched phrase.

To convert or assign a sample, press and hold Shift, and then tap Convert at the bottom of the screen to open the
Convert or Assign Slices window.

If you set the Convert To field to New [program type]
program using slices, this will create a new program and # CONVERT OR ASSIGN SLICES
assign the sample’s slices to its pads. The pads will simply
refer to the slices in this sample instead of creating new
samples. This is useful for reducing clutter in your project.
The new program will be named after the sample and
appended with ch.

New drum program using slices

Non-destructive slice

Use the Slice Type field to select how each pad’s layer
settings will be set when the slices are assigned to them
(see Program Edit Mode to learn more about the
parameters mentioned below):

CANCEL

¢ Non-Destructive Slice: Each pad’s Slice setting
will be set to the slice number.

o Pad Parameters: Each pad’s Slice setting will be
set to Pad. The Pad Start and Pad End
parameters will be set to the slice’s start point and
end point values, and the Loop Pos parameter will
be set to the slice’s start point but with Pad Loop
deactivated.

Check the Create Events box to automatically create
a new track for the new program in which each pad
plays its corresponding slice in ascending sequence
by pad number.

H Track 04
If Create Events is checked, use the Bars field to set

how many bars the slices’ events will occupy.

To convert the sample, tap Do It.

To cancel the operation, tap Close.

DON'T SNAP NUDGE EDIT START EDITEND TRANSPOSE VELOCITY
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If you set the Convert To field to New clip program, this will
create a new clip program and assign the sample’s slices to
its pads as clips. The pads will simply refer to the slices in
this sample instead of creating new samples. This is useful
for reducing clutter in your project. The new program will be
named after the sample and appended with ch.

Use the Tempo field to enter the tempo of the clips in
the new program.

Check the Create Events box to automatically create
a new track for the new program in which each pad
plays its corresponding slice in ascending sequence
by pad number.

If Create Events is checked, use the Bars field to set
how many bars the slices’ events will occupy.

To convert the sample, tap Do It.
To cancel the operation, tap Close.

If you set the Convert To field to New program with new
samples, this will create a new sample from each slice and
assign them to pads in a new program.

The new program will be named after the sample and
appended with ch. The new samples will be appended with
SI-# (where # is a consecutive number).

Check the Crop Samples box to delete the unused
parts from the sample when they are created and
assigned. This feature is destructive, though the
project will still contain your original sample.

Leave this box unchecked to keep the unused parts of
the samples when they’re created and assigned. This
way, you will still be able to edit the entire samples
further even though you are using only part of them at
the moment.

By default, this option already will create a new
program. You can uncheck the Create New Program
box to convert each slice into a sample that is placed
in the project’s sample pool but not assigned to a
program or pad.

If Create New Program is checked, check the Create
Events box to automatically create a new track in which
each pad plays its corresponding slice in ascending
sequence by pad number.

If Create Events is checked, use the Bars field to set
how many bars the slices’ events will occupy.

To convert the sample, tap Do It.
To cancel the operation, tap Close.

ﬁ”\ CONVERT OR ASSIGN SLICES

New clip program
120.0

4

CANCEL

ﬁ:\‘ CONVERT OR ASSIGN SLICES

New program with new samples
4
“
&4

CANCEL

# Track 04

DON'T SNAP NUDGE EDIT START EDITEND TRANSPOSE

VELOCQITY
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If you set the Convert To field to Assign slice to a pad,
the pad will simply refer to the slice in this sample instead Hi1 ASSIGN SAMPLE
of creating a new sample. This is useful for reducing clutter
in your project.

Assign slice to pad

Important: Assigning a sample to a pad in this way will
replace the sample on the first layer of the pad. AQ1

Non-destructive slice
Use the Pad field to select the desired pad. Alternatively,
press the desired pad. Drums

Use the Slice Type field to select how the pad’s layer
settings will be set when the slice is assigned to it (see
Program Edit Mode to learn more about the
parameters mentioned below):

¢ Non-Destructive Slice: The pad’s Slice setting
will be set to the slice number.

e Pad Parameters: The pad’s Slice setting will be
set to Pad. The Pad Start and Pad End will be set
to the slice’s start point and end point values, and
the Loop Position will be set to the slice’s start
point but with Pad Loop deactivated.

Use the Program field to specify the program to which
you want to add the slice.

To convert the sample, tap Do It.

To cancel the operation, tap Close.

If you set the Convert To field to Make new sample, this
will create a new sample in your project. (The original
sample will remain as it is.)

#ill ASSIGN SAMPLE

Important: Assigning a sample to a pad in this way will Make new sample
replace the sample on the first layer of the pad.
AO1

Use the Pad field to select the desired pad. Alternatively, &4
press the desired pad.

Drums

Check the Crop Sample box to delete the unused
parts from the sample when it’s created and assigned.
This feature is destructive, though the project will still
contain your original sample.

Leave this box unchecked to keep the unused parts of
the sample when it is created and assigned. This way,
you will still be able to edit the entire sample further
even though you are using only part of it at the moment.

Use the Program field to specify the program to which
you want to add the slice.

To convert the sample, tap Do It.
To cancel the operation, tap Close.
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If you set the Convert To field to Patched phrase, this will
create a new sample that will play based on the tempo of $l CONVERT OR ASSIGN SLICES
your Sequence, and places it in the current project. The
patched phrase will have the same name as the original
sample but appended with pp and will use a different icon
when viewing your project information.

Patched phrase

Use the Bars field to set how many bars long the
patched phrase is meant to be.

CANCEL

Processing Slices

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing
option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.)

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to
open the Function window, which displays an overview of all available editing processes.

Important: Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the
slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

€ SELECT FUNCTION
fim]  SLICE

g <
SILENCE EXTRACT

aiiis: || [
NORMALIZE REVERSE FADE IN FADE OUT

@ ©
PITCH SHIFT GAIN CHANGE

e SAMPLE

CANCEL

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All processes here will affect only the currently selected slice.
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The Silence process replaces the region between the start
point and end point with silence. ] PROCESS SLICE

Silence

Pressing 'Do It' will silence the section
between the START/END points.

FUNCTION CANCEL

The Extract process deletes the regions before the start
point and after the end point and saves it as a new sample Fiw PRoCess sLice
(with a name you enter) in your current project.

Tip: This is useful if you recorded a drum loop and wanted Bl

to remove just a snare drum hit, a kick drum hit, etc. to use
separately in the project.

NEW SAMPLE

Audio 002 Rec2 B

FUNCTION CANCEL

The Normalize process increases a sample’s level to the
highest level possible without distortion. This is essentially fin] PROCESS SLICE
a kind of digital gain optimization, so you do not have to
worry about excessive level settings when working with Ntz
samples with a wide range of amplitudes.

FUNCTION CANCEL

The Reverse process reverses the region between the
start point and end point. R

Reverse

FUNCTION CANCEL
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The Fade In process sets a fade-in between the start point
and end point. The following types are available:

Linear fades the audio in with a linear curve—a
straight line between the start and end.

Log fades the audio in with a logarithmic curve—quickly
rising at the start and flattening out towards the end.

Exp fades the audio in with an exponential curve—
slowly rising in the beginning and growing steeper
towards the end.

The Fade Out process sets a fade-out between the start
point and end point. The following types are available:

Linear fades the audio out with a linear curve—a
straight line between the start and end.

Log fades the audio out with a logarithmic curve—
quickly rising at the start and flattening out towards the
end.

Exp fades the audio out with an exponential curve—
slowly rising in the beginning and growing steeper
towards the end.

The Pitch Shift process changes the pitch of the sample
without changing its length. This lets you set the sample’s
pitch to your sequence without affecting the sample’s
tempo or duration. You can adjust it up to 12 semitones,
up or down. Keep in mind that the audio quality may
decrease at more extreme settings.

The Gain Change process raises or lowers the volume of
the sample. You can adjust it up to 18 dB, higher or lower.
This function is different than Normalize because it will
allow volumes beyond clipping level. This may be a
desired effect, but remember to watch your output level!

i) - PROCESS SLICE

Fade In

LINEAR

Pressing 'Do It' will put a fade in
between the START/END points.

FUNCTION CANCEL

[ill]  PROCESS SLICE

Fade Out

LINEAR

Pressing 'Do It will put a fade out
between the START/END points.

FUNCTION CANCEL

[ill]  PROCESS SLICE

Pitch Shift

FUNCTION CANCEL

[ill]  PROCESS SLICE

Gain Change

FUNCTION CANCEL
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Program Mode

Program Mode lets you edit a sample in the context of the program in which you’ll use it. You can adjust the pad
parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound in the program’s
audio path.

To enter Program Mode, tap the Program button at the bottom of the screen. The pads will show their assigned
samples in the current Program.

Loop Drum Minimal
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Use the Start and End fields to set the position of the start point and end point of the sample (respectively).
Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs (Start
X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point.

Program Mode includes a loop function. When on, the region of the sample between the loop point and end point will
repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:
e Use the Loop field.
e Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off).

e Use the first column of Q-Link knobs (Start X1__; if Loop Lock is on) or the third column of Q-Link knobs
(Loop X1__; if Loop Lock is off). The top-most Q-Link knobs (13 and 15) provide coarse adjustment. The
bottom-most Q-Link knobs (1 and 3) provide fine adjustment.

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point.
When off, the loop point is independent from the start point.

To turn the loop function on or off, tap the Loop button to cycle between the four modes:
Off: The sample will not loop.
Forward: When the loop reaches its end point, it will start playing again from the loop point.

Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will
return to the end point and continue playing in reverse.

Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it
will start playing forward again from the loop point.

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the screen.
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Tap each pad to hear its sample/samples. The sample on its first layer will automatically appear in the waveform
display for editing.

Use the Tune field to transpose the sample up or down from its original pitch.

Tap From BPM to open the Edit Tuning window, which lets you tune a sample to the current sequence.

B} EDTTUNING

Audio 002 Rec1

TO SEQUENCE

Use the Number of Beats field to match the number of beats in the sequence.

To tune the sample to the sequence, tap Match. The Tune field will adjust automatically and close the
window. The sample is now tuned to the sequence.

To tune the sample to the sequence and adjust the sequence tempo, tap To Seq. This is the same as
tapping Match but it also changes the sequence’s tempo to the BPM shown in the Tempo field on the right.

To close the window, tap Close.

Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original
pitch when in a keygroup program.

Use the Slice field to display either the sample as it has been edited (Pad) or the entire sample (All).

If the Slice field is set to All, you can display the sample as it has been edited but keep the start point and end point.
To do this, press and hold Shift, and then tap To Pad at the bottom of the screen. The Slice field will change to
Pad, but the start point and end point will remain in their current locations.
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The Link Slices button does not have a function in Program Mode.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can
help to avoid clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the screen. This
switches the loop function between Forward and off. The loop function is described earlier.
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Assigning Samples

You can assign your new sample directly to a pad from Program Mode.
To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.
Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the
pad will simply refer to the slice in this sample instead of S ESESRE
creating a new sample. This is useful for reducing clutter in
your project.

Assign slice to pad

Use the Pad field to select the desired pad. Alternatively, AO1

press the desired pad.
Non-destructive slice

Use the Slice Type field to select how the pad’s layer
settings will be set when the slice is assigned to it (see
Program Edit Mode to learn more about the parameters
mentioned below):

Drums

e Non-Destructive Slice: The pad’s Slice setting
will be set to the slice number.

e Pad Parameters: The pad’s Slice setting will be
set to Pad. The Pad Start and Pad End will be set
to the slice’s start point and end point values, and
the Loop Position will be set to the slice’s start
point but with Pad Loop deactivated.

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.

If you set the Assign To field to Make new sample, this
will create a new sample in your project. (The original
sample will remain as it is.)

#ill ASSIGN SAMPLE

Make new sample

Use the Pad field to select the desired pad. Alternatively,
press the desired pad. AO1

4

Check the Crop Sample box to delete the unused
parts from the sample when it’s created and assigned.
This feature is destructive, though the project will still
contain your original sample.

Leave this box unchecked to keep the unused parts of
the sample when it is created and assigned. This way,
you will still be able to edit the entire sample further
even though you are using only part of it at the moment.

Drums

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.
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Processing Slices

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing
option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.)

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to
open the Function window, which displays an overview of all available editing processes.

Important: Program Mode is non-destructive: You can choose the slice/edit behavior without destroying your original
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the
slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

& SELECT FUNCTION
fimy]  SLICE

g x
SILENCE EXTRACT

aiiis: ---III||| |||||...-
NORMALIZE REVERSE FADE IN FADE OUT

@ ©
PITCH SHIFT GAIN CHANGE

e SAMPLE

CANCEL

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All processes here will affect only the currently selected slice.
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The Silence process replaces the region between the start
point and end point with silence.

The Extract process deletes the regions before the start
point and after the end point and saves it as a new sample
(with a name you enter) in your current project.

Tip: This is useful if you recorded a drum loop and wanted
to remove just a snare drum hit, a kick drum hit, etc. to use
separately in the project.

The Normalize process increases a sample’s level to the
highest level possible without distortion. This is essentially
a kind of digital gain optimization, so you do not have to
worry about excessive level settings when working with
samples with a wide range of amplitudes.

The Reverse process reverses the region between the start
point and end point.

file]  PROCESS SLICE

Silence

Pressing 'Do It' will silence the section
between the START/END points.

FUNCTION CANCEL

[ily] ~ PROCESS SLICE

NEW SAMPLE
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FUNCTION CANCEL

filli] - PROCESS SLICE

Normalize

FUNCTION CANCEL

[l PROCESS SLICE

Reverse
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FUNCTION CANCEL
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The Fade In process sets a fade-in between the start point
and end point. The following types are available:

Linear fades the audio in with a linear curve—a
straight line between the start and end.

Log fades the audio in with a logarithmic curve—quickly
rising at the start and flattening out towards the end.

Exp fades the audio in with an exponential curve—
slowly rising in the beginning and growing steeper
towards the end.

The Fade Out process sets a fade-out between the start
point and end point. The following types are available:

Linear fades the audio out with a linear curve—a
straight line between the start and end.

Log fades the audio out with a logarithmic curve—
quickly rising at the start and flattening out towards the
end.

Exp fades the audio out with an exponential curve—
slowly rising in the beginning and growing steeper
towards the end.

The Pitch Shift process changes the pitch of the sample
without changing its length. This lets you set the sample’s
pitch to your sequence without affecting the sample’s
tempo or duration. You can adjust it up to 12 semitones,
up or down. Keep in mind that the audio quality may
decrease at more extreme settings.

The Gain Change process raises or lowers the volume of
the sample. You can adjust it up to 18 dB, higher or lower.
This function is different than Normalize because it will
allow volumes beyond clipping level. This may be a
desired effect, but remember to watch your output level!

fily) - PROCESS SLICE

LINEAR

Pressing 'Do It' will put a fade in
between the START/END points.

FUNCTION CANCEL

Fil)  PROCESS SLICE

Fade Out

LINEAR

Pressing 'Do It' will put a fade out
between the START/END points.

FUNCTION CANCEL

Fil)  PROCESS SLICE

Pitch Shift

FUNCTION CANCEL

fill] - PROCESS SLICE

Gain Change

FUNCTION CANCEL
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Program Edit Mode

Program Edit Mode contains all parameters for editing your Programs.

PROGRAM EDIT
For drum programs, this mode includes the parameters of four layers as well as all synthesis parameters and insert
effect settings. See the Drum Programs section to learn more.

For keygroup programs, this mode contains slightly more parameters than drum programs. See the Keygroup
Programs section to learn more.

For clip programs, this mode looks very different from that of other programs due to how clip launching works. See
the Clip Programs section to learn more.

For plugin programs, skip to Plugin Programs to learn more.
For MIDI programs and CV programs, skip to MIDI Programs and CV Programs to learn more.

For more general information on the differences between the types of programs, please see General Features >
Programs.

To enter Program Edit Mode, do either of the following:

e Press Menu, and then tap Program Edit.
e Press Prog Edit (MPC X, MPC One).

Drum Programs

MASTER

Poly

SIMULTANEOUS
PLAY

MUTE

et AO1 Off Off Off

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

When using drum programs, Program Edit Mode lets you edit the parameters for each pad.
To select a pad, press it. Its parameters will appear on the screen immediately.

To view a specific tab of parameters, tap the Master, Samples, Pan Velocity, Filter/Env, LFO Modulation, or
Effects button at the bottom of the screen. You can tap the Samples button multiple times to cycle through its
three available tabs.
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[ |
9, EDITZONES

CURRENT @

Tap the location icon at the top of the screen (between the Program and Pad fields) to open the Edit Zones
window, which is a feature for drum programs and clip programs. This window displays an overview of any selected
pads. Use the Mode selector to set how the selected pads will be edited:

Current: Only the currently selected pad can be edited.
Multiple: All selected pads can be edited simultaneously.

All: All pads can be edited simultaneously.

To close the window, tap Close, the X, or anywhere outside the window.

Tip: You can immediately select multiple pads while on any tab in Program Edit Mode (regardless of the current Edit
Zones setting) by pressing and holding the Shift button and pressing each desired pad. The Edit Zones setting will
automatically change to Multiple.
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FLATTEN PADS

AO1 1 seconds

1980Kick2

Tap the down-arrow icon at the top of the screen (next to the Program field) to open the Flatten Pad window,
which renders all samples on a pad as an audio sample and places it on the first layer of that pad. The resulting
sample is the audio signal produced by that pad at full velocity (127) after the pad channel strip, which means that it
includes any assigned pad insert effects and the results of warping the sample.

This function is useful if you need to reduce how CPU-intensive a pad or program is by essentially “embedding” the
warping and effects in the sample itself. By default, it will use the name of the first sample. This function works for drum
programs only. (This is the same as the Flatten Pad process shown in the program editing functions in Main Mode.)

To select the pad, press it or use the Pad menu.

To set the length of the audio tail, use the Audio Tail field. This will add extra seconds to the end of the resulting
audio file. This is useful if you are using effects or samples whose sounds exceed the defined audio length (e.g.,
long reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a
couple of seconds.

To name the new sample, tap the Edit Name field, and use the virtual keyboard that appears.
To confirm your choice, tap Do It.

To cancel, tap Cancel.

The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.
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Master

In the Master tab, you can set the playback mode and tuning for the overall Program.

MASTER

SIMULTANEOUS
PLAY

MUTE

el AO1 Off Off Off

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Polyphony sets the playback mode for the program’s pads. In Mono Mode, only one pad will sound at a time. If a
pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute
all other currently playing pads in that program. In Poly Mode, several pads can be triggered at the same time
(limited only by the total number of voices available).

Semi lets you transpose the program up to 36 semitones up or down.

Fine provides fine-tuning of the program up to 99 cents up or down.

Volume controls the overall volume level of the loaded sample/samples.

Pan controls the overall panning of the loaded sample/samples in the stereo field.

The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad only. This function
is useful for triggering a stack of sounds (e.g., layered kick drums). Use each Pad field to select the desired pad.

The Mute Targets tab lets you select up to four pads (in the same program) for the currently selected pad. When the
currently selected pad is played, it will immediately silence its mute targets. Use each Pad field to select the desired
mute target.

Tips:
This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

This feature is similar to the mute group feature, available for both drum programs and keygroup programs.
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Samples

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has identical,
independently assignable parameters.

Tap Samples to cycle through its three available tabs.

il
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On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can
create these slices in Sample Edit Mode (Chop Mode).

When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing
the end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create
slices that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the
same as the start point. When off, the loop point is independent from the start point and indicated by a separate loop
marker. This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and
loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing
a sample. This is the same as the 0 Snap button in Sample Edit Mode.
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The first Samples tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.
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The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows
the editing controls.

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to
move through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Use the bottom-most Q-Link knob in the fourth bank to zoom in or out of the sample waveform.

Tap each layer number (Layer 1-4) under the waveform to select it. When selected, its sample waveform will be
shown in the upper half of the screen and its settings will be shown in the lower half.

Use the Sample field to select the sample file for that layer. Remember that the sample has to be loaded into the project’s
sample pool beforehand. For information on how to load samples into a project, please see the Browser chapter.

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s
how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can
convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and
each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the pad/layer to which it’s
assigned has its Slice drop-down menu set to the corresponding slice number in the original sample. Playing that
pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that
slice. This means that you no longer have to clutter your project with a new sample for every slice (though you can
still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is
that in Program Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead
of the slice number), and the start and end points will correspond to the slice markers in the original sample.
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The green/S marker and red/E marker are the start point and end point (respectively). These two points define the
region of the sample that will be played.

To move the start point or end point, do any of the following:
e Tap and drag the S or E marker left or right.
e Use the Start or End fields shown below the waveform.

e Use the first bank of Q-Link knobs to adjust the start point or the second bank of Q-Link knobs to adjust
the end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob
provides fine adjustment.

Note: When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the
sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated.
Alternatively, use the third bank of Q-Link knobs to adjust the loop point. The top-most Q-Link knob provides
coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

Note: When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is
independent from the start point.

Use the Slice field to select what part/parts of the sample will play:
All: The entire sample will play.

Pad: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets
you activate Pad Loop (if the Sample Play field in the LFO Modulation tab is set to Note On).

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you
trigger the pad.

Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if
Warp is off). This is the same as the Semi knob on the second Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the
same as the Fine knob on the second Samples tab.
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Use the Reverse button to select in which direction the sample will play. When on, the sample will play in reverse.
When off, the sample will play in the normal forward direction.

Use the Pad Loop button to cycle through the available Pad Loop modes.

Important: For Pad Loop to work, you must (1) set the Sample Play field (in the LFO Modulation tab) to Note On
instead of One Shot and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

Off: The sample will not loop.

Forward: You can hold down the pad to cause that sample to repeat from the Loop Position
to the end of the sample. Release the pad to stop the repeating playback.

P PRDLOOP

i

Reverse: You can hold down the pad to cause that sample to play in reverse, repeating from
the end of the sample to the Loop Position. Release the pad to stop the repeating playback. Hen)

PAD LOOP

Alternating: You can hold down the pad to cause that sample to play from the Loop Position to
the end of the sample and then play in reverse until it reaches the Loop Position again. This will | , C)» smotaos
repeat as long as you are holding the pad down. Release the pad to stop the repeating playback.
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Tap Warp to enable or disable warping of the sample.
When enabled, lengthening or shortening the sample (based on the BPM) will not change its pitch.

When disabled, lengthening or shortening the sample will also change its pitch and vice versa.

Use the Stretch field to set the “stretch factor,” which affects how the sample is warped (if Warp is on).

Use the BPM field to enter a tempo, which affects how the sample is warped (if Warp is on).

Tap BPM Sync to enable or disable BPM Sync.
When BPM Sync and Warp are both enabled, the sample’s BPM will be “locked” to the tempo of the sequence.

When BPM Sync is disabled but Warp is enabled, the sample will be independent of the tempo of your sequence—use
the Stretch field to lengthen or shorten a sample.

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by
doing any/all of the following:

Avoid using extreme Stretch values.
Minimize the amount of pitch adjustment (e.g., the Semi and Fine parameters) of warped audio.
Avoid warping very small track regions.

Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start
at the same time.

Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the
affected pad’s layers into one audio sample (see here to learn about this). After you flatten the pad, its
sample/samples no longer need to be warped.
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The second Samples tab contains controls for its pitch and volume level.
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Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if
Warp is off). This is the same as the Semi field on the first Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the
same as the Fine field on the first Samples tab.

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
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The third Samples tab contains the control for its offset.
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Use the Offset slider to determine a time offset for the sample’s playback.

Positive values (right of center): When the pad is played, playback will start immediately but at a later point in the
sample specified by the offset value.

Negative values (left of center): When the pad is played, playback will be delayed by the amount specified by the
offset value.
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Pan Velocity
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Use the pan knob to adjust the stereo placement of the respective layer.

Use the Vel Start and Vel End knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while,
for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several
samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of
each layer accordingly.

For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set
each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-
range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.
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Use the Type field to select a filter for the selected pad. See Appendix > Glossary > Filter for an explanation of the
available filter types.

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for
band-pass and band-stop filter types.

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point.

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a
strong audible boost around the cutoff frequency.

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter
Cutoff over time.

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well
as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:
Vel>Sta (Velocity® Start) sets how much velocity is needed (for a triggered pad) to modulate the sample start point.

Vel>Atk (Velocity®Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase
for the Amp envelope.

Vel>Env (Velocity®Envelope) enables velocity information to control the amount of the filter envelope’s effect on
the cutoff frequency.

Vel>Flt (Velocity»Filter) uses the velocity of a pad to modulate the cutoff frequency directly.
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The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with
the Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the
envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter
frequency with the Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters.

LFO Modulation
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The Modes controls let you set the behavior for each pad’s samples in a drum program.

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group
affects pads within that program only; mute groups do not affect pads in other programs.

Tip: This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

Use the Layer Play selector to determine how multiple samples assigned to the same pad are played:

Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the samples will
cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4... etc.

Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.

Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.

Use the Sample Play selector to determine how much of the sample is played.
One Shot: The entire sample will play from start to end. Use this when you want to play short sounds.

Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can
control a sound’s duration by pressing and holding its corresponding pad.
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Use the Pad Polyphony field to determine how the pad’s sound behaves when multiple hits are registered. When set
to Mono, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its
sample/samples, the new pad will immediately mute all other currently playing pads in that program. When set to
Poly, several pads can be triggered at the same time (limited only by the total number of voices available). You can
also select a specific number of pads (2-32) so that you can trigger up to this many pads at the same time (unless
they exceed the total number of voices available).

The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack
of the filter envelope (Attack), the volume level of the filter envelope (Amp) and or the panning of the sound (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount
also gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can
be used for modulation purposes.

Use the Wave field to select the LFO waveform type:
Sine (best suited for smooth modulations)
Triangle (best suited for smooth modulations)
S&H (samples a random value and holds it until the next value is generated)
Saw (can generate interesting filter or volume changes)
Saw Down (can generate interesting filter or volume changes)
Square (interesting results with hard-panning modulations)

Noise (generates random values and glides)

Use the Rate field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete
a cycle, while higher values will come closer to audible range.

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff
frequency of the filter (Filter), the volume level of the sound (Amp) and panning of the sound (Pan).
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Inserts

You can select up to four insert effects for each pad. To learn how to use insert effects, please see General Features >
Effects > Insert Effects.

To add an effect:
1. Double-tap the desired Inserts slot. A list of effects will appear.
2. Swipe up or down to move through the list.

You can tap the Type and Manufacturer buttons to sort your effects by those categories.
3. To load an effect, double-tap it, or tap Select.

To close the list, tap Close.

To remove an effect from its slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button for the slot.
To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner.
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To adjust the effect’s parameters, tap the pencil icon. Use the sliders to set the value of each parameter. These
values affect only this instance of the effect; insert effects are not global.
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Sends

The audio of the pad will be routed to send effects (if you have any loaded) at their designated send levels. The return
channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the pad will route to each send effect.

Important: To set the send level, use, you have to load an effect into the corresponding send effect slot in the
Channel Mixer. See Channel Mixer > Returns to learn more how to do this. To learn about send effects, please see
General Features > Effects > Send/Return Effects.
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When using keygroup programs, Program Edit Mode lets you edit the parameters for each keygroup.

To select a keygroup, press a pad within that keygroup. Its parameters will appear on the screen immediately.
Alternatively, use the Keygroup field at the top of the screen.

To view a specific tab of parameters, tap the Master, Samples, Pan Velocity, Filter/Env, LFO Modulation, or
Effects button at the bottom of the screen. You can tap the Samples button multiple times to cycle through its three
available tabs.

Number of KG (keygroups) lets you create up to 128 keygroups within a keygroup program. This is useful when
working with multi-samples. For example, if you want to create a realistic piano, you can use different keygroups (e.g.,
88 for a grand piano) with every keygroup containing its own sampled note (with up to four possible velocity layers).

Tap the Keygroup field to select a keygroup to edit. You can also select All to edit all keygroups simultaneously.

Tap the piano-keys icon to edit the note range of the
current keygroup. This will open the Set Keygroup Note
Range window. This lets you restrict the key range used
for a sample’s playback. Only notes with a key number
higher or equal (Low Key) or lower and equal (High Key)
to the selected value will trigger a sound.

& Set Keygroup Note Range

Tips:

Alternatively, you can set the current keygroup’s note
range by using the Lo and Hi fields under Note Range in
the Master tab.

Set the Lo parameter to A0 and the Hi parameter to C8 to
emulate the range of a standard 88-key piano.

The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.
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Master

In the Master tab, you can set the playback mode and tuning for the overall program.
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Polyphony sets the playback mode for the program’s keygroups. In Mono Mode, only one keygroup will sound at a
time. If a keygroup is played while another (or the same one) is still playing its sample/samples, the new keygroup will
immediately mute all other currently playing keygroups in that program. In Poly Mode, several keygroups can be
triggered at the same time (limited only by the total number of voices available).

Semi lets you tune the program up to 36 semitones up or down.

Fine provides fine-tuning of the program up to 99 cents up or down.

Transpose shifts the pitch of the MIDI notes sent to the program up to 36 semitones up or down.

KG Select (Keygroup Select) lets you select a specific keygroup for editing. This parameter works in conjunction with
the Number of KG (keygroups) parameter at the top of the screen, which lets you create up to 128 keygroups within
one keygroup program. A default keygroup program contains only one single keygroup. When you have created
more than one keygroup with Number of KG, use KG Select to select any keygroup for editing. All selects all
available keygroups of a keygroup program for simultaneous editing.

Key Track allows you to switch a sample’s automatic transposition on or off. If this is off, you will always hear the
same pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard.
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Level controls the overall volume level of the loaded sample/samples.

Pan controls the overall panning of the loaded sample/samples in the stereo field.

Note Range lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or
equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo and Hi are also shown
in the virtual keyboard in the Edit Layers section. Alternatively, tap the piano-keys icon to open the Set Keygroup
Note Range window.

Tip: Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano.

Semi lets you transpose the sample 36 semitones up or down, while Fine provides fine-tuning of each layer up to 99
cents up or down.

Tip: The Edit Layers section has some parameters similar to those in this section (Level, Pan, Semi, Fine, Note
Range). Remember that Key Group parameters control the overall settings for the sample, while Edit Layer
parameters control the settings for each layer (up to 4).

Use the KG Polyphony (keygroup polyphony) field to determine how the keygroup will play. When set to Mono, only
one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the
new pad will immediately mute all other currently playing pads in that program. When set to Poly, several pads can
be triggered at the same time, limited only by the total number of voices available. You can also select a specific
number of pads (2-32) so that you can play up to this many pads at the same time (unless they exceed the total
number of voices available).

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group
affects pads within that program only; mute groups do not affect pads in other programs.
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Layer Play determines how multiple samples assigned to the same pad are played:

e Cycle (Cyc): Each time the pad is played, it will play the next layer’s sample. In other words, the samples will
cycle through the layers as follows: 1, 2, 3, 4,1, 2, 3, 4... etc.

o Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.

e Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.

Sample Play determines how much of the sample is played:
e One Shot: The entire sample will play from start to end. Use this when you want to play short sounds.

o Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can
control a sound’s duration by pressing and holding its corresponding pad.
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Samples

Each keygroup can trigger up to four samples, which are assigned in four individual layers. Each layer has identical,
independently assignable parameters.

Tap Samples to cycle through its three available tabs.
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On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

{3 SETTINGS

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can
create these slices in Sample Edit Mode (Chop Mode).

When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing
the end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create
slices that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the
same as the start point. When off, the loop point is independent from the start point and indicated by a separate loop
marker. This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and
loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing
a sample. This is the same as the 0 Snap button in Sample Edit Mode.
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The first Samples tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.
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The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows
the editing controls.

The waveform display shows the “active” section of the clip waveform. Swipe left or right on the waveform to move
through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Use the bottom-most Q-Link knob in the fourth bank to zoom in or out of the sample waveform.

Tap each layer number (Layer 1-4) under the waveform to select it. When selected, its sample waveform will be
shown in the upper half of the screen and its settings will be shown in the lower half.

Use the Sample field to select the sample file for that layer. Remember that the sample has to be loaded into the project’s
sample pool beforehand. For information on how to load samples into a project, please see the Browser chapter.

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s
how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads (keygroups),
you can convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its keygroup to refer to that slice when you press a pad in that keygroup; the original
sample remains intact and each slice marker is like a “bookmark” for a keygroup. In Program Edit Mode, you’ll see
that the layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice number in the
original sample. Playing that keygroup will cause it to refer to that slice marker like a “bookmark” instead of creating
an entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for
every slice (though you can still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is
that in Program Edit Mode, the layers they’re assigned to have their Slice drop-down menus set to Pad (instead of
the slice number), and the start and end points will correspond to the slice markers in the original sample.
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The green/S marker and red/E marker are the start point and end point (respectively). These two points define the
region of the sample that will be played.

To move the start point or end point, do any of the following:
e Tap and drag the S or E marker left or right.
e Use the Start or End fields shown below the waveform.

e Use the first column of Q-Link knobs to adjust the start point or the second column of Q-Link knobs to
adjust the end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob
provides fine adjustment.

Note: When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the
sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated.
Alternatively, use the third column of Q-Link knobs to adjust the loop point. The top-most Q-Link knob provides
coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

Note: When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is
independent from the start point.

Use the Slice field to select what part/parts of the sample will play:
All: The entire sample will play.

Pad: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets
you activate Pad Loop (if the Sample Play field in the Master tab is set to Note On).

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you
trigger the pad.

Semi lets you transpose the selected layer 36 up to semitones up or down. This is the same as the Semi knob on the
second Samples tab.

Fine provides fine-tuning of each layer by cents. This is the same as the Fine knob on the second Samples tab.
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Use the Reverse button to select in which direction the sample will play. When on, the sample will play in reverse.
When off, the sample will play in the normal forward direction.

Use the Pad Loop button to cycle through the available Pad Loop modes.

Important: For Pad Loop to work, you must (1) set the Sample Play field (in the Master tab) to Note On instead of
One Shot and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

Off: The sample will not loop.

Forward: You can hold down the pad to cause that sample to repeat from the Loop Position
to the end of the sample. Release the pad to stop the repeating playback. ) bADLOOR

i

Reverse: You can hold down the pad to cause that sample to play in reverse, repeating from
the end of the sample to the Loop Position. Release the pad to stop the repeating playback. «CD) rmorooe

Alternating: You can hold down the pad to cause that sample to play from the Loop Position to
the end of the sample and then play in reverse until it reaches the Loop Position again. This will | «C2D)» ewouoor
repeat as long as you are holding the pad down. Release the pad to stop the repeating playback.
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The second Samples tab contains controls for its pitch and volume level.
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Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sampile (if
Warp is off). This is the same as the Semi field on the first Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the
same as the Fine field on the first Samples tab.

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
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The third Samples tab contains the control for its offset.
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Use the Offset slider to determine a time offset for the sample’s playback.

Positive values (right of center): When the pad is played, playback will start immediately but at a later point in
the sample specified by the offset value.

Negative values (left of center): When the pad is played, playback will be delayed by the amount specified by
the offset value.
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Use the Pan knob to adjust the stereo placement of the respective layer.

Use the Vel Start and Vel End knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while,
for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several
samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of
each layer accordingly.

For example, you may have three samples of a piano key with low force, medium force, and high force. You can set
each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-
range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.

Use the Root Note menu to set the starting note of each loaded sample. Smp denotes the sample’s default pitch.
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Use the Type field to select a filter for the selected pad. See Appendix > Glossary > Filter for an explanation of the
available filter types.

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for
band-pass and band-stop filter types.

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point.

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a
strong audible boost around the cutoff frequency.

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter
Cutoff over time.

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well
as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much
more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:

Kbd>Flt (Keyboard+Filter) sets how much the note value will be added to the filter cutoff. This allows higher notes
to sound brighter.

Vel>Atk (Velocity® Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase
for the Amp envelope.

Vel>Env (Velocity®Envelope) enables velocity information to control the amount of the filter envelope’s effect on
the cutoff frequency.

Vel>Flt (Velocity»Filter) uses the velocity of a pad to modulate the cutoff frequency directly.

220



The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with
the Env knob. See Anatomy of an Envelope to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the
envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter
frequency with the Env knob. See Anatomy of an Envelope to learn about the envelope parameters.
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The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack
of the filter envelope (Attack), the volume level of the sound (Amp), and the panning of the sound (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount
also gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can
be used for modulation purposes.

Use the Wave field to select the LFO waveform type:
Sine (best suited for smooth modulations)
Triangle (best suited for smooth modulations)
S&H (samples a random value and holds it until the next value is generated)
Saw (can generate interesting filter or volume changes)
Saw Down (can generate interesting filter or volume changes)
Square (interesting results with hard-panning modulations)

Noise (generates random values and glides)
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Use the Rate field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete
a cycle, while higher values will come closer to audible range.

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff
frequency of the filter (Filter), the volume level of the sound (Amp) and the panning of the sound (Pan).

The Controller Mod section determines the influence of additional play controllers on various sound parameters.

Important: To use these parameters, make sure that a connected MIDI device can send pitch bend messages as
well as aftertouch and modulation wheel data.

Pitch Bend sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel.

Wheel>LFO determines how much a connected MIDI keyboard’s modulation wheel affects the LFO intensity.

Aft>Filt (Aftertouch»Filter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data affects the
filter cutoff.
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Inserts

You can select up to four insert effects for each keygroup. To learn how to use insert effects, please see General
Features > Effects > Insert Effects.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you
load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

To add an effect:
1. Double-tap the desired Inserts slot. A list of effects will appear.
2. Swipe up or down to move through the list.
You can tap the Type and Manufacturer buttons to sort your effects by those categories.
3. Toload an effect, double-tap it, or tap Select.

To close the list, tap Close.

To remove an effect from its slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button for the slot.
To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner.
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To adjust the effect’s parameters, tap the pencil icon. Use the user interface or sliders to set the value of each
parameter. These values affect only this instance of the effect; insert effects are not global.
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Sends

The audio of the program will be routed to send effects (if you have any loaded) at their designated send levels. The
return channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the program will route to each send effect.

You can select up to four send effects for each keygroup, but remember that they will be applied to that keygroup
only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will
overlap in that range as well.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel
Mixer. See Channel Mixer > Returns to learn more how to do this. To learn about send effects, please see General
Features > Effects > Send/Return Effects.
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PROGRAM

When using clip programs, Program Edit Mode lets you assign a sample (a loop called a clip) to each pad in a single
bank. You can also edit various settings to determine how each pad launches its assigned clip.

To select a pad, press it. Its parameters will appear on the screen immediately.

To view a specific tab of parameters, tap Program or Pad the bottom of the screen. The Program tab is
where you assign clips to pads (see Program below). The Pad tab is where you determine how each pad plays
its clip (see Pad below).

o

.9, EDITZONES

]

CURRENT Q

Tap the location icon at the top of the screen (between the Program and Pad fields) to open the Edit Zones
window, which is a feature for drum programs and clip programs. This window displays an overview of any selected
pads. Use the Mode selector to set how the selected pads will be edited:

Current: Only the currently selected pad can be edited.
Multiple: All selected pads can be edited simultaneously.
All: All pads can be edited simultaneously.

To close the window, tap Close, the X, or anywhere outside the window.
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The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.

The Settings window lets you configure certain Audio Edit Mode settings.

To view the Settings, tap the gear icon.

X seTTINGS

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead while viewing the Pad tab.

Follow: Depending on the zoom setting, the waveform display will scroll along in the background while keeping
the audio playhead centered.

Page: The waveform display will move to the “next page” to follow the audio playhead.
Off: The waveform display will not move at all.

These functions also apply to the Grid View, Audio Edit Mode, List Edit Mode, and Sample Edit Mode.
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Program

This tab is where you can assign clips to each pad and adjust the program’s overall tuning and quantization.
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Loop Drum Pu Loop Bass Tec Loop Keys Mo Loop Keys Blis

ADs AQ6 AOD7 A0z

Loop Drum De Loop Bass Nut Loop Keys Me Loop Keys Rev

AD1 Aoz AD3

1 bar

Loop Drum Mi Loop Bass Sq / Loop Keys Cry Elect13

PROGRAM

To assign a sample to a pad, press or tap a pad to select it (it will play its assigned samples, if any). Tap the
Sample field, and then use the data dial or =/+ buttons to select a clip. Alternatively, double-tap the Sample field,
and then tap a clip to select it.

To clear the assigned clip from a selected pad, assign a sample to a pad, but select None.

Coarse lets you transpose the program up to 36 semitones up or down.

Fine provides fine-tuning of the program up to 99 cents up or down.

Use the Launch Quantize field to set the quantization of the program in bars (or subdivisions of a bar).
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PROGRAM

The upper half of the screen shows the clip waveform. The lower half shows the editing controls.

The waveform display shows the “active” section of the clip waveform. Swipe left or right on the waveform to move
through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

The green marker and red marker are the start point and end point (respectively). These two points define the region
of the sample that will be played.

To move the start point or end point of the selected region, do any of the following:
e Tap and drag the S or E marker left or right.
e Use the Start or End fields shown below the waveform.

e Use the first row of Q-Link knobs (Layer 1 Start) to adjust the start point or the second row of Q-Link
knobs (Layer 1 End) to adjust the end point. The right-most Q-Link knobs (12 and 16) provide coarse
adjustment. The left-most Q-Link knobs (9 and 13) provide fine adjustment.

Use the Zoom + or Zoom - buttons at the bottom of the screen to zoom in or out (respectively) of the waveform.
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Below is a brief step-by-step process so you can get familiar with setting up a clip. Continue reading the rest of this
chapter to learn how to use the parameters in this window.

To assign and edit a clip:

1.

Assign a sample to a pad using the Program tab
(described earlier). For example, start with a four-bar
drum loop.

In the Pad tab, note that the BPM field has a value, ‘

which is automatically detected.

If the Warp button is not already on, tap it. The Warp
function keeps the loop in time with the sequence
tempo or the master tempo.

If you need to edit the loop’s tempo manually, do any
of the following:

o Tap the BPM field, and then use the data dial
or —=/+ buttons to change the value.

e Double-tap the BPM field, and then use the
numeric keyboard that appears to enter a value.

Let’s shorten the loop to a two-bar loop by doing any
of the following:

e Tap and drag the start point (S) or end point (E)
marker.

e Tap the beat, bar, or tick value of the Start or
End fields, and then use the data dial or —/+
buttons to change the value.

e Double-tap the beat, bar, or tick value of the
Start or End fields, and then use the numeric
keyboard that appears to enter a value.

Set the locations properly to ensure the loop’s timing
is correct—neither too short nor too long. When the
loop repeats, it should feel seamless.

If the Fade button is not already on, tap it. This applies
a very small fade-in and fade-out at the start and end
of the clip to prevent “clicks” and glitches if start point
or end point is not at a “zero-crossing.”

If you need to edit the loop’s pitch manually, do any of
the following:

e Tap the Coarse or Fine slider, and then use the
data dial or -/+ buttons to change the value.

e Use Q-Link Knobs 1 and 2 (Layer __ Semi
Tune and Layer __ Fine Tune) to change the
value of the Coarse or Fine sliders.

e Double-tap the Coarse or Fine slider, and then
use the numeric keyboard that appears to enter
a value.

The Coarse slider adjusts the pitch in semitones. The
Fine value adjusts the pitch in cents. You will hear the
pitch adjust in real time.
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PROGRAM
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PROGRAM

Tap Warp to lengthen or shorten the clip without changing its pitch, and use the BPM field to change the tempo. Use
the Coarse and Fine sliders if you want to change the pitch.

Use the Pad Play field to determine how the clip is played.
One Shot: When you press the pad, the entire clip will play from start to end and then stop.

Toggle: When you press the pad, the entire clip will play from start to end and loop indefinitely. Pressing it
again—or launching another in the same mute group—will stop its playback. This is the most common usage.

Use the Pad Quantize field to set the quantization of the pad in bars (or subdivisions of a bar). When set to Program
so it uses the same quantization as the overall program (determined by the Launch Quantize field). When set to Off,
the pad will not follow any quantization at all.

Tap Reverse to reverse the clip’s audio.

Coarse lets you transpose the pad up to 36 semitones up or down.

Fine provides fine-tuning of the pad up to 99 cents up or down.

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group
affects pads within that program only; mute groups do not affect pads in other programs.

By default, each column of pads is assigned to the same mute group. This means only one pad from each column
can be playing its clip at a time. You can use the Mute Group field to configure this any way you like, though.

Use the Fade button to apply a very small fade-in and fade-out at the start and end of the clip. This can help prevent
“clicks” and glitches that may occur if the start point or end point is not placed at the waveform’s “zero-crossings.”
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Plugin Programs
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OSCILLATOR MIXER / FILTER ENVELOPE

For plugin programs, you will see a graphical representation of the plugin interface, or an overview of all available
plugin parameters with a slider for each.

The automation button indicates the global automation state. This is shown in several modes. See General Features >
Automation to learn about this.

Use the user interface or sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help,
and select MPC User Manual.
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MIDI Programs

od

"= Midi 001

For MIDI programs, you will see an overview of all available MIDI CCs with a slider for each.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and
select MPC User Manual.

232



CV Programs

For CV programs, you will see an overview of all available CV outputs with a slider for each.

The automation button indicates the global automation state. This is shown in several modes. See General Features >
Automation to learn about this.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and
select MPC User Manual.
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Anatomy of an Envelope

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound
over a given period of time.

For drum programs, use the AD/AHDS selector to select an AD or AHDS envelope. When Sample Play is set to
Note-On, it will use an ADSR envelope.

Keygroup programs always use AHDS envelopes. When Sample Play is set to Note-On, it will use an ADSR envelope.

With AHDS envelopes, the following happens when you
trigger a sample:

1.

Within the period of time you have defined with the attack
(Atk), the sample volume rises to its maximum value.

The sample’s maximum volume will be maintained
during the Hold phase.

During the Decay phase, the sample’s volume will
gradually drop to the sustain level.

The sample’s volume will stay at the sustain level
(Sust) until the pad is released.

With AD envelopes, the following happens when you trigger
a sample:

1.

Within the period of time you have defined with the attack
(Atk), the sample volume rises to its maximum value.

The sample’s maximum volume will be maintained until
its Decay phase, when the sample’s volume will gradually
drop to zero over the set duration. Click the Type drop-
down menu to select how the decay functions:

Decay From Start: The volume will start decreasing
immediately after reaching its maximum level.

Decay From End: The maximum volume will be
maintained for a hold phase until it reaches the
decay phase.

With ADSR envelopes, the following happens when you
trigger a sample:

1.

Within the period of time defined by Attack, the
sample volume rises to its maximum value.

During the Decay phase, the sample’s volume will
gradually drop to the Sustain level.

The sample’s volume will stay at the Sustain level until
the Release phrase begins.

The sample’s volume will drop to “zero” over the duration
set by Release.

< AMPENVELOPE

& FILTER ENVELOPE

& AMP ENVELOPE
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List Edit Mode

List Edit Mode has some of the features of the Grid View—as well as some additional ones—but
with a different interface/workflow.

LIST EDIT

e OB

TIME PAD/NOTE LEN MOD TYPE VALUE
001:01:00 Volume

AO06 (38) Aftertouch

A0S (40) Pad Mute

AD3 (42) Aftertouch

AO7 (46) Aftertouch

Pan
A01(37) =

A0S (40) =

A11 (45) =

001:01:24 Volume

DELETE

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the
modes. See General Features > Time Counter/Locate to learn about this.

The clock icon at the top of the screen opens the Timing Correct window. See General Features > Timing Correct
(TC) to learn about this.

The View menu lets you select what type of events are shown in the list.
All: Select this option to show all event types.
Notes: Select this option to show only notes.
Aftertouch: Select this option to show only aftertouch messages.
Track Automation: Select this option to show only track automation events.
Program Automation: Select this option to show only program automation events.
Pitch Bend: Select this option to show only pitch bend events.
Control Change: Select this option to show only MIDI CC messages.
Program Change: Select this option to show only MIDI program change messages.
Ch Pressure: Select this option to show only channel pressure messages.
Solo/Mute: Select this option to show only solo and mute events for tracks, programs, and pads.

Other: Select this option to show other types of events not listed above, such as pad or keygroup parameters.

The automation button indicates the global automation state. This is shown in several modes. See General Features >
Automation to learn about this.
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The Settings window lets you configure certain
List Edit Mode settings.

To view the Settings, tap the gear icon.

{3 SETTINGS

|-> FoLLow

Use the Hitting Pad Selects All Events selector to turn the feature on or off. When On, pressing a pad will
automatically select all note events for that pad in the sequence on that track. When set to Off, pressing a pad will
simply play its sound without selecting any note events.

Use the Auto-Advance on Step Record selector to turn the feature on or off. When set to On, pressing a pad when
the track is record-armed will move the audio playhead forward by a length determined by the current Time Division
setting in the TC/Timing Correct window. When set to Off, pressing a pad when the track is record-armed will not
change the audio playhead position.

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.
Follow: The list will scroll along in the background while keeping the audio playhead centered.
Page: The list will move to the “next page” to follow the audio playhead.

Off: The list will not move at all.

These functions also apply to the Grid View, Audio Edit Mode, and Sample Edit Mode.

PAD/NOTE LENGTH VELOCITY MOD TYPE

The sequence for the track will be shown as a list of events, with the following parameters:
#: This is the number of the note event.

Time: This is the position of the note event in bars, beats, and ticks. If multiple note events occur at the same
time, additional note events will be listed immediately below, but their Time values will be grayed out.

Event Type: This icon indicates the type of event (e.g., Note, Aftertouch, Track Automation, etc.). See the list
of icons below showing the different types of events.

Pad/Note: This is the pad and/or corresponding MIDI note number. For drum programs, you will see the pad
number. For keygroup programs, plugin programs, and midi programs, you will see the note.

Length: This is the length of the note event in ticks.
Velocity: This is the velocity of the note event with its corresponding color.
Mod Type: This is the type of modifier used on the note event via automation.

Value: This is the value of the modifier automation.
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Drums

TIME PAD/NOTE LENGTH VELOCITY MOD TYPE VALUE

001:01:00 Volume
AO06 (38) Aftertouch
A0S (40) Pad Mute
A03 (42) Aftertouch
AO7 (46) Aftertouch

Pan

A01(37)
AO5 (40)
A11 (45)

001:01:24

DELETE

The red arrow (P) on the left side of the list represents the audio playhead’s current position. If your sequence is

playing, the arrow will move accordingly.

The following icons indicate the corresponding types of events:

4
o
=3
o

Track Mixer Automation (Volume, Pan, Mute, Solo)

[| 3l Track MIDI CC Automation (0-127)

Fa Bl Track Parameter Automation (Aftertouch, Pitchbend, Channel Pressure, or Program Change)

Program Mixer Automation (Volume, Pan, Mute, Solo, or Send 1-4)

Program Parameter Automation (options vary based on the type of program)

Program Insert Effect Automation (options vary based on the effect)

Pad/Keygroup Mixer Automation (Level, Pan, Pad Mute, Pad Solo, or Send 1-4)

Pad/Keygroup Parameter Automation (options vary based on the type of program)

Pad/Keygroup Insert Effect Automation (options vary based on the effect)

cjefofifefalofelz]
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To select an event, tap it.

To select multiple events, press and hold Shift and tap each event.

To insert a note event, press Rec or Overdub so the button is lit, and then press a pad. A note event will be
created at the current location using the pad you pressed. You can keep pressing additional pads, which will
continue to insert each press as a single note event in the order you pressed them (similar to a step sequencer).
Press Stop to exit this function.

Note: Depending on the Auto-Advance on Step Record setting, the current time position will either advance each time
you press a pad or remain in place. See the earlier description of Auto-Advance on Step Record to learn about this.

To edit the Pad/Note, Length, or Velocity or numeric Value of an event, tap the value to select it, and then use
the data dial or —/+ buttons to change the value. Alternatively, double-tap it and use the numeric keypad that
appears to enter a value (for Length, Velocity, or numeric Value only).

To edit the Length of an event according to your Timing Correct settings, tap the value to select it, and then
press and hold Shift and use the data dial or -/+ buttons to change the value.

To shift the Pad/Note of an event by pad bank, tap the value to select it, and then press and hold Shift and use
the data dial or —/+ buttons to change the pad bank.

To turn a Solo/Mute event on or off, tap the desired setting on the On/Off switch. Alternatively, tap the On/Off
switch to select it, and then use the data dial or —/+ buttons to change the value.

To move an event, tap it to select it, tap Nudge at the bottom of the screen, and then use the data dial or —/+
buttons to shift the event up or down. Repeat this for other events, or tap Nudge again to turn the feature off.

To move an event according to your Timing Correct settings, tap the Time value to select it, and then press and
hold Shift and use the data dial or —/+ buttons to change the value.

To play an event, tap it to select it, and then tap Play (») at the bottom of the screen. This works with note events
only.

To delete an event, tap it to select it, and then tap Delete at the bottom of the screen.
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Browser

The Browser lets you navigate your MPC hardware’s internal and external hard disks to load
[ | samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily
adapt it to your preferred workflow. You can also audition (preview) your samples before loading
them.

BROWSER
Important: You can install an additional SATA drive in your MPC hardware, allowing for even more storage space.
See Appendix > SATA Drive Installation to learn more about this.

Important: MPC X and MPC Live support read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems
as well as read-only capability for HFS+ file systems. We recommend using an exFAT file system as it is the most
robust one supported by both Windows and macOS.

To show the Browser, do any of the following:
e Press Menu and then tap Browser.
e Press Browse (MPC X, MPC One) or Shift+Menu/Browse (MPC Live, MPC Touch).

To browse for files, tap Browse in the lower-left corner. See the Browse section to learn about this.

To view the project’s sample pool and pads, tap Sample Assign in the lower-left corner. See the Sample Assign
section to learn about this.

B3 [Internal\MPC Documents [Internal]\Expansions\The Vault 2

O, Search directory

O, Search directory
B = I

Acoustic-Cymbal-Ac1 Crsh 1.wav

it Acoustic-Cymbal-Ac1 Crsh 2.wav

Exports
BB MPC Documents

Programs

Projects Acoustic-Cymbal-Ac1 Rd Bell.wav

Samples

Acoustic-Cymbal-Ac1 Rd
Sequences Acoustic-Cymbal-Ac2 Crsh 1.wav
Tracks Acoustic-Cymbal-Ac2 Crsh 2.wav

Acoustic-Cymbal-Ac2 Rd L.wav

Acoustic-Cymbal-Ac2 Rd Bow.wav

BROWSE SAMPLE ASSIGN =) AUDITION BROWSE SAMPLE ASSIGN > <) AUDITION

When the Browse tab is selected, you can do any of the following:
To browse your files by location, tap Places on the left side of the screen.
Internal is the internal drive of MPC X, MPC Live or MPC One.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X, MPC Live or
MPC One.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, MPC One or your
computer (with MPC Touch), they will appear in this column, as well.

To browse your files by content, tap Content and then tap the type of file: Drums, Instruments, Clips,
Samples, Demos, or My Files (see below to learn about these content buttons).

To browse your MPC Expansions (MPC X, MPC Live or MPC One only), tap Expansions (see Addenda >
Updates for MPC 2.1 > New Features > Exporting Expansions to learn how to export MPC Expansions from
your computer to your MPC).

To move up one folder level, tap the folder/L icon in the upper-left corner.
To move through a list, swipe up or down, turn the data dial or use the —/+ buttons.

To select a file or folder, tap it once.
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To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the data dial, or press
the center cursor or Enter (MPC X), to enter a selected folder. You can also tap one of the folder buttons (1-5)
in the upper-right corner to jump immediately to those pre-assigned file paths (see below to learn how to assign
these file paths).

To load a selected file, double-tap it, tap Load, press the data dial, or press the center cursor or Enter (MPC
X). If the file is a sample, it will be loaded to the project’s sample pool. If the file is a project, it will be loaded in its
entirety (you will be asked if you want to close your current project).

To load all files in a folder, select the folder (so it is highlighted in the list), press and hold Shift, and then tap
Load All in the lower-right corner.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically
converted to full-quality uncompressed audio files, so they may use more storage space than they do on your
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.
To preview a selected sound, tap and hold Play (») at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen.
In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set
the volume level. Use the Sync and Warp buttons to audition samples and loops in time with your sequence.
See Addenda > Updates in MPC 2.5 for more information. Tap Audition once more to hide the window.

To show the information for the current storage device, press and hold Shift and then tap Drive Info at the
bottom of the screen. The drive’s information will appear in a new window. Tap OK to return to the previous screen.

To format a storage device to use an exFAT file system, select it in the Browser, press and hold Shift and
then tap Format Drive at the bottom of the screen. In the window that appears, tap OK and then Format in the
next window to format the device, or tap Cancel to return to the previous screen without formatting. This
formatting process will set the device to use the exFAT file system, remove any partitions from the drive, and
erase all of its content. (Devices that are uninitialized or do not have a file system will not be recognized by the
MPC hardware and consequently cannot be formatted.)

To get the most efficient use of the Browser, set the file
paths to your favorite drive locations first. There are five
folder buttons labeled 1-5 in the upper-right corner. You
can set these to be shortcuts to five locations on your
MPC hardware’s internal drive and/or any connected
storage devices, giving you quick access to your files.

To assign the current location to a folder button, press
and hold Shift, and then tap one of the folder buttons (1-5).
Now, when you tap that folder button again, the Browser
will show that folder’s content immediately.

Use the six filter buttons to show only specific types of
files in the list below. Folders will still be shown in the list.

To show project files only, tap the P/page icon.

To show sequence files only, tap the bars icon.

To show program files only, tap the four-squares icon.
To show sample files only, tap the waveform icon.
To show all file types, tap the three-pages icon.

To show or hide MPC project folders, tap the MPC
folder icon.
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Use the six Content buttons to show specific locations in the internal drive of MPC
X or MPC Live and filter them automatically by file type:

Drums: Tap this button to enter the Expansions/The Vault 2 folder on the
internal drive, viewing program files only.

Instruments: Tap this button to enter the Expansions/Instruments folder on
the internal drive, viewing program files only.

Clips: Tap this button to enter the Expansions/Clips folder on the internal
drive, viewing program files only.

Samples: Tap this button to enter the Expansions/The Vault 2 folder on the
internal drive, viewing sample files only.

My Files: Tap this button to enter the MPC Documents folder, viewing all files.

Splice: Tap this button to view samples synced from a paired Splice account.
See Addenda > Updates in MPC 2.5 for more information.

Sample Assign

SAMPLE POOL

4l 1980Snare
- 1984HatCl
Al 1984HatOp
4t Audio 001 Rec1

4 Audio 002 Rec1

4 Bass 01
C AD2 RO3 nos
1980Kick 1984Kick Snrsmil1 1980Snare
ui- Bass 02

R et

BROWSE SAMPLE ASSIGN =) AUDITION CLEAR PAD

When the Sample Assign tab is selected, you can do any of the following:

To select a program in the project, double-tap the Program field at the top of the screen. In the list that
appears, tap the desired program. Alternatively, tap the Program field and then use the data dial or the —/+
buttons to select a location.

To move through the sample pool, swipe up or down, turn the data dial, or use the -/+ buttons.
To preview a selected sound, tap and hold Play (») at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen.
In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set
the volume level. Tap Audition once more to hide the window.

To assign a sample to a pad, press it or tap it on the screen so it lights green. Then, in the Sample Pool list,
tap the desired sample. Alternatively, use the data dial or —/+ buttons to select a sample, and press the data
dial, or press the center cursor or Enter (MPC X), to assign it.

To clear a sample from a pad, press it or tap it on the screen so it lights green. Then, tap Clear Pad at the
bottom of the screen.
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Sampler

J The Sampler lets you record audio samples to use in your projects.

Important: To record any audio, you need to connect an audio source to your MPC hardware

or to your computer’s audio interface.
SAMPLER

To open the Sampler, do any of the following:
e Press Menu and then tap Sampler.

e Press Sampler (MPC X, MPC One).

00:00:00

MAX LENGTH

00:06

SAMPLE PAD TAP PAD HOLD

To set up the Sampler before recording:

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before
you make any connections to avoid “pops” or feedback.

2. Connect a synthesizer or other line-level audio source to the input/inputs of your MPC hardware.

Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC One, MPC Touch) knob to set the input level while
playing your audio source. You should now see the level in the meter. Make sure it does not exceed the
maximum level (the meter should not be “peaking” constantly).

4. Set the recording controls as desired (described in this chapter).

Tap the Arm button to record-arm the Sampler.

You can use the Sampler to record using four different methods: Sample, Slice, Pad Tap, or Pad Hold, all described
later in this chapter. The following controls are present regardless of which method you use.

The Sampler page also contains the Auto Sampler, which lets you capture and convert any plugin preset or external
instrument preset into a Keygroup sampler patch. See Addenda > Updates in MPC 2.3 > New Features > Auto
Sampler for more information.

The time counter in the upper-right corner shows the current playhead position. This is shown in most of the modes.
See General Features > Time Counter/Locate to learn about this.
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The upper-left Input Source field defines whether you are going to record an external
audio signal, which you can set to a pair of inputs (Input 1,2-3,4 in Standalone Mode,
Input 1,2-31,32 in Controller Mode) or a single input (Input 1-4 in Standalone Mode,
Input 1-32 in Controller Mode). You can also select an internal signal from within your
MPC hardware (Resample L, Resample R, or Resample L+R).

Resampling does not require an audio connection because the source is internal and is
therefore recorded without any loss in audio quality. You can, for example, use Resample
to record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left Mono/Stereo field to choose whether your recorded
samples will be monaural (Mono) or binaural (Stereo).

The Inserts field shows any enabled or disabled effects for the Sampler. Tap the area
under Inserts to open a window where you can load, change, and enable or disable the
effects.

Important: These effects are applied to the audio as you record it. This means that the
effects cannot be “removed” from the sound later. Learn more about how effects work
in General Features > Effects.

Tap the Monitor button to enable or disable input monitoring. When on, the audio you
hear in your headphones will be taken before it reaches the Sampler, ensuring zero
latency. When off, the audio you hear in your headphones will be taken after it is
processed in the Sampler, so there may be some latency, but you will hear the audio
source as it sounds in the recording.

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of
the audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1
(MPC X) or the first Q-Link knob in the fourth column (MPC Live, MPC One, MPC
Touch).

When the Sampler is record-armed, it automatically starts recording when the level of
the incoming source exceeds this setting. If you set it too high, the recording may not
start when you play the input source, or the start of the material you wanted to record
may be missing. If you set it too low, the recording may start too early, before you play
the external source. Set this parameter to an appropriate level using the level meter.

To reset the “peak hold,” which shows the highest level of your input signal in the level
meter, tap it.

Input 1,2
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For reference, the Sample Length counter shows you the length of your sample during
the recording procedure.

Tap Arm to record-arm the Sampler. The button will then change to Record and show
Waiting for signal.

At that point, start recording by doing either of the following:

e Start performing so that the incoming audio level exceeds the level of the
threshold slider.

e Tap Record under the Sample Length counter.

To disarm the track instead, tap Cancel.

Use the Max Length field to define the maximum sampling time. Alternatively, turn the
Q-Link Knobs 3 and 4 (MPC X) or the third and fourth Q-Link knobs in the fourth
column (MPC Live, MPC One, MPC Touch): Minutes and Seconds.

You can record up to 19 minutes and 59 seconds (19:59) per sample. We recommend
setting these to values that roughly match your estimated recording duration.

00:00:00

MAX LENGTH

00:20

00:00:00

RECORD

Waiting for signal
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Sample

Using this method, you can insert slice markers directly in your sample as you record it.

Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of
Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a
long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

SLICE +

To start recording, do one of the following:
e Start performing so that the incoming audio level exceeds the level of the threshold slider.

e Tap Record under the Sample Length counter.

To insert a slice marker in a sample while recording, tap Slice+ (in the lower-right corner) as the sample records.
Each time you tap it, a slice marker will be placed at that location.

To stop recording, tap Stop under the Sample Length counter.
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After you stop your recording, the Keep or Discard Sample window will appear.

% KEEP OR DISCARD SAMPLE

New Sample

Drums

DISCARD

Use the Edit Name field to name the new sample. Tap it and use the virtual keyboard that appears.

Use the Program field to assign the new sample to a program. Select <none> if you want to save it to the project
without assigning it to a program.

Use the Assign to Pad field to assign the sample to a pad in the program.

Use the Root Note field to set where the sample’s original pitch will be on the keyboard.

If you recorded a sample while a sequence was playing, the Keep or Discard Sample window will show a few more
options after you select a pad.

Check the Add Event box to automatically add the sample to the currently playing sequence.
Use the @ field to select where you want the event to start:
e Start: The sample will be a note event at the start of the currently playing sequence.
o Trigger: The sample will be a note event where you began recording it in the currently playing sequence.

Use the Track field to set which track will contain the new event.

To confirm your selections, tap Keep at the bottom of the screen.
To discard the recording and return to the Sampler, tap Discard at the bottom of the screen.
To play the recording, tap Play at the bottom of the screen.

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information).
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Slice

Using this method, the pads correspond to slices of the currently recorded sample. Slice markers divide the sample
into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit
Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds
throughout (e.g., a drum loop or a long melodic or harmonic passage).

To start recording, do one of the following:
e Start performing so that the incoming audio level exceeds the level of the threshold slider.

e Tap Record under the Sample Length counter.

To insert a slice marker in a sample while recording, press any pad as the sample records. Each time you press
it, a slice marker will be placed at that location.

The number of the pad that flashes red is the number of the slice marker that will be inserted next. The numbers of
the pads that are lit yellow are the numbers of the slice markers that are already inserted.

When you are done recording, you can name the sample and create a new program using the slices.

To stop recording, tap the round Stop button.

After you stop your recording, the Keep or Discard Sample window will appear.

il KEEP OR DISCARD SAMPLE

New Sample

With Non-Destructive Slices ~

DISCARD CREATE

Use the Edit Name field to name the new sample. Tap it and use the virtual keyboard that appears. Otherwise, the
process will add a consecutive number after the sample name.
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Use the Create New Program field to assign the new sample to a new program:
Off: No program will be created. The slices will still be added to your project’s sample pool.

With Non-Destructive Slices: In the new program, each pad’s Slice setting will be set to the corresponding
slice number. This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit
Mode > Chop Mode > Converting or Assigning Slices).

With Pad Parameters: In the new program, each pad’s Slice setting will be set to Pad. The Pad Start and Pad
End will be set to the slice’s start point and end point values, and the Loop Position will be set to the slice’s
start point but with Pad Loop deactivated. This is identical to how you can assign samples in Sample Edit Mode
(as described in Sample Edit Mode > Chop Mode > Converting or Assigning Slices).

To confirm your selections, tap Create or Keep at the bottom of the screen.
To discard the recording and return to the Sampler, tap Discard at the bottom of the screen.
To play the recording, tap Play at the bottom of the screen.

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information).

Pad Tap

Important: This mode works for drum programs only; you must select a drum program before using this mode.
Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing a pad immediately starts or continues recording directly to that pad (make sure you are
using the desired program before you start recording). Pads with assigned samples are lit bright yellow. Pads
without samples are lit dim yellow.

To start recording to a pad, press it. Recording will start immediately, and the pad will flash red. If you press a new
pad, the recording will stop on the previous pad, which will turn green, and start on the new pad, which will flash red.

Note: If you start recording by tapping Record under the Sample Length counter—or if the volume exceeds the
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad.

To stop recording to a pad, press the currently recording pad, which is flashing red. The sample will continue
recording. You can start recording on another pad at any time.

To stop all recording, tap Stop under the Sample Length counter.

When you are done recording, each pad that you have pressed during recording:
¢ will have its Slice setting set to Pad;
o will have its Pad Start and Pad End set to the slice’s start point and end point values; and
o will have its Loop Position set to the slice’s start point but with Pad Loop deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop
Mode > Converting or Assigning Slices).

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information).
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Pad Hold

Important: This mode works for drum programs only; you must select a drum program before using this mode.
Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing and holding a pad immediately starts or continues recording directly to that pad (make sure
you are using the desired program before you start recording). Pads with assigned samples are lit bright yellow. Pads
without samples are lit dim yellow.

To start recording to a pad, press and hold it. Recording will start immediately, and the pad will light red.

Note: If you start recording by tapping Record under the Sample Length counter—or if the volume exceeds the
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad.

To stop recording, release the pad. The pad will light green, and the sample will continue recording. You can start
recording on another pad at any time.

To stop all recording, tap Stop under the Sample Length counter.

When you are done recording, each pad that you have pressed during recording:
o will have its Slice setting set to Pad;
¢ will have its Pad Start and Pad End set to the slice’s start point and end point values; and
¢ will have its Loop Position set to the slice’s start point but with Pad Loop deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in Sample Edit Mode > Chop
Mode > Converting or Assigning Slices).

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information).

Auto Sampler

See Addenda > Updates in MPC 2.3 > New Features > Auto Sampler for more information.
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Looper

The Looper lets you record and overdub audio in real time—a great tool for live performance
as well as spontaneous moments in the studio. You can export the loop as a sample to use in
your project.

&N

LOOPER

To open the Looper, do either of the following:
e Press Menu, and then tap Looper.
¢ Press Shift+Sampler/Looper (MPC X, MPC One).

«

EXPORT REVERSE RECORD

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to
learn how to use the Looper in different cases.

To get started using the Looper:

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you
make any connections to avoid “pops” or feedback.

Connect a synthesizer, audio player, etc. to the input/inputs of your MPC hardware.

3. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC One, MPC Touch) knob to set the input level while
playing your audio source. You should now see the level in the meter. Make sure it does not exceed the
maximum level (the meter should not be “peaking” constantly).

Set the recording controls as desired (described in this chapter).
Tap the Record To selector so Overdub is selected.

Tap the Rec/Record button in the lower-right corner to record-arm the Looper.

S

Play your audio source. The Looper will start recording immediately when the input level reaches the threshold
value. Alternatively, tap P>/Play at the bottom of the screen to manually start recording.

Each time the Looper repeats, its contents are being overdubbed —a new layer of audio will be added each time
you let the Looper repeat as it records.

Tip: You can record a loop while playing a sequence in the background for reference.
8. To stop recording, tap P/Play at the bottom of the screen.
To export your loop as a sample, tap Export to open the Keep or Discard Sample window.

To clear the contents of the Looper, tap Clear.
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The time counter at the top of the screen indicates the current playhead position. This is shown in most of the
modes. See General Features > Time Counter/Locate to learn about this.

The upper-left Input Source field defines whether you are going to record an external
audio signal, which you can set to a pair of inputs (Input 1,2-3,4 in Standalone Mode,
Input 1,2-31,32 in Controller Mode) or a single input (Input 1-4 in Standalone Mode, [EEE
Input 1-32 in Controller Mode). You can also select an internal signal from within your
MPC hardware (Resample L, Resample R, or Resample L+R).

Input 1,2

Resampling does not require an audio connection because the source is internal and is
therefore recorded without any loss in audio quality. You can, for example, use Resample
to record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left Mono/Stereo field to choose whether your recorded loop
will be monaural (Mono) or binaural (Stereo).

The Inserts field shows any enabled or disabled effects for the Looper. Tap the area under
Inserts to open a window where you can load, change, and enable or disable the effects.

Important: These effects are applied to the audio as you record it. This means that the
effects cannot be “removed” from the sound later. Learn more about how effects work
in General Features > Effects.

Tap the Monitor button to enable or disable input monitoring.

When on, the audio you hear in your headphones will be taken before it reaches the Looper, ensuring zero latency.
You can turn input monitoring on only if the Input Source field is set to an input, not to a Resample setting.

When off, the audio you hear in your headphones will be taken after it is processed in the Looper, so there may
be some latency, but you will hear the audio source as it sounds in the recording.

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1 (Threshold on MPC X) or the first Q-
Link knob in the fourth column (MPC Live, MPC One, MPC Touch). The threshold slider will work only when Sync is off
(see below).

When the Looper is record-armed, it automatically starts recording when the level of the incoming source exceeds
this setting. If you set it too high, the recording may not start when you play the input source, or the start of the
material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play
the external source. Set this parameter to an appropriate level using the level meter.

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it.
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Use the Bars field to define the length of your loop. Regardless
of how much or how little audio you record, this is how long [ |
your loop will be. +6.00dB

Use the Sync button to sync or un-sync the looper with
sequence playback. When on, the Looper will stay in step with
your current sequence. When you play or record into the Looper,
it will wait until the sequence starts playing Bar 1 to start.

Use the Record To selector to determine the loop recording
behavior:

Play: Before recording, you must first tap the »/Play button
on the screen, which will start playing the Looper.

Overdub: Before recording, you must first tap the Rec/
Record button in the lower-right corner to record-arm the
Looper.

Use the Output Gain slider to set the output signal level of the
Looper.
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To record with the Looper:
Important:
To record without erasing any audio you’ve already recorded in the loop, use the Overdub button.

To overwrite the audio you’ve already recorded, use the Replace button.

1 Input 1,2

tereo

«

EXPORT REVERSE RECORD

If Record To is set to Play:

To start recording, tap the Replace or Overdub button as the loop is playing. The Looper will start recording
immediately.

To stop recording, tap the Replace or Overdub button. The Looper will stop recording but continue playing.
To stop playback and recording, tap the p>/Play button.
If Record To is set to Overdub:
To start recording, tap the P/Play button on the screen.
If Sync is off, you can also play your audio source so that the input level reaches the threshold value.

If Sync is on, you can also press the Play or Play Start button to start playing a sequence; recording will
start when the sequence starts on Bar 1.

To stop recording, tap Overdub. The Looper will stop recording but continue playing.

To stop playback and recording, tap the P/Play button, or press Stop to stop sequence playback.

To play or stop the loop (without recording), tap the »/Play button on the screen.

To reverse loop playback, tap Reverse. If Sync is on, playback will reverse once the Looper’s playhead reaches
the end of the loop. If Sync is off, playback will reverse immediately.

To erase the loop immediately, tap Clear.
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% KEEP OR DISCARD SAMPLE

New Looper Sample

Drums

DISCARD

To export the loop as a sample:

1.

2
3.
4

o

Tap Export to open the Export Loop as a Sample window.
Tap the Edit Name field and use the virtual keyboard that appears to enter a new name.
Optional: Use the Program field to assign it directly to a program. To ignore this feature, select <none>.

Optional: If you’re assigning the sample to a program, use the Assign to Pad field to assign it to a specific pad.
Alternatively, just press the pad. To ignore this feature, select Off.

Use the Root Note field to select the sample’s root note.
Optional: Tap and hold your finger on Play to play the sample.
Tap Do It to confirm your choice, or Cancel to cancel.

When your loop is done exporting, it will be added to your project’s sample pool with the name you entered and
will be assigned to the program and pad you selected (if any).
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Pad Mixer

Al In the Pad Mixer, you can set a program’s levels, stereo panning, routing, and effects.

PAD MIXER

This mode appears differently for each type of program:
For drum programs, this mode shows a pad with controls for each individual pad (of 128).
For keygroup programs, this mode shows a pad with controls for each individual keygroup (up to 128).

For clip programs, this mode shows a pad with controls for each individual clip (up to 16). Even though you can
view other pad banks, only Pad Bank A is relevant for clip programs.

For MIDI programs, plugin programs, and CV programs, this mode is unavailable.

For more information on how these programs differ, please see General Features > Programs.

To enter the Pad Mixer, do any of the following:
e Press Menu, and then tap Pad Mixer.
e Press Pad Mixer (MPC X), or Shift+Track Mix/Pad Mix (MPC One).
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The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of their
functionality is identical. If a sample has been assigned to a pad, its name is displayed at the top of it.

To select a pad, press its corresponding pad or tap it on the screen. Alternatively, use the numbered Pad field in
the upper-left corner.

To view more channels, use the Pad Bank buttons.

255



Use the Program field in the upper-left corner to select the program whose pads you want to view. Remember that
only drum programs, keygroup programs, or clip programs will display properly in the Pad Mixer.

Use the Track field at the top of the screen to select the desired track.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See
General Features > Time Counter/Locate to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General
Features > Automation to learn about this.

To view a specific setting on all channels, tap the Level, Pan, Mute, Send, Insert, or Route button at the bottom
of the screen. You can tap the Send or Insert buttons multiple times to cycle through the four available slots for each.

When a pad is selected, you can view and adjust all of its settings in the left side of .
the screen rather than using the tab buttons at the bottom. 1 AD1

When viewing the channel strip: Program

The first field shows the current pad number. Press a pad or double-tap the
field to select a different pad.

The second field shows where the pad is routed, which you can change:
Program (the usual setting); Out 1,2-7,8, Out 1-8 or Sub 1-8 in Standalone
Mode; and Out 1,2-31,32 or Out 1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed
post-pan knob. If the pan knob is set to the center position, the left and right
channels will be summed and padded. If the pan knob is set to the maximum
left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that pad. Tap the
area under Inserts to open a window where you can load, change, and enable
or disable the effects.

Tap Solo or Mute to solo or mute the pad (respectively).

Adjust the pan knob or level slider to change the panning or level of the pad.
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Levels

Track 09
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When the Level tab is selected, use the data dial or -=/+ buttons to adjust the level of the currently selected pad.

The level sliders and meters in each pad show a visual representation of the level. Double-tap a pad on the screen to
open a large version of the level slider and meter.

Panning

Track 09

INSERT

When the Pan tab is selected, use the data dial or —/+ buttons to adjust the panning of the currently selected pad.

The pan sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a large
version of the pan knob.
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Mute
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When the Mute tab is selected, mute the currently selected pad by doing any of the following:
e Turn the data dial.
e Use the -/+ buttons.
e Tap the pad on the screen.

When a pad is muted, its M button will light red.

Send Effects

Track 09

ple B)M)  A14 No Sample (5] (M)

I [
-INF dB -INF dB -INF dB

A12 No Sample (3] (M)

I
-INF dB

Ao7Bottle  (SJ(M)

7
-INF dB

A03snrsmilt (8] (M)

-21.0dB

INSERT

When the Send tab is selected, use the data dial or —/+ buttons to adjust the send level of the currently selected pad.

The level sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a
large version of the level slider.

You can select up to four send effects for each pad. You can use various effects included in your MPC hardware as
well as other VST and AU plugins installed on your computer. Tap the Send button to cycle through the four available
slots for each.

To learn how to use send effects, please see General Features > Effects > Send/Return Effects.
Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel Mixer.
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Insert Effects
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When the Insert tab is selected, use the data dial or —/+ buttons to open a window where you can select an effect
for the currently selected pad.

Instead of level sliders, there are fields that display 0-4 boxes to indicate which insert slots have a loaded effect.

The level meters in each pad show a visual representation of the level. Double-tap a pad on the screen to open a
window where you can load, change, and enable or disable the effects for all four insert slots.

You can select up to four insert effects for each pad. You can use various effects included in your MPC hardware as
well as other VST and AU plugins installed on your computer. Tap the Insert button to cycle through the four available
slots for each.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.
Important:

When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert
effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

If a routing is set to anything other than Program, then a program insert effect will not be applied to that pad or keygroup.

Routing
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When the Route tab is selected, use the data dial or —/+ buttons to select the output of the currently selected pad.
Usually, this is set to Program. Double-tap a pad on the screen to select a different destination: Out 1,2-7,8, Out
1-8 or Sub 1-8 in Standalone Mode; and Out 1,2-31,32 or Out 1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to
the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum
left or right positions, only the respective channel will be sent to the output.
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Channel Mixer

I In the Channel Mixer, you can set levels, stereo panning, and other settings for your tracks,
il programs, returns, submixes and masters.
CHANNEL MIXER

To open the Channel Mixer, do either of the following:
e Press Menu, and then tap Channel Mixer.
e Press Ch. Mixer (MPC X), or Track Mix (MPC One).

The Channel Mixer works like an audio mixer with various settings for each channel, shown in a 4x4 array. Their
functionality is mostly identical. The name of the track, program, or channel is displayed at the top of each one.

Use the Mixer field at the top of the screen to select which mixer you want to view: MIDI Tracks, Audio Tracks,
Programs, Returns, Submixes, or Masters. Each page has slight differences, described in each section.

The following controls and tabs are available for all of the mixers (or most of them, as indicated).

To select a channel, tap its corresponding pad on the screen. Alternatively, use the field in the upper-left corner.

To view more channels (while viewing tracks or programs), use the —=/+ buttons at the top of the screen.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See
General Features > Time Counter/Locate to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General Features
> Automation to learn about this.
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Levels

When the Level tab is selected, use the data dial or —/+ buttons to adjust the velocity level or volume level of the
currently selected track, program, return, submix, or master.

The level sliders and meters in each pad show a visual representation of the level. Double-tap a pad on the
screen to open a large version of the level slider and meter.

Panning

When the Pan tab is selected, use the data dial or —/+ buttons to adjust the panning of the currently selected
track, program, return, submix, or master.

The pan sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a
large version of a pan knob.

Mute/Solo/Rec Arm

Tap this tab to cycle it through Mute, Solo, and Rec Arm functions.

When Mute is selected, mute tracks, programs, returns, submixes, or masters by doing any of the following:
e Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC One, MPC Touch).
e Use the =/+ buttons.
e Tap the pad on the screen.
e Turn each of the Q-Link knobs to mute or unmute each of the pads.

When a track, program, return, submix, or master is muted, its M button will light red.

When Solo is selected, solo tracks, programs, returns, submixes, or masters by doing any of the following:
e Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC One, MPC Touch).
e Use the =/+ buttons.
e Tap the pad on the screen.
e Turn each of the Q-Link knobs to solo or unsolo each of the pads.

When a track, program, return, submix, or master is soloed, its S button will light green while other tracks are
muted with their M buttons lit red.

The Solo tab is available for tracks and programs only.

When Rec Arm is selected, record-enable audio tracks by doing any of the following:
e Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC One, MPC Touch).
e Use the —=/+ buttons.

e Tap the pad on the screen. Press and hold Shift while tapping a pad on the screen to record-enable
multiple tracks at once.

e Turn each of the Q-Link knobs to record-arm or disarm each of the pads.

The Rec Arm tab is available for audio tracks only.
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Send Levels (audio tracks, programs, and submixes only)

When the Send tab is selected, use the data dial or —/+ buttons to adjust the send level of audio tracks,
programs, or submixes.

The level sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a
large version of the level slider.

You can use up to four send channels. Tap Send to cycle through the four available slots for each.
To learn how to use send effects, please see General Features > Effects > Send/Return Effects.

Important: When using send channels, make sure you have already loaded at least one effect to it using the
return mixer. See Returns below to learn how to do this.

Insert Effects (audio tracks, programs, returns, submixes, and masters only)

When the Insert tab is selected, use the data dial or —/+ buttons to open a window where you can select an
effect for the currently selected audio track, program, return, submix, or master.

Instead of level sliders, there are fields that display 0-4 boxes to indicate which insert slots have a loaded effect.

The level meters in each pad show a visual representation of the level. Double-tap a pad on the screen to open a
large version of the level slider.

You can select up to four insert effects for each audio track, program, return, submix, or master. Tap the Insert
button to cycle through the four available slots for each.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.

Routing (audio tracks, programs, returns, and submixes only)

When the Route tab is selected, use the data dial or —/+ buttons to select the output of the currently selected
program, return, or submix.
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MIDI Tracks
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The MIDI Track Mixer shows levels, panning, and mute states for all used tracks.

To view a specific setting on all tracks, tap Level, Pan, or Mute at the bottom of the screen. Tap Mute/Solo to
switch between them.

When a track is selected, you can view and adjust all of its settings in the left side of the screen rather than using the
tab buttons at the bottom.

When viewing the MIDI track channel strip:

Note: This is the same as the MIDI track channel strip in Main Mode.
The first field shows the current track (which you can change).
The second field shows the current program the track is using (which you can change to a program of the same type).
Tap Solo or Mute to solo or mute the track (respectively).

Adjust the pan knob or velocity slider to change the panning or velocity of the track.
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Audio Tracks
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The Audio Track Mixer shows levels, mute/solo/record-arm states, send and insert effects, and routing for all used
tracks.

To view a specific setting on all tracks, tap Level, Pan, Mute/Solo/Rec Arm, Send, Insert, or Route at the
bottom of the screen. Tap Mute/Solo/Rec Arm to cycle through them.

When a track is selected, you can view and adjust all of its settings in the left side of the screen rather than using the
tab buttons at the bottom.

When viewing the audio track channel strip:
Note: This is the same as the audio track channel strip in Main Mode.

The first field defines the input source of the external audio signal, which you can set to a pair of inputs (Input
1,2-3,4 in Standalone Mode, Input 1,2-31,32 in Controller Mode) or a single input (Input 1-4 in Standalone
Mode, Input 1-32 in Controller Mode).

The second field shows where the track is routed, which you can change: Out 1,2-7,8, Out 1-8 or Sub 1-8 in
Standalone Mode; and Out 1,2-31,32 or Out 1-32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set
to the center position, the left and right channels will be summed and padded. If the pan knob is set to the
maximum left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that audio track. Tap the area under Inserts to open
a window where you can load, change, and enable or disable the effects for all four insert slots.

Tap Solo or Mute to solo or mute the track (respectively).

Tap the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states:
When set to Auto, you will hear incoming audio while the track is record-enabled only.
When on, you will hear incoming audio whether or not the track is record-enabled.

When off, you will never hear any incoming audio.
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Tap the automation button or press Read/Write (MPC X) to cycle through its three states:

When off, the audio track will ignore automation data. If you have already recorded or entered
automation, tapping this will switch between Read (R) and Write (W) only, but you can override
this and turn it off by pressing and holding Shift while pressing or tapping the button.

Important: If you have already recorded automation and turn it off, the audio track will still use
the effect and its parameter values at the point where you turned it off.

When set to Read (R), the audio track will read automation data but will not record any additional

automation over it. (Think of this as a protective feature to prevent accidental changes to your

automation while recording.)

When set to Write (W), the audio track can record automation. (If you have any Q-Link knobs
assigned to automatable parameters, make sure not to touch any accidentally while you are
recording.)

Tip: You can quickly set all programs and audio tracks to the same automation by tapping the
global automation button in the upper-right corner of the screen. See General Features >
Automation to learn about this.

Adjust the pan knob or level slider to change the panning or level of the track.

Tap the Rec